
HP Universal CMDB Browser
Software Version: 4.04

UCMDB Browser Installation and Configuration Guide

Document Release Date: December 2015
Software Release Date: December 2015



Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be
construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software,
Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notice
© 2002 - 2015 Hewlett-Packard Development Company, L.P.

Trademark Notices
Adobe™ is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.

Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to: https://softwaresupport.hp.com/.

This site requires that you register for an HP Passport and to sign in. To register for an HP Passport ID, click Register on the HP Support site or click Create an Account on the
HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.

Support
Visit the HP Software Support site at: https://softwaresupport.hp.com.

This website provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your
business. As a valued support customer, you can benefit by using the support website to:

l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
l Download software patches
l Manage support contracts
l Look up HP support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require that you register as an HP Passport user and to sign in. Many also require a support contract. To register for an HP Passport ID, click
Register on the HP Support site or click Create an Account on the HP Passport login page.

To find more information about access levels, go to: https://softwaresupport.hp.com/web/softwaresupport/access-levels.

HP Software Solutions Now accesses the HPSW Solution and Integration Portal website. This site enables you to explore HP Product Solutions to meet your business needs,
includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this website is http://h20230.www2.hp.com/sc/solutions/index.jsp.

UCMDB Browser Installation and Configuration Guide

HP Universal CMDB Browser (4.04) Page 2 of 203

https://softwaresupport.hp.com/
https://softwaresupport.hp.com/
https://softwaresupport.hp.com/web/softwaresupport/access-levels
http://h20230.www2.hp.com/sc/solutions/index.jsp


Contents

Chapter 1: Installation 8

Introduction 8

Install the UCMDB Browser on an Existing Tomcat 9

Install the UCMDB Browser on the Same Machine that Runs the UCMDB Server 10

Install the UCMDB Browser with Preconfigured Apache Tomcat Server on Windows 11

Install the UCMDB Browser with Preconfigured Apache Tomcat Server on Linux 12

Install the UCMDB Browser on the JBoss 7 Application Server 14

Connect the UCMDB Browser to an RTSM Instance 15

Chapter 2: Configuration and Administration 17

Initial Setup for Working with the UCMDB Browser 18

Grant Access to the UCMDB Browser 19

Best Practices for Working with the UCMDB Browser 19

Settings affecting overall system operation 19

Settings affecting search 20

Create a UCMDB Integration User 21

Change the UCMDB Integration User Credentials 22

Configure the UCMDB Server URL 23

Configure LW-SSO 23

Configure SSL 24

Configure High Availability Mode 26

Configure CAC Support 28

Configure CAC Support with Multiple CRL Files 30

Configure Multiple UCMDB Servers 31

Change the Default Port of the Tomcat Server 34

Configure to Use Encrypted Parameters on the Tomcat Server 35

Deploy the UCMDB Browser with a Different Root Context 36

Upgrade the UCMDB Browser 37

Upgrade the UCMDB Browser Embedded in Configuration Manager 38

Configure Reverse Proxy for the Apache Tomcat and IIS Servers 39

UCMDB Browser Installation and Configuration Guide

HP Universal CMDB Browser (4.04) Page 3 of 203



Configure an Environment to Use Multiple Reverse Proxies 40

Configure a One-Time Authentication Token 41

Configure Browser Internal Priorities (for the Incidents and Problems Widgets) 43

Disable Compatibility View for Internet Explorer 8 43

Configuration Mechanism 44

Specify the Number of Concurrent Sessions 44

Enable/Disable Timeout of a Browser Session 45

Authorize Access to CIs 45

Use Cases 47

Brand the UCMDB Browser 48

Log User Statistics 50

How to Set UCMDB Browser Session to Expire 50

Chapter 3: Search and Functionality 51

Logging In 52

Landing Page 54

<Username> Menu 55

Settings Menu 55

Help Menu 55

Accessing the Administration Console for UCMDB Browser 56

Configure the Enhanced Search Engine 56

Using the Enhanced Search Engine 71

Simple Search 72

Search According to CMDB Structure 73

Different Types of Search Results Based on the Same Input Text 74

Special Support 75

Search with Keywords 75

Searches Based on Logical Operators 75

Enriching Search Results 76

Federated Search 76

Auto-Completion Search Entry Capability 77

Legacy CI Search Engine 77

Specify Data Stores Used for Data Loading (legacy search engine) 81

Specify CI Types Returned in Search Results (legacy search engine) 82

Export Search Results 82

UCMDB Browser Installation and Configuration Guide

HP Universal CMDB Browser (4.04) Page 4 of 203



Specify the Appearance and Order of Widgets 83

Configure Properties to be Displayed by the Properties Widget 83

Configure the Properties Widget to Show/Hide Empty Attributes 93

Assign Color Categories 94

Change CI Attributes 95

Change the Source of Thumbnails (for the Stakeholder Widget) 100

Specify Impact Rules 101

Change the History Widget 'From Date' 101

Reports 102

Create a basic report 106

Create a report from search 107

Open a report 108

Generate a report 109

Edit a report 110

Delete a report 110

Select content to be displayed in a report 111

Schedule a report 111

View all scheduled reports 113

Export a report 113

Link to a report 114

Discovery Indicators 114

Service Modeling 115

Model a business service starting from a specific entry point 117

Identify and model applications from existing data 119

Edit a service model 120

Delete a service model 121

View a service model in text navigation mode 122

Show additional Information on a topology map 122

Add layers to an existing model 124

Simulate the impact of a service's failure 125

Simulate the impact of a CI's failure 126

Run discovery manually for a service model 126

Map Toolbar 130

View a service's details 130

Set border rules on a link 132

Group the CIs in a service model by CITs 133

Arrange the CIs in a service model by layers 134

UCMDB Browser Installation and Configuration Guide

HP Universal CMDB Browser (4.04) Page 5 of 203



Access a Service Model Using a Direct Link 135

Assisted Modeling 136

Notifications 143

Schedule Notifications 146

Export notifications 147

Export Widget Details 148

Properties Widget 149

Environment Widget 151

History Widget 153

Impact Simulation Widget 158

Policy Widget 159

Change Requests Widget 160

Incidents Widget 162

Problems Widget 165

Monitoring Widget 167

Stakeholder Widget 168

Dependent Services Widget 170

Security Widget 171

Defects Widget 172

Business Topology Widget 175

Storage Data Widget 177

Dynamic Widgets 178

Discovery Progress Widget 181

Chapter 4: Integrate with Other Applications 184

Load Embeddable Widgets 184

Configure the BSM Health Indicator (for the Monitoring Widget) 185

Configure Integration with Enterprise View 187

Deploy a Universe for Integrating the UCMDB Browser into BusinessObjects 187

Deploy a Report Designed for UCMDB Browser Integration into BusinessObjects 189

Configure the Enterprise View Adapter 190

Integrate with ALM (for the Defects Widget) 190

Configure Integration with Service Manager 194

UCMDB Browser Installation and Configuration Guide

HP Universal CMDB Browser (4.04) Page 6 of 203



Configure a Direct Link to Service Manager for a Selected Problem, Incident, or Change
Request 195

Direct Links 195

Configure Integration with SiteMinder 197

Configure Integration with Configuration Manager 200

Chapter 5: Troubleshooting and Limitations 201

Send Documentation Feedback 203

UCMDB Browser Installation and Configuration Guide

HP Universal CMDB Browser (4.04) Page 7 of 203



Chapter 1: Installation
Introduction 8

Install the UCMDB Browser on an Existing Tomcat 9

Install the UCMDB Browser on the Same Machine that Runs the UCMDB Server 10

Install the UCMDB Browser with Preconfigured Apache Tomcat Server on Windows 11

Install the UCMDB Browser with Preconfigured Apache Tomcat Server on Linux 12

Install the UCMDB Browser on the JBoss 7 Application Server 14

Connect the UCMDB Browser to an RTSM Instance 15

Introduction
Before installing the UCMDB Browser, ensure that your system meets the following requirements:

l UCMDB version. any UCMDB 10.00 or later version

l UCMDB Browser Server. Java JDK 7 (64 bit) must be installed on the server where you install the

UCMDB Browser (the Apache Tomcat version gets its Java from the JAVA_HOME environment

variable).

The UCMDB Browser installation currently comes in three formats:

l Web Application Package. A zip file called ucmdb-browser-install.zip that consists of the UCMDB

Browser .war file and a /conf folder with the UCMDB Browser configuration files. Use this format if:

o You already have an Apache Tomcat Server installed, or you want to install the Tomcat server on

your own.

o You want to install the UCMDB Browser on the same machine that runs the UCMDB server.

Note: If you are planning to install the UCMDB Browser with a Tomcat server, it is not

recommended to do this on the same machine that runs the UCMDB Server. For details

about installing both applications on the same machine, see "Install the UCMDB Browser on

the Same Machine that Runs the UCMDB Server" on page 10.
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l Pre-configured Apache Tomcat Server package for Windows. A zip file called ucmdb-browser-

tomcat-windows.zip that consists of a pre-configured Apache Tomcat server for Windows with the

UCMDB Browser .war file. The UCMDB configuration files reside under the /conf folder.

l Pre-configured Apache Tomcat Server package for Linux. An archive file called ucmdb-browser-

tomcat.tar.gz that consists of a pre-configured Apache Tomcat server for Linux with the UCMDB

Browser .war file. The UCMDB configuration files reside under the /conf folder.

Install the UCMDB Browser on an Existing Tomcat

Note: The installation directory must not contain spaces, and can use only English letters (a-z),

digits (0-9), the hyphen sign ('-'), and the underscore sign (_).

1. Download and install Apache Tomcat version 7.0x.

2. Unzip the file ucmdb-browser-install.zip to an accessible location.

3. Go to the folder where you extracted the contents and in the ucmdb_browser_config.xml file

(located at <UCMDB_Browser_installation_folder>\conf), configure the connection to UCMDB as

follows:

o protocol. CMDB Server protocol

o host_name. CMDB Server name

o host_port. CMDB Server port

o context_name. CMDB Server context name

Note: If the root context has a default value “/” this setting can be omitted.

4. Update the context.xml file in the Tomcat conf folder to include the configuration files in the class

path. It can be found under <Tomcat installation path>\conf\context.xml.

Add under the <context> tag:

<Environment name="ucmdb_browser_home" value="<folder path of the UCMDB_

Browser_installation_folder>" type="java.lang.String" override="false"/>
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For example:

<Environment name="ucmdb_browser_home" value="C:\ucmdb-browser-install\"

type="java.lang.String" override="false"/>

Note: The conf folder should not be part of the path setting for value, as shown in the

example above.

5. Place the .war file under the webapps folder of Tomcat (located at <Tomcat installation

path>\webapps).

6. Start the Tomcat server.

7. Go to http://<server name>:<tomcat port>/ucmdb-browser.

Install the UCMDB Browser on the SameMachine that
Runs the UCMDB Server

Note:

l The installation directory must not contain spaces, and can use only English letters (a-z), digits

(0-9), the hyphen sign ('-'), and the underscore sign (_).

l The UCMDB Browser should not be installed on the same machine that runs the UCMDB server if

you want the UCMDB Browser to work with multiple UCMDB Servers (as described in "Configure

Multiple UCMDB Servers" on page 31). Rather, you should install the UCMDB Browser on a

separate machine.

1. Unzip the file ucmdb-browser-install-for-ucmdb-archive.zip to an accessible location.

2. Copy the file ucmdb-browser.war to the UCMDB server in the folder %UCMDB-Server%deploy/.

Note: If the server is running, use a cut-and-paste operation to put the new WAR file in place,

rather than copy-and-paste. Using cut-and-paste copies the file instantly and causes the

server to deploy the full application (instead of possibly deploying an incomplete WAR file).
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Note: %UCMDB-Server% is the UCMDB server root folder. For example:

C:\hp\UCMDB\UCMDBServer.

3. Restart the UCMDB server.

4. After restart, open the UCMDB Browser with the following URL:

http://server-name:8080/ucmdb-browser

Install the UCMDB Browser with Preconfigured Apache
Tomcat Server on Windows

Note:

l The installation directory must not contain spaces, and can use only English letters (a-z), digits

(0-9), the hyphen sign ('-'), and the underscore sign (_).

l To run Tomcat as a service, Java JDK 7 for Win 64 bit should be installed (not JRE). The Apache

Tomcat version gets its Java from the JAVA_HOME environment variable.

l The pre-configured Apache Tomcat Server has pre-defined user credentials to access the

Tomcat Manager Application. The user credentials are: admin/admin. It is strongly

recommended to change these credentials after installation to prevent unauthorized access to

the Tomcat Manager Application.

To change these credentials go to the Tomcat conf folder, and change the credentials in the file

tomcat-users.xml. For more details, see the Tomcat online documentation at:

http://tomcat.apache.org/tomcat-7.0-doc/manager-howto.html

To install the UCMDB Browser:

1. Unzip the file ucmdb-browser-tomcat-windows.zip to an accessible location.

2. Go to the folder where you extracted the contents and in the ucmdb_browser_config.xml file

(located at <UCMDB_Browser_installation_folder>\conf) configure the connection to the UCMDB

server as follows:
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o protocol. CMDB Server protocol

o host_name. CMDB Server name

o host_port. CMDB Server port

3. Install the Tomcat server as a service using <UCMDB_Browser_installation_folder>/install_

ucmdb_browser_service.bat.

Note: The above step must be performed using administrator privilege.

4. Start the Tomcat server using <UCMDB_Browser_installation_folder>/start_ucmdb_browser_

service.bat.

5. Go to http://<server name>:8088/ucmdb-browser.

Note: After restarting your computer, the Tomcat server starts automatically. To stop the

Tomcat server, run: <UCMDB_Browser_installation_folder>/stop_ucmdb_browser_

service.bat. To uninstall the Tomcat server, run: <UCMDB_Browser_installation_

folder>/uninstall_ucmdb_browser_service.bat.

Install the UCMDB Browser with Preconfigured Apache
Tomcat Server on Linux

Note:

l The installation directory must not contain spaces, and can use only English letters (a-z), digits

(0-9), the hyphen sign ('-'), and the underscore sign (_).

l Java JDK 7 (64 bit) must be installed on the server where you install the UCMDB Browser (the

Apache Tomcat version gets its Java from the JAVA_HOME environment variable).

l The pre-configured Apache Tomcat Server has pre-defined user credentials to access the

Tomcat Manager Application. The user credentials are: admin/admin. It is strongly

recommended to change these credentials after installation to prevent unauthorized access to

the Tomcat Manager Application.
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To change these credentials go to the Tomcat conf folder, and change the credentials in the file

tomcat-users.xml. For more details, see the Tomcat online documentation at:

http://tomcat.apache.org/tomcat-7.0-doc/manager-howto.html

To install the UCMDB Browser:

1. Extract the contents of the archive file ucmdb-browser-tomcat.tar.gz into the folder ucmdb-

browser on your home directory.

2. Go to the ucmdb_browser_config.xml file in the folder ./ucmdb-tomcat/conf and configure the

connection to UCMDB as follows:

o protocol. CMDB Server protocol

o host_name. CMDB Server name

o host_port. CMDB Server port

3. Ensure that all shell scripts (./ucmdb-browser/bin/*.sh files) have ‘execute’ permission. You can

use the command ls –l ./ucmdb-browser/bin/ to do this.

If the shell scripts do not have 'execute' permissions, add them by invoking chmod a+x ./ucmdb-

browser/bin/*.sh.

4. Start the Tomcat server with the pre-installed UCMDB Browser by invoking ./ucmdb-

browser/bin/startup.sh.

Note:

l To stop the Tomcat server, use the command ./ucmdb-browser/bin/shutdown.sh.

l When the UCMDB Browser is embedded on the UCMDB Server and installed on Linux, ensure that

the /etc/hosts file is updated with: 127.0.0.1 localhost.

UCMDB Browser Installation and Configuration Guide

Chapter 1: Installation

HP Universal CMDB Browser (4.04) Page 13 of 203



Install the UCMDB Browser on the JBoss 7 Application
Server

1. Extract the contents ucmdb-browser-install.zip to an accessible location on a local drive.

Note: The installation directory must not contain spaces, and can use only English letters (a-z),

digits (0-9), the hyphen sign ('-'), and the underscore sign (_).

2. Go to the folder where you extracted the contents, and deploy the ucmdb-browser.war file on

JBoss 7.

3. Go to the folder where you extracted the contents and in the ucmdb_browser_config.xml file

(located at <UCMDB_Browser_installation_folder>/conf) configure the connection to the UCMDB

server as follows:

o protocol. CMDB Server protocol

o host_name. CMDB Server name

o host_port. CMDB Server port

4. Add system-properties in the server element in $JBOSS_

HOME\standalone\configuration\standalone.xml as follows:

<server ...>
<extensions>...</extensions>

<system-properties>
<property name="ucmdb_browser_home" value="<UCMDB_Browser_

installation_folder>"/>
</system-properties>

<management>...</management>
...

</server>

where "<UCMDB_Browser_installation_folder>" is the root folder to which you extracted the

contents of the installation zip file in step 1.

5. Restart the JBoss 7 application server.
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6. Optional: If you receive a timeout error message after performing the previous step, add the

attribute deployment-timeout="1200" to the deployment-scanner element in $JBOSS_

HOME\standalone\configuration\standalone.xml. For example:

<deployment-scanner path="deployments" relative-to="jboss.server.base.dir"
scan-interval="5000" deployment-timeout="1200"/>

It is possible to add a timeout value of even more than 1200 if needed.

7. If you performed the previous step, restart the JBoss 7 application server.

Connect the UCMDB Browser to an RTSM Instance
The UCMDB Browser can connect to an RTSM by applying the RTSM port and an integration user. The

RTSM port is usually deployed on 21212. You should also modify the UCMDB user integration credentials

that the UCMDB Browser uses to connect. Create an integration user in the RTSM JMX or use an existing

one and modify it according to the instructions in "Change the UCMDB Integration User Credentials" on

page 22.

If the BSM is configured to authenticate users on LDAP, the RTSM should be configured with the same

LDAP settings as the BSM.

To copy BSM LDAP settings to the RTSM:

1. In BSM, go to Admin > Platform > Users and Permissions > Authentication Management.

2. Open another tab with the RTSM JMX console (http://<server-name>:21212/jmx-console) and find

the method LDAP Settings > configureLDAP.

Note: For <server-name>, enter the RTSM server name. 21212 is the default RTSM port.

3. Copy all LDAP settings from the BSM to the RTSM. The following table shows the correspondence

between setting names in the BSM and RTSM:

BSM Setting name

RTSM JMX Setting

Name Description

LDAP server URL ldapURL LDAP connection string

Users filter userFilter Users filter
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BSM Setting name

RTSM JMX Setting

Name Description

Distinguished Name (DN) Resolution isEnableSearchForDN Distinguished Name (DN)
Resolution

Distinguished Name of Search-
Entitled User

searchUser LDAP Search User

Password of Search-Entitled User searchUserPassword LDAP Search User Password

Groups base DN groupBase Group Base

Groups search filter groupBaseFilter Group Base Filter

Root groups base DN rootGroup Root Group

Root groups filter rootGroupFilter Root Group Filter

Group class object groupClass Group class object

Groups member attribute groupMemberAttribute Groups member attribute

Users object class userClass Users object class

UUID attribute userUID UUID attribute

4. From the same method RTSM JMX > LDAP Settings, invoke allowLDAPAuthentication with the

parameter “true”.

Note: Copying LDAP settings from the BSM to the RTSM does not influence RTSM integrations since

they do not work with LDAP.
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Initial Setup for Working with the UCMDB Browser

Note: These setup steps must be performed for UCMDB 10.10 and later versions.

In order to enable a user to use the UCMDB Browser, you must do the following in UCMDB:

l Enable access to the UCMDB Browser

In the Roles Manager, assign UCMDB Browser access permission to the relevant role.

For details, see "Grant Access to the UCMDB Browser" on the next page

l Specify which widgets will be displayed for a role in the UCMDB Browser

a. Go to Security > Roles Manager.

b. Click the Resources tab and select UCMDB Browser Widgets.

c. Select the widgets for which you want to grant View permission in the UCMDB Browser and click

.

d. When you are finished, click Save .

Note: The list of available UCMDB Browser widgets will be visible in UCMDB only after launching

the UCMDB Browser for the first time.

For details, see "Roles Manager Page" in the HP Universal CMDB Administration Guide.

l Authorize access to CIs

In the Roles Manager, specify the specific access levels to CIs that you want to assign to the role.

For details, see "Authorize Access to CIs" on page 45

Note: Browser CI Access Control is not supported for in multi-tenant installations. To enable CIs

to be viewed in multi-tenant installations, select the View CIs action on the General Actions tab

in the Roles Manager.
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Grant Access to the UCMDB Browser
Starting with UCMDB version 10.10, for a user to access the UCMDB Browser, you must assign access

permission to the relevant role.

1. In UCMDB, go to Security > Roles Manager.

2. Select the role to which you want to add the permission.

3. Click the General Actions tab.

4. In the System Access Actions section, select Access to UCMDB Browser in the Available Actions list

and add it to the Selected Actions list.

5. Click Save .

Best Practices for Working with the UCMDB Browser
This section provides a brief list of settings that impact system performance and enable you to

configure the UCMDB Browser in a way that is faster for production, and reduces the time needed to

apply particular settings.

For more information about these and other settings, see the relevant section in this book.

Settings affecting overall system operation

l Time for which information in the Browser cache is valid. The UCMDB Browser uses a settings

cache, which caches data for faster operation. The default value is 5 minutes. If you increase this,

more users will be able to log in faster. For example, with a 10 minute value, the values in the cache

are considered valid for up to 10 minutes. This means that if user1 logs in, for 10 minutes after that,

all users that log in and read the same settings will use the values from the cache. This results in a

faster login. When you change a setting, it may take the same amount of time for it to be visible. To

clear this cache, access this page: <HOSTNAME>:<PORT>/ucmdb-browser/invalidate_cache.jsp.

l Maximum parallel calls from UCMDB Browser UI to UCMDB Browser web server. The UCMDB

Browser can throttle its asynchronous calls from the UCMDB Browser UI to the UCMDB Browser web

server. If you have more than 8 widgets visible, increase this setting for a faster loading UI. The
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default value is 10. This value should always be a few increments above number of widgets, since

besides each widget that runs a call when selecting a CI’s details, some other calls are also made

(such as updating the most visited page).

l Enable user statistics. The logging of user statistics is disabled by default, for improved

performance.

l Enable notifications. The ability to receive notifications is useful; however, this feature does put a

load on the application. Notifications are enabled by default, but if you do not use them, you can

improve performance by disabling them. Searching would also be faster, since notification data is

not gathered for each CI returned by a search before results are displayed.

Settings affecting search

l Search results page size. This setting specifies the number of rows that are displayed in the results

grid on a single page. The default value should be fine, but you can increase it to see more results in

a single glance. A very high value will result in a slower overall performance, because many more

elements must be loaded in the UI.

l Legacy search

o Show federated search results. This setting only affects the legacy search engine and widgets.

Disable it if issues occur such as the search not working, widgets failing to load, or you notice

exceptions from the UCMDB Federation engine in the logs. An alternative to disabling this setting

is to disable integration points (one by one, or all of them), and then enable them one at a time.

o Return CIs belonging to classes that have MODELING_ENABLED qualifier in legacy search

engine. This setting affects only the legacy search engine. Its value is set to True by default,

which means the legacy search engine works in the same way it did since the first version.

However, search rules that used the MODELING_ENABLED qualifier took 50% more search time.

Changing the value to False reduces the time of the legacy search dramatically if you have

MODELING_ENABLED added to many classes. You can still add custom classes to search results,

using the CMS_BROWSER_SEARCH qualifier.

l Enhanced search

o Search results update interval. This setting affects the enhanced search engine, and specifies

the time period (in milliseconds) after which the UCMDB Browser asks for updates. The default

setting should be fine.
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Create a UCMDB Integration User
You can create a dedicated user for integrations between other products and UCMDB. This user enables

a product that uses the UCMDB client SDK to be authenticated in the server SDK and execute the APIs.

Applications written with this API set must log on with integration user credentials.

Caution: It is also possible to connect with a regular UCMDB user (for instance, admin). However,

this option is not recommended. To connect with a UCMDB user, you must grant the user API

authentication permission.

To create an integration user:

1. Launch the Web browser and enter the server address, as follows:

http://localhost:8080/jmx-console

You may have to log in with a user name and password.

2. Under UCMDB, click service=UCMDB Authorization Services.

3. Locate the createUser operation. This method accepts the following parameters:

o customerId. The customer ID.

o username. The integration user's name.

o userDisplayName. The integration user's display name.

o userLoginName. The integration user's login name.

o password. The integration user's password.

The default password policy requires the UCMDB password to include at least one of each of the

four following types of characters:

l Uppercase alphabetic characters

l Lowercase alphabetic characters
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l Numeric characters

l Symbol characters ,\:/. _?&%=+-[]()|

It also requires the password to adhere to the minimum length, which is set by the Password

minimum length setting.

4. Click Invoke.

5. Locate the setRolesForUser method and enter the following parameters:

o userName. The integration user's name.

o roles. SuperAdmin.

Click Invoke.

6. Locate the setUserServerAdministratorValue method and enter the following parameters:

o customerID. The customer ID.

o userLoginName. The integration user's login name.

o serverAdministratorValue. Select True.

Click Invoke.

7. Either create more users, or close the JMX console.

Note: The integration user is per customer. To create a stronger integration user for cross-

customer usage, use a systemUser with the isSuperIntegrationUser flag set to true. The

system user should have the same user name and password as the integration user.

Change the UCMDB Integration User Credentials
The UCMDB Browser connects to the UCMDB server through the API using the UCMDB UI integration user

credentials. If you changed the UCMDB integration user credentials from the initial default settings,

perform the following steps:

1. Create a credentials.txt tile and put it in the same directory as the ucmdb_browser_config.xml

file.
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2. In the file credentials.txt, enter the following content:

o user=<user-name>

o password=<user-password>

Where user-name is the integration user's user name and user-password is the integration user's

password.

3. Restart the Tomcat server.

Caution: For multiple UCMDB configurations (as described in "Configure Multiple UCMDB

Servers" on page 31, the same integration user should be defined on all UCMDB servers.

Note: After restarting the Tomcat server and then logging in to the UCMDB Browser, a new

encrypted file credentials.bin is created and the file credentials.txt is removed.

Configure the UCMDB Server URL
If UCMDB is deployed in a distributed configuration (in the case of Business Service Management users,

when the Gateway and Data Processing servers are not on the same machine), the UCMDB server URL

should be defined to allow correct access by direct links.

To configure the UCMDB server URL, add the following to the ucmdb_browser_config.xml file:

<ucmdb_ui_url>http://[ucmdb-ui-server-name]:[ucmdb-ui-port]/ucmdb-ui/</ucmdb_ui_
url>

where [ucmdb-ui-server-name] is the UCMDB server name and [ucmdb-ui-port] is the UCMDB-UI

server port.

Configure LW-SSO
1. Configure all external applications that integrate with the UCMDB Browser with LW-SSO settings.

For details about LW-SSO authentication, see the relevant section in one of the following

documents:
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UCMDB Version Document Name

UCMDB 10.00 and 10.01 Hardening the HP Universal CMDB and Configuration Manager

UCMDB 10.10 and later HP Universal CMDB and Configuration Manager Hardening Guide

Note: If you access the UCMDB Browser by IP address (not by FQDN), you should add the UCMDB

Browser IP address to the UCMDB’s trusted hosts. You can do this from the JMX console. Under

LW-SSO Configuration Management, locate the addTrustedIPs method and invoke it using the

UCMDB Browser IP address value.

2. Open the ucmdb_browser_lwsso_config.xml file in the /conf folder in an XML editor and make the

following changes:

o For the domain tag, enter the domain name of the UCMDB Browser (for example, net or

domain-name.com).

o For the value of initString, enter the exact value of initString that is defined for the UCMDB

server and is retrieved when performing the procedure described in the section Retrieving

Current LW-SSO Configuration in Distributed Environment in the relevant document listed in

step 1.

Note:

l In the case of an embedded UCMDB Browser, configure LW-SSO by going to Administration >

Infrastructure Settings Manager > General Settings and configure settings that start with LW-

SSO.

l The UCMDB server name in the ucmdb_browser_config.xml file (under the <host_name> tag)

should be the full DNS name (for example ucmdb-server.com).

l When working with LW-SSO, the URL of the UCMDB Browser should also contain the domain

name (for example http://UCMDB-SERVER.com:8088/ucmdb-browser/).

Configure SSL

Note: If you disable SSL support, you compromise your system's security. You will be vulnerable to

data sniffing and other security attacks.
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To install and configure SSL support on Tomcat:

1. Create a keystore file to store the server's private key and self-signed certificate by running one

of the following commands:

o For Windows: %JAVA_HOME%\bin\keytool -genkey -alias tomcat -keyalg RSA

o For Unix: $JAVA_HOME/bin/keytool -genkey -alias tomcat -keyalg RSA

For both commands, use the password value changeit (for all other fields in the console dialog that

opens, you can use any value).

2. In the $CATALINA_BASE/conf/server.xml file (where $CATALINA_BASE is the directory in which you

installed Tomcat), do the following:

o Remove comments from the entry SSL HTTP/1.1 Connector.

o Set protocol="org.apache.coyote.http11.Http11Protocol" instead of protocol="HTTP/1.1".

This command defines a Java (JSSE) connector, regardless of whether or not the APR library is

loaded.

Note: For a full description on how to configure server.xml to use SSL, see the Apache Tomcat

official site: http://tomcat.apache.org/tomcat-7.0-doc/ssl-howto.html

3. Restart the Tomcat server.

To use the HTTPS protocol for connection to the UCMDB server:

1. In the ucmdb_browser_config.xml file, assign the value https to the tag<protocol> and assign the

UCMDB server HTTPS port value (8443 by default) to the tag <port>.

2. Download the UCMDB server public certificate to the UCMDB Browser machine (if you use SSL on

the UCMDB server, the UCMDB administrator can provide you with this certificate), and import it

into the cacerts trust store on the JRE that is going to connect to the server by running the

following command:

"%JAVA_HOME%\bin\keytool" -import -alias ucmdb -trustcacerts -file <UCMDB-Server-

certificate-file> -keystore "%JAVA_HOME%\jre\lib\security\cacerts"

where <UCMDB-Server-certificate-file> is the full path to the UCMDB server public certificate file.

3. Restart the Tomcat server.
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Configure High Availability Mode
The typical configuration for a high availability environment has two or more UCMDB Browsers that

connect to the same UCMDB server, or to the same load balancer that manages a cluster of UCMDB

servers. The UCMDB Browsers are configured to work behind a load balancer, meaning that the load

balancer serves as the entry point to the UCMDB Browsers. All the UCMDB Browsers are active at any

given time and can handle requests from users. Requests are distributed to the UCMDB Browsers in the

cluster by the load balancer, and are shared evenly among all the UCMDB Browsers.

Note:

l The load balancer used for high availability must have the ability to insert cookies and must be

able to perform health checks ("keepalive").

l These instructions are certified for the F5 BIG-IP version 10.x and F5 BIG-IP version 11.x load

balancers.

If you are using a different load balancer, the configuration should be performed by a network

administrator who has broad knowledge about how to configure load balancers, and principles

similar to those described here should be applied.

l This procedure assumes that you already have at least one UCMDB Browser installed and

configured.

To set up a high availability environment:

1. Create a cluster of UCMDB Browsers.

Install one or more additional UCMDB Browsers to create a cluster. For information about installing

the UCMDB Browser, see "Installation" on page 8.

Note:

o The machines used for all of the UCMDB Browsers in the cluster should have similar

hardware, including the same amount of memory, and should be running the same

operating system.
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o UCMDB Browsers in the cluster must use the same port number for HTTP, HTTPS, and so on.

You cannot configure multiple UCMDB Browsers for high availability if they are using

different ports.

2. Start the UCMDB Browsers.

a. If the first UCMDB Browser is not started, start the process and wait for the startup process to

complete.

b. Start the additional UCMDB Browsers.

3. Configure the load balancer.

The load balancer is used to balance the load that is sent to the UCMDB Browsers in the cluster.

Configure the load balancer as follows:

a. On the load balancer, configure a Cluster VIP address that sends requests to the entire UCMDB

Browser cluster.

b. Configure a pool of back-end servers that represents all UCMDB Browsers in the cluster. This

pool is monitored by a health monitor, which sends requests that can be processed by any

UCMDB Browser in the cluster.

c. Configure the health monitor by providing a keepalive address. The health monitor checks for

the keepalive page of each of the UCMDB Browsers. For the Cluster VIP address, use the

following URL for the keepalive address: /ucmdb-browser/public/ping.jsp.

Possible responses from this URL are:

Response HTTP Response Code

Up 200 OK (desired response)

Down 503 Service unavailable

d. Connect the health monitor to the UCMDB Browser pool configured in step b.

e. Configure session affinity on the load balancer:

l Configure the load balancer to insert cookies to the responses that are sent back to

UCMDB Browser clients (internet browsers).

l Using the Insert method, add a persistence profile cookie for the VIP address.

UCMDB Browser Installation and Configuration Guide

Chapter 2: Configuration and Administration

HP Universal CMDB Browser (4.04) Page 27 of 203



Note:

l The cookie name and value are unimportant, as long as the load balancer knows how

to maintain stickiness with the cookies that it sends out.

l F5 BIG-IP version 10.x adds a session cookie only to the first response per connection

to the server. Other load balancers you might use add a session cookie to each

response.

f. If the VIP is configured to accept secure connections and the load balancer forwards the

requests to the UCMDB Browsers over HTTP, you must configure redirect rewrites. In the load

balancer software, enable the Redirect Rewrite select All option to configure the HTTP

profile associated with the Cluster VIP.

Configure CAC Support
This section describes how to configure Common Access Card (CAC) support on the UCMDB Browser.

1. Make sure that you have access to the keystore, truststore, and crl files. If necessary, you can

create them using the following examples:

o Import the server certificate into the keystore:

$  keytool -importkeystore -deststorepass changeit -destkeypass changeit
-destkeystore keystore.jks -srckeystore ../../certtest/localhost.p12

-srcstoretype PKCS12 -alias sercer

Enter source keystore password:

o Import the certificate authority (CA) certificate into the truststore:

$ keytool -import -keystore cacerts.jks -storepass changeit -alias my_ca

-file ../../certtest/ca.crt

Owner: EMAILADDRESS=ca@naive.sk, CN=CA Admin, OU=CA, O=Naive, L=Bratislava,
ST=Bratislava, C=SK

...too long...

Trust this certificate? [no]: yes

Certificate was added to keystore
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2. Load the client certificate into your Web browser.

3. Open the server.xml file, located in <UCMDB_Browser_installation_

directory>\webapps\release\conf. Add the following lines, if they do not exist:

o <Connector protocol="HTTP/1.1" port="8553" maxThreads="200"

This line specifies the port number. You can use any value, as long as it does not conflict with an

existing port. The default value is 8443.

o SSLEnabled="true" scheme="https" secure="true" sslProtocol="TLS"

This line configures SSL for the Tomcat server.

o truststoreFile="C:\Program Files\Apache Software Foundation\Tomcat

7.0\certificates\server.truststore" truststorePass="hppass"

This line provides the path to the truststore file and the password of the truststore file.

o keystoreFile="C:\Program Files\Apache Software Foundation\Tomcat

7.0\certificates\server.keystore" keystorePass="hppass"

This line provides the path to the keystore file and the password of the keystore file.

o crlFile="C:\Program Files\Apache Software Foundation\Tomcat

7.0\certificates\server.crl"

This line provides the path to the certificate revocation list file.

o clientAuth="true" />

This line specifies that login is permitted only when the client has a valid client certificate.

4. Disable access to other connectors ( to ensure that no user can connect to the Tomcat server with

unsecured HTTP access) by commenting out or deleting other connector tags that are referenced

in the file.

5. Save the server.xml file and restart the Tomcat server.

Note: If your Web browser cannot connect to the Tomcat server after following this procedure,

delete the following line from the server.xml file:
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<Listener className="org.apache.catalina.core.AprLifecycleListener"

SSLEngine="on" />

Save the server.xml file and restart the Tomcat server again.

Configure CAC Support with Multiple CRL Files

The UCMDB Browser can accept multiple CRL files. However, Tomcat only supports a single CRL file via

the crlFile Connector attribute. The following procedure highlights how to work around this Tomcat

limitation so that the UCMDB Browser can use multiple CRL files:

1. Convert the CRL files from DER format to PEM format by using the following OpenSSL command

(DER format is binary and PEM format is Base64-encoded text). Make sure that the CRL file name

does not contain any space, because OpenSSL does not work well with spaces in file names.

OpenSSL crl –inform DER –in <input path to CRL file> -outform PEM –out <output
path to CRL in PEM format>

2. Concatenate the contents of all PEM-formatted files in a proper order into a new file. The content

from Trust Anchor must be the first in the new file.

3. Update server.xml to reference the new file in the crlFile attribute.

The following example demonstrates how to perform the above procedure for two CRL files under the

test64 folder:

1. Convert the CRL file format by using the following commands:

OpenSSL crl –inform DER –in c:/certs/test64/TrustAnchorCRLCP.01.01.crl -outform
PEM –out c:/certs/test64/TrustAnchor.pem
OpenSSL crl –inform DER –in c:/certs/test64/IntermediateCRLRL.02.01.crl -
outform PEM –out c:/certs/test64/Intermediate.pem

2. Open TrustAnchor.pem and Intermediate.pem in a text editor.

3. Copy the entire contents of Intermediate.pem, and then paste the content at the bottom of

TrustAnchor.pem, as shown below.

-----BEGIN X509 CRL-----

MIIBbzCB2QIBATANBgkqhkiG9w0BAQUFADBeMQswCQYDVQQGEwJVUzEYMBYGA1UE

ChMPVS5TLiBHb3Zlcm5tZW50MQwwCgYDVQQLEwNEb0QxEDAOBgNVBAsTB1Rlc3Rp
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bmcxFTATBgNVBAMTDFRydXN0IEFuY2hvchcNOTkwMTAxMTIwMTAwWhcNNDgwMTAx

MTIwMTAwWjAiMCACAScXDTk5MDEwMTEyMDAwMFowDDAKBgNVHRUEAwoBAaAjMCEw

CgYDVR0UBAMCAQEwEwYDVR0jBAwwCoAIq5rr+cLnVI8wDQYJKoZIhvcNAQEFBQAD

gYEAC7lqZwejJRW7QvzH11/7cYcL3racgMxH3PSU/ufvyLk7ahR++RtHary/WeCv

RdyznLiIOA8ZBiguWtVPqsNysNn7WLofQIVa+/TD3T+lece4e1NwGQvj5Q+e2wRt

GXg+gCuTjTKUFfKRnWz7O7RyiJKKim0jtAF4RkCpLebNChY=

-----END X509 CRL-----

-----BEGIN X509 CRL-----

MIIBSzCBtQIBATANBgkqhkiG9w0BAQUFADBeMQswCQYDVQQGEwJVUzEYMBYGA1UE

ChMPVS5TLiBHb3Zlcm5tZW50MQwwCgYDVQQLEwNEb2QxEDAOBgNVBAsTB1Rlc3Rp

bmcxFTATBgNVBAMTDENBMS1STC4wMi4wMRcNOTkwMTAxMTIwMTAwWhcNNDgwMTAx

MTIwMTAwWqAjMCEwCgYDVR0UBAMCAQEwEwYDVR0jBAwwCoAIZdDTuqICq/YwDQYJ

KoZIhvcNAQEFBQADgYEAxrDHzKno1mkJqPTub0c9To6jC3CGTilV1E12oD0kFjkX

qL40+W251qQ2wMC+G7ZrzBIc5dRuJ93feHZ7cc03/s3TziXDvSyfNOYpHzkPwT48

HuSgBYgJ3uswwk+tDiA64NzbOJqssxxhFRok9OpwC8eQkzgpA3a6816v2I3XL9s=

-----END X509 CRL-----

4. Save the concatenated contents to a new file. For example, TrustInt64.pem.

5. Modify the server.xml file so that the crlFile attribute points to this new file:

crlFile="C:/certs/test64/TrustInt64.pem"

6. Save the server.xml file, and then restart the Tomcat server.

Configure Multiple UCMDB Servers
It is possible to configure the UCMDB Browser to work with multiple UCMDB Servers. This is done by

replicating the section <ucmdb_configuration>…</ucmdb_configuration> in the ucmdb_browser_

config.xml file, as shown in the following example:

<ucmdb_configuration name="configuration-1">
<protocol>http</protocol>
<host_name>ucmdb-server-1</host_name>
<host_port>8080</host_port>
<context_name>/</context_name>
<customer>

        <customer_name>company_a</customer_name> 
<customer_number>1</customer_number> 

    </customer>
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</ucmdb_configuration>
<ucmdb_configuration name="configuration-2">

<protocol>http</protocol>
<host_name>ucmdb-server-2</host_name>
<host_port>8080</host_port>
<context_name>/</context_name>
<customer>

        <customer_name>company_b</customer_name> 
<customer_number>6</customer_number> 

    </customer>
</ucmdb_configuration>

There is no limit to the number of UCMDB Servers that you can add in this manner.

Note:

l The value of the name attribute in each configuration (for example, configuration-1 or

configuration-2 in the example above) is optional, but if it is defined it must be a unique value.

l You can specify a default customer by name, ID, or both. If you include the

<customer>...</customer> tag, you must provide details for it. On the login page of the

UCMDB Browser, only the customer that you defined as the default customer for a particular

UCMDB server will be visible in the drop-down list.

l Configuring multiple UCMDB servers is not relevant to the embedded UCMDB Browser since the

embedded UCMDB Browser can connect to only one server. For more information, see "Multiple

Customer Support for the Embedded UCMDB Browser" on page 34.

For each configuration section, the customers for that UCMDB server are retrieved automatically at the

moment that the application server starts, and a connection for each customer is formed using the

value from the name attribute in the ucmdb_configuration tag (if the name attribute is not defined, the

value from the host_name tag is used) and the name of the customer. All these connections appear in

the drop-down list in the login screen. For example, in the case of the xml example above, if

configuration-1 has two customers and configuration-2 has three customers, then the drop-down list

will contain five connections, in the form of:

l configuration-1 – CustomerName1

l configuration-1 – CustomerName2

l configuration-2 – CustomerName1
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l configuration-2 – CustomerName2

l configuration-2 – CustomerName3

If the UCMDB server defined in configuration-2 is inaccessible, then the connection for it is still visible in

the drop-down list (without any customer information), even if the user cannot login using that server.

In that case, the list will contain the connections:

l configuration-1 – CustomerName1

l configuration-1 – CustomerName2

l configuration-2

If only one server is available, then the server name does not appear in the connection name.

Caution: If you have launched the UCMDB Browser with a given UCMDB server, you cannot open

another instance of the UCMDB Browser with a different UCMDB server with the same web browser.

You can, however, open another instance of the UCMDB Browser with a different UCMDB Server if

you use a different web browser. For example, if you opened the UCMDB Browser with Internet

Explorer with a given UCMDB server, you can open the UCMDB Browser using Google Chrome with

another UCMDB server.

Note: The same LW-SSO settings from the ucmdb_browser_lwsso_config.xml file are used for all

UCMDB configurations.

Retrieving Customer States

You can specify whether to retrieve the state(s) for each customer so that the state appears next to

the customer name in the login drop-down list. Currently, the possible states are Actual and Authorized.

The default value for this setting is false, meaning that the customer state does not appear in the login

drop-down list. If you change it to true, the state(s) for each customer is also retrieved, in addition to

the customer name. So if the server host has two customers, Customer-1 with an Actual state and an

Authorized state, and Customer-2 with an Actual state, then the connections will be host – Customer-1

(Actual), host – Customer-1 (Authorized), and host – Customer 2 (Actual).

This setting also applies to the embedded UCMDB Browser, as described below.
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To specify whether to retrieve the state for each customer:

In UCMDB, go to Administration > Infrastructure Settings > UCMDB Browser Settings, and set the

value for Enable customer states.

Multiple Customer Support for the Embedded UCMDB Browser

The embedded UCMDB Browser can connect to only one UCMDB server and so configuration for multiple

UCMDB servers is not relevant. The information regarding the server is automatically sent by the UCMDB

server into which the Browser is embedded. Similar to the case of login for the non-embedded Browser,

the embedded UCMDB Browser searches for all the customers for that server, and for each customer it

creates a different connection. For example, if the host server has two customers, customer1 and

customer2, then the connection names customer1 and customer2 appear in the drop-down list on the

login page.

Also, if the setting to receive customer states has been set to true (as described above), then the

customer state appears next to the customer name in login drop-down for the embedded Browser.

Change the Default Port of the Tomcat Server
The default port value (8080) of the Tomcat Server may conflict with an existing application (for

example, another web application already uses this port). If such a conflict exists, change the default

port as follows:

1. Locate the file server.xml in $CATALINA_BASE/conf/ where $CATALINA_BASE is the directory in

which you installed Tomcat.

2. In server.xml, find a statement similar to the following:

<Connector port="8080" maxHttpHeaderSize="8192"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" redirectPort="8443" acceptCount="100"
connectionTimeout="20000" disableUploadTimeout="true" />

or

<Connector port="8080" protocol="HTTP/1.1"
connectionTimeout="20000"
redirectPort="8443" />
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3. Change the Connector port=”8080″port to any other port number.

For example:

<Connector port="8181" protocol="HTTP/1.1"
connectionTimeout="20000"
redirectPort="8443" />

4. Save the server.xml file and restart the Tomcat server.

Note: To use encrypted parameters on the Tomcat server, for example, an encrypted port number

in the server.xml file, see "Configure to Use Encrypted Parameters on the Tomcat Server" below

Configure to Use Encrypted Parameters on the
Tomcat Server
To configure to use encrypted parameters on the Tomcat server,

1. Stop the Tomcat server.

2. Locate the file catalina.properties in $CATALINA_BASE/conf/, where $CATALINA_BASE is the

directory in which you installed Tomcat.

a. Open the the file catalina.properties.

b. Uncomment or add the following:

org.apache.tomcat.util.digester.PROPERTY_SOURCE=com.hp.ucmdb_
browser.tomcat_config.CustomPropertyDecoder

c. Save the file.

3. Go to the $CATALINA_BASE/lib/ directory, check that you have the following .jar file (if not, copy it

from the Browser 4.00 Release - Tomcat bundle)

o tomcat-property-config.jar

4. Go back to the $CATALINA_BASE/conf/ directory,
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a. Create a file called configproperties.txt.

b. Add values in the form of: <key>=<value>. For example,

my.port=8088

5. Open the $CATALINA_BASE/conf/server.xml file, and use those properties as follows:

This is the HTTP connector, note the my.port usage:

<Connector port="${my.port}" protocol="HTTP/1.1"
connectionTimeout="20000"
redirectPort="8443" />

6. Restart the Tomcat server.

Upon startup, an automatically generated configproperties.bin file, the encrypted version of the

configproperties.txt file, replaces the original configproperties.txt file.

The values of the parameters will be replaced on Tomcat startup, by the values defined in the

encrypted file.

There is now no clear text version of these parameters, they are all encrypted.

Deploy the UCMDB Browser with a Different Root
Context
You can change the default root context name /ucmdb-browser. To do this, rename ucmdb-

browser.war under <Tomcat installation path>\webapps.

For example, if you want to change the context name to /nice-application, rename ucmdb-browser.war

to nice-application.war.

You can also create a multilevel context name. For example, if you want to change the context name to

/very/very/nice-application, rename ucmdb-browser.war to very#very#nice-application.war.
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Upgrade the UCMDB Browser
If you have a version of the UCMDB Browser that is older than the current version, you can upgrade to

the latest version as follows:

1. Download the file ucmdb-browser-install-for-ucmdb.zip from HP Live Network (labeled UCMDB

Browser for UCMDB installation on HP Live Network).

2. Stop the web application (Tomcat or UCMDB Server).

3. Delete the old ucmdb-browser.war file as follows:

o If the Browser is installed on the same machine that runs the UCMDB server: Delete the file

ucmdb-browser.war from the folder %UCMDB-Server%deploy/, where %UCMDB-Server% is

the UCMDB server root folder.

o For all other installations: Delete ucmdb_browser.war from <Tomcat installation

path>\webapps. Also, in <Tomcat installation path>\webapps delete the ucmdb_browser

folder.

4. Copy the new ucmdb-browser.war file to the appropriate locations as follows:

o If the Browser is installed on the same machine that runs the UCMDB server: Copy the file

ucmdb-browser.war to %UCMDB-Server%deploy/. Clear the ucmdb-browser.war folder from

C:\hp\UCMDB\UCMDBServer\runtime\jetty-cache before starting the UCMDB server.

o For all other installations: Copy ucmdb_browser.war to <Tomcat installation path>\webapps.

Note: If the server is running, use a cut-and-paste operation to put the new WAR file in place,

rather than copy-and-paste. Using cut-and-paste copies the file instantly and causes the

server to deploy the full application (instead of possibly deploying an incomplete WAR file).

%UCMDB-Server% is the UCMDB server root folder. For example: C:\hp\UCMDB\UCMDBServer.

5. Copy the necessary update resources, depending on the type of installation you have, as follows:

o If you have your own Tomcat installation (meaning, you installed the UCMDB Browser according

to the instructions in "Install the UCMDB Browser on an Existing Tomcat" on page 9), copy the

setenv.bat file to the bin folder.
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o If you installed the UCMDB Browser according to the instructions in "Install the UCMDB Browser

with Preconfigured Apache Tomcat Server on Linux" on page 12, copy the setenv.sh file to the

bin folder.

o If you installed the UCMDB Browser according to the instructions in "Install the UCMDB Browser

with Preconfigured Apache Tomcat Server on Windows" on page 11, copy the update_ucmdb_

browser_service.bat file to the root folder of your installation (the same place where the

install_ucmdb_browser_service.bat is located) and run it.

6. Read the release notes for the latest version to determine which features and functionality you

want to use and update your Browser settings accordingly.

7. Start the Tomcat server or UCMDB server (depending on your installation).

All features and functionality from the previous installation are active in the new installation, as well as

the new features and functionality for the latest version.

Upgrade the UCMDB Browser Embedded in
Configuration Manager
You can independently upgrade to the latest version of the UCMDB Browser embedded in Configuration

Manager as follows:

1. Navigate to the following folder:

<Configuration Manager installation folder>/servers/server-0/webapps

2. Delete the ucmdb-browser.war file.

3. Verify that the ucmdb-browser folder has been deleted as well. If the folder still appears after

approximately 30 seconds, stop the Configuration Manager service and delete the folder manually.

4. Copy the new ucmdb-browser.war file into the folder:

<Configuration Manager installation folder>/servers/server-0/webapps

Note: If the server is running, use a cut-and-paste operation to put the new WAR file in place,

rather than copy-and-paste. Using cut-and-paste copies the file instantly and causes the

server to deploy the full application (instead of possibly deploying an incomplete WAR file).
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5. If you stopped the Configuration Manager service and deleted the ucmdb-browser folder manually

(as described in step 3), restart the Configuration Manager service.

6. Verify that the ucmdb-browser folder has been recreated.

Configure Reverse Proxy for the Apache Tomcat and
IIS Servers
The client can configure reverse proxy on the UCMDB Browser for either the Apache Tomcat or IIS

servers.

Configure Reverse Proxy for the Apache Tomcat Server

1. Configure reverse proxy to append header X-Reverse-Proxy with the reverse proxy URL for Apache-

server. To do this, open file %apache-home-directory%\conf\httpd.conf (where %apache-home-

directory% is the Apache server home directory), and add the following lines:

o LoadModule headers_module modules/mod_headers.so

o RequestHeader set X-Reverse-Proxy http://srp-server-front-end-url

Where http://srp-server-front-end-url is the entire reverse proxy’s frontend URL.

2. Restart the Apache Tomcat server.

Configure Reverse Proxy for the IIS Server

Prerequisites

Install Application Request Routing (ARR) by using one of the following methods:

l Install ARR by using the Microsoft Web Platform Installer.

l Download and install ARR from the following address:

http://www.iis.net/downloads/microsoft/application-request-routing

Configure the IIS server
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1. Open IIS Manager, expand the server node, right-click Server Farms, and then click Create Server

Farm. The Create Server Farm wizard opens.

2. Enter the name of the server farm, make sure the Online option is selected, and then click Next.

The Add Server page is displayed.

3. Add the UCMDB Browser server by using the following steps:

a. Enter the IP address of the UCMDB Browser server in the Server address field.

b. Click Advanced settings, expand the applicationRequestRouting section, and then specify the

port numbers for the UCMDB Browser server.

c. Click Add.

d. Click Finish.

4. Click Yes when IIS Manager displays the following message:

IIS Manager can create a URL rewrite rule to route all incoming requests to this server farm

automatically. Do you want to create this rule now?

Configure an Environment to Use Multiple Reverse
Proxies
When clients are connected to the same UCMDB Browser instance through multiple reverse proxies, the

UCMDB Browser needs to know each client’s frontend URL to build correct direct links to the HP

Configuration Manager and HP Service Manager servers. For example, a client who accesses the UCMDB

Browser by reverse proxy https://reverse-proxy-1 should get a direct link by the same https://reverse-

proxy-1.

Therefore, a configuration based on relative URLs instead of full URLs should be implemented. When

the UCMDB-Browser receives a request with a header X-Reverse Proxy, it relates to application URLs as

relative URLs and concatenates part of the header with a relative URL. To use this solution the

customer should:

1. Configure each reverse proxy in the environment to append header X-Reverse-Proxy with the

Reverse Proxy’s frontend URL.

2. Use a relative URL for all servers behind the reverse proxy in the UCMDB-Browser configuration.
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To perform the actual configuration:

1. Configure reverse proxy to append header X-Reverse-Proxy with the reverse proxy URL for Apache-

server. To do this, open file %apache-home-directory%\conf\httpd.conf (where %apache-home-

directory% is the Apache server home directory), and add the following lines:

o LoadModule headers_module modules/mod_headers.so

o RequestHeader set X-Reverse-Proxy http://srp-server-front-end-url

Where http://srp-server-front-end-url is the entire reverse proxy’s frontend URL.

2. The UCMDB Browser configuration file should use relative URLs instead of full URLs. For example,

instead of http://cm-server/cnc, use /cnc. Specifically, it is very important that the value of tag

<ucmdb_ui_url> is defined and uses a relative path.

Configure a One-Time Authentication Token
The one-time authentication token is an additional means for the user to access to UCMDB Browser by a

direct link (URL with parameters). With such a URL, the user does not need input credentials. The

advantage of this method is that:

l The URL does not contain user credentials.

l The URL is for one time use only (after initial use, the URL cannot be used again).

Note: You must have administrator rights in order to generate an authentication token for another

user.

To configure and use the one-time authentication token:

1. Create a URL for obtaining the one time authentication token as follows:

http://<server-name>:<port>/ucmdb-browser/generate-authentication-

token.jsp?username=<your_user_name>&password=<your-password>&server=<ucmdb-

server>&logged-in-user=<logged_in_user_name>

where the parameters server and logged-in-user are optional.

The following is an example of a URL for obtaining one time authentication token:
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http://server-name:8088/ucmdb-browser/generate-authentication-

token.jsp?username=johndoe&password=12345678&server=ucmdb-server

Note:

o Parameter names are case sensitive and should be used exactly as they appear in this

documentation.

o When an optional parameter (such as server) is omitted, the first server from the

configuration is used.

o The server name in the [server] parameter should be taken from one of the <host_name>

fields in UCMDB Browser configuration file. If the [server] parameter is defined but it’s

value does not correspond to any of the values of the <host_name> field in UCMDB Browser

configuration file, the authentication token will be not generated.

2. Execute the URL prepared in the previous step. After successful execution, the Authentication-

Token field in the response http-header contains the authentication token value created for the

parameters you entered in the previous step. The http field is used here for a return value to

enlarge security strength.

Note:

o The response http-header fields can be viewed by using any external request interceptor

(such as Fiddler) or tools embedded into a web browser (for example, in Chrome: Developer

Tools > Network tab).

o If the credentials provided in the previous step are not valid, the authentication-token field

is empty or not present at all.

3. Build the URL for the UCMDB Browser by using the parameter authentication-token and the token

value obtained in the previous step. For example:

http://server-name:8088/ucmdb-browser/?authentication-token=<token-value>

where token-value is the authentication token string obtained in the previous step.

After executing the URL, you are redirected to the UCMDB Browser without having to enter user

credentials.
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Note: After restarting the server of the UCMDB Browser, all prepared authentication tokens

are no longer valid.

Configure Browser Internal Priorities (for the Incidents
and Problems Widgets)
For both the Incidents and Problems widgets, configuration of the UCMDB Browser Internal Priorities is

performed in UCMDB.

1. Go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

2. In the Names column, find the following settings:

o List of statuses for an major priority incident or problem

o List of statuses for an minor priority incident or problem

o List of statuses for an none priority incident or problem

o List of statuses for an open incident or problem

o List of statuses for an urgent priority incident or problem

3. In the Value column, change the priority name for any of the settings above according to your

system needs.

Disable Compatibility View for Internet Explorer 8
If you want to use the UCMDB Browser with Internet Explorer 8 (IE8), you must disable compatibility view

as follows:

1. In IE8, go to Tools > Compatibility View Settings.

2. In the Compatibility View Settings dialog box, uncheck the following options:

o Display intranet sites in Compatibility View

UCMDB Browser Installation and Configuration Guide

Chapter 2: Configuration and Administration

HP Universal CMDB Browser (4.04) Page 43 of 203



o Display all websites in Compatibility View

3. Click Close.

Configuration Mechanism
The UCMDB Browser configuration settings are kept on the UCMDB Server to which the UCMDB Browser

is connected. The Browser configuration settings on the UCMDB Server are accessible from in UCMDB (in

Administration > Infrastructure Settings > UCMDB Browser Settings). The settings appear only after

initial login, which triggers a settings deployment on the UCMDB Server.

For each group of configuration settings, there is a setting called: Enable XXX, where XXX is the name

of a Browser feature (for example, Enable the Incidents Widget, and so on). This setting can be used to

enable/disable the group of settings. For example, if Enable the Incidents Widget is set to false, the

Incidents Widget is not available in the UCMDB Browser.

Note: When upgrading to UCMDB 10.0x, the UCMDB Browser settings are not upgraded. The UCMDB

administrator should set them manually in Infrastructure Settings Manager in UCMDB.

Specify the Number of Concurrent Sessions
By default, a user can open an unlimited number of sessions. You can specify the maximum number of

sessions that a user may log into concurrently.

Note: This setting cannot be used for:

l UCMDB Browsers in a high availability environment.

l a standalone UCMDB Browser that is connected to multiple UCMDB servers.

l a standalone UCMDB Browser that is connected to a UCMDB server with multiple customers.

l the embedded UCMDB Browser of a UCMDB that is configured with CAC.

1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

2. In the Name column, choose Maximum sessions per user.

3. In the Value column, enter a number.
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4. Click Save .

5. Log out from the UCMDB Browser, and then log in again (this loads the new settings).

Enable/Disable Timeout of a Browser Session
It is possible to set a timeout for a Browser session if the UCMDB Browser is not used for a certain

period of time. If the timeout is enabled and a user does not perform any actions in the UCMDB Browser

for the set timeout period, then when the user tries to perform an action in the Browser a message

appears for 2 seconds stating that the session has expired and the user is redirected to the Browser

login page.

Note: The default wait period for the timeout is 30 minutes. This value can be changed in the Java

web.xml file, located at:

%WEB_SERVER_HOME%\webapps\ucmdb-browser\WEB-INF\web.xml

By default this timeout is disabled, but you can change this setting according to the following

instructions.

1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

2. In the Name column, choose Enable the Session Timeout.

3. In the Value column, choose True or False (depending on whether you want to enable or disable the

timeout) from the drop-down list .

4. Click Save .

5. Log out from the UCMDB Browser, and then log in again (this loads the new setting).

Authorize Access to CIs
Browser CI Access Control enables you to assign granular access to the CIs in views or CI types in UCMDB,

according to a user's assigned role. A role that has global View or Edit permission can see all CIs and

relationships in UCMDB. A role that has View or Edit permission for a particular view can see only the CIs

and relationships in that view. In addition, permission can be granted to view or edit particular CI types.
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Note:

l You must assign at least one permission for a view or CIT in order to see CIs in the UCMDB

Browser.

l You must have View permission on a particular CI in order to refocus on it, even if that CI is

visible in a widget because of Browser CI Access Control settings.

To authorize access to CIs:

1. In UCMDB, go to Security > Roles Manager.

2. Select the role to which you want to assign access.

3. Click the Browser CI Access Control tab and add available actions as required.

4. Select an available view or CI type for which you want to assign permissions.

5. When you are finished, click Save .

For additional details about permissions, see "User Permissions for the UCMDB Browser" in the HP

Universal CMDB Administration Guide.

Note:

l If a CI does not have Edit permission assigned through a view or CI type, the Edit button will not

be displayed in the Properties widget and it will not be possible to change any property's

attributes in the UCMDB Browser.

l A user will be able to see the composite CIs of permitted CIs, even he has not been granted

specific permission for those composite CIs.

l If a user has permissions on CIs of two CI types and those CIs are not composite CIs, in order to

have permission on their relationship (for example, to view them in the Environment widget),

the necessary triplet should be added to the calculated link. This is named Authorized

Relationship Addition (UCMDB Browser), and it can be found in CI Type Manager > Calculated

Relationships.
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Use Cases

Enable a user to view or edit all CIs

l Read only: Assign the global permission View All to all CIs for a role.

l Read/Write: Assign the global permission Edit All to all CIs for a role.

Enable a user to view or edit only specific CIs

l Read only:

o Assign View permission to specific views.

o Assign View All CIs permission to a particular CI type.

Note: By default, in the UCMDB Browser, the Party and Location CI types are automatically

assigned View All CIs permission.

l Read/Write:

Do one of the following:

o To edit all CIs that you can view, assign Edit All CIs permission on all views.

o To edit CIs in a specific view, assign Edit All CIs permission on only that view.

o To edit only specific CI types in relevant views, assign Edit By CIT permission to the views and

Edit In View permission to a particular CI type.

Note: You can assign permissions to a group of views by selecting a node in the list of

Available Views, or apply the permissions to all views by selecting the Root node.

o To edit all CIs of a specific CI type, assign Edit All CIs permission to that CI type.
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Enable a user to view all CIs and edit only specific CIs

l Assign the global permission View All to all CIs for a role.

Do one of the following:

l To edit all CIs of a specific CI type, assign Edit All CIs permission to that CI type.

l To edit only specific CIs:

o To edit all CIs that you can view, assign Edit All CIs permission on all views.

o To edit CIs in a specific view, assign Edit All CIs permission on only that view.

o To edit only specific CI types in relevant views, assign Edit By CIT permission to the views and

Edit In View permission to a particular CI type.

Note: You can assign permissions to a group of views by selecting a node in the list of

Available Views, or apply the permissions to all views by selecting the Root node.

o To edit all CIs of a specific CI type, assign Edit All CIs permission to that CI type.

Brand the UCMDB Browser
The majority of UCMDB Browser installations are delivered with Hewlett-Packard branding. However, you

have the ability to apply a header and footer, add custom text and an icon in the header of the UCMDB

Browser, and replace the image that appears on the landing page.

In all UCMDB Browser installations, the <UCMDB_Browser_installation_directory>

\webapps\ucmdb-browser\public\branding folder contains sample icon, image, and stylesheet files.

You can replace or update these files as desired, and specify their location in the settings in UCMDB, as

described below.

Recommended image sizes are:

l for icons - 20 x 20 pixels

l for the landing page image - 135 x 135 pixels

Example of the CSS stylesheet:
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.bannerClass {
background-color: yellow;
color: blue;
font-weight: bold;
font-style:italic;

}

To brand the UCMDB Browser:

1. In UCMDB, go to Administration > Infrastructure Settings Manager, and choose UCMDB Browser

settings.

2. Update the following settings as required:

Name Value

Banner stylesheet URL The URL of the stylesheet used for the banner text.

Banner text The text that will appear in the header and footer.

Custom masthead text Customized text that will appear in the masthead of the
UCMDB Browser.

Custom icon for masthead The URL of the icon that will appear in the masthead of the
UCMDB Browser.

Custom image for landing page The URL of the image that will appear on the landing page of
the UCMDB Browser.

Note: For the best visual effect, use a graphic with a
transparent background.

Custom product name The name of the product that will appear on the landing page
of the UCMDB Browser.

Note: If you specify customized text and an icon for the masthead, they will appear in addition

to the current Hewlett-Packard text and image, and not as replacements.

3. Click Save .
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Log User Statistics
The UCMDB Browser can log the user's functional activities, including aspects of the Browser's

performance and error messages. No user details are logged, and no UCMDB data, such as CI attributes,

are logged. The log files are stored in the same folder as the UCMDB Browser log folder.

The log files and their data are not sent in any way and remain strictly in the customer's local

environment. HP may request that customers share the data in order to learn how the UCMDB Browser

is being used. By default, this logging functionality is disabled. It is possible to turn it on by setting the

Enable user statistics UCMDB Browser setting to true.

Note: If UCMDB Browser is installed on a JBoss application server, logging is only supported in

versions 7.2.0 (6.1.0 EAP) and later.

How to Set UCMDB Browser Session to Expire
To set a UCMDB Browser session to expire when LW-SSO is enabled,

1. In UCMDB, go to Administration > Infrastructure Settings Manager.

2. With all categories of infrastructure settings displayed, select Name for the Filter by column field,

and enter LW-SSO in the field next to it to display all LW-SSO settings.

3. Check if the LW-SSO cookie expiration period setting value is smaller than the LW-SSO ping

interval setting value. (Both of the settings are expressed in minutes.)

If not, modify the values for the two settings to ensure that LW-SSO cookie expiration period is

smaller than the LW-SSO ping interval.

When LW-SSO ping interval is lower than LW-SSO cookie expiration period, this means that the

session will never expire. The ping will keep the session active.

4. Click Save .

5. Restart UCMDB Server.
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Logging In
To log in to the UCMDB Browser, enter the following in a web browser:

http://<server_name>:<8088>/ucmdb-browser

where <server_name> represents the fully qualified domain name (FQDN) of the UCMDB server.

Note:

l To log in to the UCMDB Browser, your UCMDB license must be valid.

l If you attempt to log in to the UCMDB Browser and a UCMDB server is not available, an error

message is displayed.

l Starting from UCMDB version 10.10, if you attempt to log in to the UCMDB Browser in a multi-

customer environment and you have not been assigned a role with the permission, an error

message is displayed.

If a default password or password policy has been defined (available for UCMDB 10.00 and later

versions), and you attempt to log in to the UCMDB Browser using that default password, you will receive

a message asking you to change it. Select a new password and log in again using the new password.

After enabling or disabling the default password feature, the UCMDB Browser cache settings must time

out once before the new setting takes effect. To specify the cache value:
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In UCMDB, go to Administration > Infrastructure Settings > UCMDB Browser Settings,and set Time for

which information in the Browser cache is valid=X, where X is a number of minutes.

The cache can be manually invalidated by navigating to this page: http://{YOUR_UCMDB_BROWSER_

URL}/invalidate_cache.jsp

You can specify a redirection URL when you log out of the UCMDB Browser. Use the Logoout forward

URL setting in the Infrastructure Settings Manager in UCMDB. Be sure to add http:// to the URL if

required.

No user administration is possible from within the UCMDB Browser (this is only performed in UCMDB).

Note:

l The initial launch after the installation of the UCMDB Browser (prior to login) can take from 30

seconds up to a couple of minutes.

l When logging in to the UCMDB Browser for the first time with any given UCMDB Server, the login

takes longer (from 30 seconds up to a couple of minutes) due to automatic deployments.

l If you are using the UCMDB Browser with a UCMDB 10.00 server, after login the logged-in user

locale information is taken from the UCMDB server and the Browser uses the user’s locale. If

there is no locale defined for the user, or if the UCMDB server is a version earlier than 10.00, the

locale of the Browser is used.

Login to the UCMDB Browser occurs as follows:

l UCMDB users. The users of the UCMDB Browser are the same as the users of UCMDB, therefore, only

users that exist in UCMDB are able to log in to the UCMDB Browser.

l LDAP users. When the UCMDB server is configured to authenticate on LDAP, the UCMDB Browser

automatically detects this and uses this configuration to authenticate users against the same LDAP.

Note: The following LDAP group configuration is relevant for UCMDB 9.xx only. For UCMDB 10.xx

and later versions, all LDAP configuration and group mapping is performed only on the UCMDB

server, as well as all authentication processing, including LDAP integration.

When LDAP authentication is performed, you can manage permissions in the ucmdb_browser_

config.xml file. There are two permission options:

o Allow access to UCMDB Browser for all LDAP users. Access for all LDAP users is enabled if the

section <ldap_configuration> does not exist in the ucmdb_browser_config.xml file or does not
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contain at least one record as follows: <group>ldap-group</group> (where ldap-group is an

actual LDAP group name).

o Allow access to the UCMDB Browser only for LDAP users that are related to LDAP groups. LDAP

groups are saved as a list, separated by comma. The setting name is List of LDAP group

(groups).

<ldap_configuration>
<permitted_groups>

<group>group-1</group>
<group>group-2</group>

</permitted_groups>
</ldap_configuration>

Note: The example above of the <ldap_configuration> section with two sample records is

placed in the comments in the ucmdb_browser_config.xml file.

Landing Page
The Search page and the UCMDB Browser header are automatically displayed when you log in to the

UCMDB Browser.

Note: You can open the Search page from anywhere else in the UCMDB Browser simply by clicking

the <product name> section in the upper left corner of the UCMDB Browser window.

The UCMDB Browser header is designed to offer a clean and compact look.

You can find the Search, Reports, Service Modeling, and Notifications tabs to the right side of the logo

and product name. The background of the header is light gray.

Hovering your mouse over the Search tab allows you access to the following modules:

1. Quick Search

2. Advanced Search

3. Most Visited

4. Most Searched

You can find the login user related options, Settings options and the Help menu in the upper right
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corner of the UCMDB Browser window.

<Username> Menu

Hovering your mouse over the <username> allows you to access the following:

l Server details

l Last login time

l Administration Console. This option is available with UCMDB Browser 4.01. For details, see

"Accessing the Administration Console for UCMDB Browser" on the next page.

l Logout

Settings Menu

Hovering your mouse over the Settings icon allows you to access the following:

l Manage System Categories. See "Assign Color Categories" on page 94.

l Schedule Notifications. See "Notifications" on page 143.

l Manage Discovery Status. See "Discovery Indicators " on page 114.

Help Menu

Hovering your mouse over the Help icon allows you to access the following:

l Help. Accessing the Help section, UCMDB Browser's Help page or a custom help page opens.

Starting from UCMDB Browser version 4.03, you can create a custom help page for the UCMDB

Browser’s users in the UCMDB UI > Administration > Infrastructure Settings Manager > UCMDB

Browser Settings > Custom Help Page URL. In the value field, add a URL, for instance

http://www.hpe.com.

When the non-administrator user accesses the Help section in the UCMDB Browser, the custom Help

page opens.
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l About. Accessing the About section, the UCMDB Browser's version and the Copyright Information are

displayed.

Accessing the Administration Console for UCMDB
Browser
Starting from UCMDB Browser version 4.01, you can access various administrative tools for the UCMDB

Browser from within the new Administration Console for UCMDB Browser.

The Administration Console for UCMDB Browser is available for users with the Administration Privileges.

You can access the Administration Console page using either of the following methods:

l Hover your mouse over the <username>> Administration Console.

l Use one of the following URLs: http://<browser-home>/admin or http://<browser-

home>/Admin.jsp

Bi-directional direct links are available from the UCMDB Browser to Administration Console.

Main modules available in the Administration Console include:

l Cache Operations. EhCache values stored in the browser. Usually data cached from the server.

l Logs. Displays a list of UCMDB Browser logs. You can View Full, Download, and Tail a log entry.

l Version. Displays the following information:

o UCMDB Browser version

o UCMDB Server product name, version, and build

o Content Pack version and build.

l Session Manager. You can view all logged in users with their active sessions.

Configure the Enhanced Search Engine

Note: The Enhanced CI search engine is supported on UCMDB 10.00 and later versions.
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The Enhanced CI search engine translates free text queries to TQL queries, with much better

performance and accuracy than the legacy search engine and flexible searching language. The syntax of

the search queries is based on the class model.

Note: The Enhanced CI search engine does not support any of the class model configurations used

by the legacy search engine.

The search engine can be configured in the following three areas:

l Indexing. Configure what is indexed, which CI types are "searchable", which attributes are

"searchable", and what are types of the attributes. This configuration is performed with the Search_

Indexer_Configuration_XML and Search_Ranking_Configuration_XML files.

This configuration file includes a list of class types that are indexed and a list of attributes for each

one of the class types. This configuration influences the manner in which the search by property

condition is performed.

l Parsing. Configure class model synonyms. Synonyms translate the user input string query into a

graph structure, TQL. This configuration is performed with the Search_Parser_Configuration_XML

file.

This configuration file includes a set of class synonyms, attribute synonyms, date synonyms, relation

synonyms, and a set of redundant words.

Note: The list of redundant words must contain only single words, with no spaces (no phrases

are permitted).

l Ranking. Configure which CI types are presented and the order of presentation. Prioritization is

according to class model. This configuration is performed with the Search_Ranking_Configuration_

XML file.

This configuration file contains a list of attributes that are associated with five data fields, called

data0, data1, data2, data3, and data4. These fields are prioritized, where data4 has the highest

priority and data0 has the lowest priority.

This configuration influences the order of CIs in the search results.

The UCMDB Browser can be used out-of-the-box without initial configuration of the search engine.

However, if an attribute is not in the Indexer or Ranking lists, it does not appear in the search results.
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Modify the currently indexed list

1. Go to JMX Console > UCMDB:service=Topology Search Services.

2. Choose one or more of the following operations:

o editIndexerConfiguration – displays and enables editing of the Search_Indexer_Configuration_

XML file.

o editParserConfiguration – displays and enables editing of the Search_Parser_Configuration_

XML file.

o editRankingConfiguration – displays and enables editing of the Search_Ranking_

Configuration_XML file.

3. For each operation, enter the relevant customer ID and click Invoke.

Enable/Disable the Enhanced Search Engine

For the enhanced search engine to work, it must be enabled in UCMDB. By default, it is enabled (unless it

was disabled during UCMDB installation).

To change the enable/disable setting:

1. Go to JMX Console > UCMDB:service=Settings Services > setGlobalSettingValue.

2. In the name field enter cmdb.search.enabled.

3. In the value field enter:

true: If you want the search enabled.

false: If you want the search disabled.

4. Click Invoke.

5. Restart the UCMDB server.

Note: If you disable the Enhanced Search Engine, the UCMDB Browser automatically reverts to the

legacy search engine.
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Enable/Disable Searching for Federated Data

The enhanced search engine can be configured to perform searches on federated data. By default, it is

disabled. To enable searching for federated data, you must set the "federated search enable" flag to

True in the JMX Console and in the UCMDB Infrastructure Settings Manager.

Enable or disable searching for federated data in the JMX console

1. Go to JMX Console > UCMDB:service=Settings Services > setSettingValue.

2. In the name field enter cmdb.federation.search.enabled.

3. In the value field enter:

true: If you want to enable searching federated data.

false: If you want to disable searching federated data.

4. Click Invoke.

5. Restart the UCMDB server.

Enable or disable searching for federated data in the UCMDB Infrastructure Settings

Manager

Follow the instructions in the section "Specify Data stores Used for Data Loading" in the HP Universal

CMDB Administration Guide.

Enable searching of federated CIs by CI display name

To search for a federated CI by the CI display name (or sub-string of the display name), the CI type must

be assigned the qualifier CMS_BROWSER_SEARCH in the CI Type Manager.

Specific Configuration Options

Configure Search by Data

In the Search_Ranking_Configuration_XML file, you can associate attributes of a CI to a data field

according to the data field priority. This enables a search of the values of those CI attributes and
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affects the order of CIs returned in the search results.

Configure Search by Topology

In the Search_Parser_Configuration_XML file, you can configure relationship synonyms that associate

phrases with class types. For example, in the example below, the phrase "owned by" is associated with

the class type "person".

<relationship>
<synonym>owned by</synonym>
<className>person</className>

</relationship>

As a result of the above configuration, if the user enters the search query "all windows owned by John",

the search engine looks for all windows CIs that are connected to a CI of type 'person' with the name

'John'.

Configure Search by Path

In the Search_Parser_Configuration_XML file, you can define compound classes by inserting a list of

class types. In the example below, all the class types in the <string> tag make up the compound class,

which triggers the search by path. If this list is empty, no search by path is initiated.

You can change the number of linked paths through which you want to search, starting from the original

search term. To do this, go to the Infrastructure Settings Manager in UCMDB and change the Search

Engine Compound Depth setting to the value you want. For details, see "Infrastructure Settings

Manager" in the HP Universal CMDB Administration Guide.

<compoundClasses>
<string>msdomain</string>
<string>person</string>
<string>osuser</string>
<string>location</string>
<string>business_element</string>
<string>cluster</string>
<string>party</string>

</compoundClasses>

Configure Search by Cardinality Condition

In the Search_Parser_Configuration_XML file, you can define a set of cardinality synonyms that

associate phrases with cardinality types. For example, if you define

<cardinalitySynonym cardinalityType="MIN" cardinalityPhrase="with at least"/>
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and then a user enters the search query "all NT with at least 2 CPUs", the search engine looks for all CIs

with class type 'NT' that have two or more CIs of type CPU related to them.

The out-of-the-box cardinality synonyms are as follows:

<cardinalitySynonyms>
<cardinalitySynonym cardinalityType="MIN" cardinalityPhrase="min"/>
<cardinalitySynonym cardinalityType="MIN" cardinalityPhrase="with minimum"/>
<cardinalitySynonym cardinalityType="EQUAL" cardinalityPhrase="with"/>
<cardinalitySynonym cardinalityType="MAX" cardinalityPhrase="max"/>
<cardinalitySynonym cardinalityType="MAX" cardinalityPhrase="with maximum"/>
<cardinalitySynonym cardinalityType="MIN" cardinalityPhrase="minimum"/>
<cardinalitySynonym cardinalityType="MAX" cardinalityPhrase="before"/>
<cardinalitySynonym cardinalityType="MAX_EXCLUDED" cardinalityPhrase="with

less than"/>
<cardinalitySynonym cardinalityType="EQUAL" cardinalityPhrase="with

exactly"/>
<cardinalitySynonym cardinalityType="MIN" cardinalityPhrase="with at least"/>
<cardinalitySynonym cardinalityType="MIN_EXCLUDED" cardinalityPhrase="with

more then"/>
<cardinalitySynonym cardinalityType="MIN" cardinalityPhrase="since"/>
<cardinalitySynonym cardinalityType="MIN" cardinalityPhrase="from"/>
<cardinalitySynonym cardinalityType="MIN" cardinalityPhrase="at least"/>
<cardinalitySynonym cardinalityType="MAX" cardinalityPhrase="till"/>
<cardinalitySynonym cardinalityType="NOT" cardinalityPhrase="without"/>
<cardinalitySynonym cardinalityType="MIN_EXCLUDED" cardinalityPhrase="with

more than"/>
<cardinalitySynonym cardinalityType="MIN" cardinalityPhrase="after"/>
<cardinalitySynonym cardinalityType="MAX" cardinalityPhrase="with at most"/>
<cardinalitySynonym cardinalityType="MAX" cardinalityPhrase="maximum"/>
<cardinalitySynonym cardinalityType="MAX_EXCLUDED" cardinalityPhrase="with

less then"/>
<cardinalitySynonym cardinalityType="MAX" cardinalityPhrase="at most"/>

</cardinalitySynonyms>

Configure Search by Property Condition

This search is based on attribute synonyms. In the Search_Parser_Configuration_XML file, you can

define synonyms for the CI attribute names that are defined in UCMDB. In the following example, the CI

attribute display_label has four different synonyms defined for it:

<attributeSynonym>
<synonym>name</synonym>
<attributes>

<attributeName>display_label</attributeName>
</attributes>
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</attributeSynonym>
<attributeSynonym>

<synonym>display label</synonym>
<attributes>

<attributeName>display_label</attributeName>
</attributes>

</attributeSynonym>
<attributeSynonym>

<synonym>display</synonym>
<attributes>

<attributeName>display_label</attributeName>
</attributes>

</attributeSynonym>
<attributeSynonym>

<synonym>label</synonym>
<attributes>

<attributeName>display_label</attributeName>
</attributes>

</attributeSynonym>

Another type of search by property condition occurs when a cardinality synonym is followed by a

number, which can also include a unit. For example, if the user enters the search input text windows

with at least 4GB memory, since memory is a synonym for the attribute types memory_size and nt_

physical_memory as shown in the code example below, this triggers a search by property condition.

<attributeSynonym>
<synonym>memory</synonym>
<attributes>

<attributeName>memory_size</attributeName>
<attributeName>nt_physicalmemory</attributeName>

</attributes>
</attributeSynonym>
.
.
.
<unit>

<multiplyBy>1073741824</multiplyBy>
<synonym>gigabytes</synonym>
<synonym>g</synonym>
<synonym>giga</synonym>
<synonym>gb</synonym>

</unit>

You can add additional synonyms for cardinality phrases, synonyms for attribute names, and synonyms

for unit types in order to refine this type of search. In the example above, the memory size attribute is

stored in bytes, and in order to search by gigabytes, the search engine uses the conversion defined in
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the <multiplyBy> tag (this definition is provided out-of-the-box). In addition to the conversion for

gigabytes, out-of-the-box conversions are also provided for megabytes and kilobytes.

Note: Units and numbers are rounded according to the range definitions defined by the Use Update

Value Policy qualifier. For more information on setting range definitions, see "The Use Update

Value Policy Qualifier" in the HP Universal CMDB Modeling Guide.

Configure Search by Category

In the Search_Parser_Configuration_XML file, you can specify labels to be used when searching for CIs.

In the following example, the labels "category" and "color" enable you to search for the strings “all

windows color green” and “all servers category editable”.

<categoryLabelSynonyms>
<categoryLabelSynonym>category</categoryLabelSynonym>

</categoryLabelSynonyms>
<categoryColorSynonyms>

<categoryColorSynonym>color</categoryColorSynonym>
</categoryColorSynonyms>

Configure Class Name Conditions

In the Search_Parser_Configuration_XML file, you can create synonyms for class names. In the

following example, the synonym "windows" was created for the class name "nt".

<classSynonym>
<synonym>windows</synonym>
<className>nt</className>

</classSynonym>

Configure String Replacement

In the Search_Parser_Configuration_XML file, you can configure string replacements. The code

example below enables the search engine to retrieve all nodes that have the attribute Host is virtual

set to True. The CI property 'host_isvirtual' is a boolean property, and is true if the node is virtual, but

the user does not need to know this and this string replacement converts his search query without the

user knowing these details.

<replace>
<from>virtual node</from>
<to>node host_isvirtual true</to>

</replace>
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String replacement can be implemented using the '%' wildcard character. With the following code

example, if the user enters the search query "linux nodes" or "linux machine", the search engine

converts this to "nodes version linux" and “machine version linux”, respectively.

<replace>
<from>linux %1</from>
<to>%1 version linux</to>

</replace>

Configure Enriching Capability

The enriching mechanism executes enriching queries over the search results. Enriching queries are

defined in two ways, one is user-defined and the other is based on existing folding rules.

The enriching mechanism reviews the CIs in the search results and extends the results by applying each

one of the enriching queries as a perspective over the CI. The enriching process is executed repeatedly,

where after each execution search results are received and then enriched again by the enriching TQLs,

which in turn produces more search results. By default, this process is repeated 3 times, but this can be

changed by means of the cmdb.search.enriching.depth parameter. For instructions on configuring this

parameter, see "Configure Repetition of the Enriching Mechanism" on the next page.

User-Defined Enriching Queries

To create user-defined enriching queries:

1. In UCMDB, go to Modeling > Modeling Studio and click New .

2. From the drop-down list, select Query. The Query Definition editor opens.

3. Click Query Definition Properties . The Query Definition Properties dialog box opens.

4. In the Type field, select Perspective from the drop-down list.

5. In the Bundles field, click Select Bundles .

6. From the Bundles list, select search_result_enriching_tqls and click OK.

7. Define the query according to your system needs.

8. Define one of the nodes of the query as Set as Contact Query Node. The query definition is similar

to the perspective definition and therefore should include at least one contact node, where the

contact node is the CI that should be enriched.
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There are also two out-of-the-box enriching queries provided in the Modeling Studio. You can view and

edit them as follows:

1. Go to Modeling > Modeling Studio, and select the Resources tab.

2. From the Resources Type drop-down list, select Queries.

3. In the list of queries, go to Search Engine > Enriching TQLs.

4. Under Enriching TQLs, choose one of the enriching queries. You can view it and edit it according to

you system needs.

Enriching Queries Based on Existing Folding Rules

As mentioned above, in addition to the user-defined enriching queries, there is an existing set of

predefined enriching queries based on folding rules.

To view, add, or edit enriching queries based on folding rules:

1. Go to Modeling > CI Type Manager.

2. From the CI Types drop-down list, choose Calculated Relationships.

3. In the list of Calculated Links, select Folding Rules (Configuration Manager).

4. Select the Triplets tab on the upper right. The list of Triplets appears.

From each one of the listed triplets there is an automatic mechanism that creates at run-time an

enriching query. It enriches the Target CI type by the Source CI type. In this case, the Target CI type

is the contact node of the query.

5. To add a new triplet, click Add . If you select the forward relationship direction (from Source to

Target), the Target CI type is enriched by the Source CI type. If you select the backward relationship

direction (from Target to Source), the Source CI type is enriched by the Target CI type.

6. To edit a triplet, select the triplet in the list and click .

Note: To disable the use of folding rules, change the Specify whether Search Engine Enriching

should use folding rules setting in the Infrastructure Settings Manager to False.

Configure Repetition of the Enriching Mechanism

To configure the number of times that enriching is performed on search results:
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1. Go to JMX Console > UCMDB:service=Settings Services > setSettingValue.

2. In the name field enter cmdb.search.enriching.depth.

3. In the value field enter the number of times that you want enriching to be repeated on search

results.

4. Click Invoke.

5. Restart the UCMDB server.

Note: Changing the cmdb.search.enriching.depth parameter value to a higher value can introduce

performance issues due to generating a large search result.

Configure Redundant Words

There is a set of words that the search engine ignores when parsing the search query. To configure this

list, go to the Search_Parser_Configuration_XML file and go to the <blacklist> section. Add to or edit

the list as needed.

The current list of redundant words is a follows:

<blacklist>
<blacklistItem>to</blacklistItem>
<blacklistItem>such as</blacklistItem>
<blacklistItem>with</blacklistItem>
<blacklistItem>for</blacklistItem>
<blacklistItem>or</blacklistItem>
<blacklistItem>a</blacklistItem>
<blacklistItem>the</blacklistItem>
<blacklistItem>like</blacklistItem>
<blacklistItem>in</blacklistItem>
<blacklistItem>and</blacklistItem>
<blacklistItem>of</blacklistItem>
<blacklistItem>if</blacklistItem>
<blacklistItem>an</blacklistItem>
<blacklistItem>on</blacklistItem>
<blacklistItem>linked</blacklistItem>
<blacklistItem>all</blacklistItem>

</blacklist>

Configure Search of CIs Changed in a Specific Time Period

In the Search_Parser_Configuration_XML file, there are a sets of words defined as month-name
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synonyms and day-name synonyms. For example:

<monthSynonym>
<monthName>january</monthName>
<monthNumber>0</monthNumber>

</monthSynonym>
<monthSynonym>

<monthName>jan</monthName>
<monthNumber>0</monthNumber>

</monthSynonym>
.
.
.
<daySynonym>

<dayName>sunday</dayName>
<dayNumber>1</dayNumber>

</daySynonym>
<daySynonym>

<dayName>sun</dayName>
<dayNumber>1</dayNumber>

</daySynonym>

Values in the tags <monthNumber> and <dayNumber> should not be modified. These configurations

allow support of search queries like “all windows created last Sunday” and “all nodes changes between

August 8th 1980 and 25/5/2011”.

Configure Date Format

The search engine supports two dates formats: day-month-year (DMY) and month-day-year (MDY),

which can be configured as follows:

1. Go to JMX Console > UCMDB:service=Settings Services > setSettingValue.

2. In the name field enter: cmdb.search.date.format.

3. In the value field enter the desired date format: DMY, MDY, or both.

4. Click Invoke.

5. Restart the UCMDB server.

Configure Autocompletion

In the Search_Autocompletion_Configuration_XML file, you can expand the UCMDB Browser's search

capabilities by configuring the UCMDB server to suggest matches for substrings of words in a search,
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including CI attribute values.

1. Go to JMX Console > UCMDB:service=URM Services > listResourceTypes and click Invoke.

2. Click Topology_AUTOCOMPLETION_CONFIGURATION.

3. Click Search_Autocompletion_Configuration_XML.

4. Enter the fields of classes that you want to index for autocompletion. Since the class name

supports inheritance, you can enter the following:

<supportedAutocompletionFields>
<autocompletionField>

<className>managed_object</className>
<attributeName>display_label</attributeName>

</autocompletionField>
</supportedAutocompletionFields>

or, for example:

<supportedAutocompletionFields>
<autocompletionField>

<className>nt</className>
<attributeName>display_label</attributeName>

</autocompletionField>
<autocompletionField>

<className>unix</className>
<attributeName>display_label</attributeName>

</autocompletionField>
</supportedAutocompletionFields>

5. Click Save resource.

Configure Query Search Filter

By default, the search algorithm filters out the queries that are too general. If you wish to turn off the

filter, follow these steps:

1. Go to JMX Console > UCMDB:service=Settings Services > setSettingValue.

2. In the name field, enter cmdb.search.filter.queries.
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3. In the value field, enter false.

Note: Enter true if you want to turn on the filter.

4. Click Invoke.

Perform a Full Reindex of All CIs

Use either of the following approaches to perform a full reindex of all CIs available for search in the

UCMDB Browser:

l Go to JMX Console > UCMDB:service=Topology Search Services and invoke the reindex() method.

This method removes all CIs information stored inside the SOLR index files without removing any

internal SOLR files.

Note: You can also invoke the reindexCiType() method to re-index all the CIs of a given CI type

from the CMDB model database. For more information, refer to the HP Universal CMDB JMX

Reference Guide.

l Stop the UCMDB server, delete the <UCMDB_Server_Home>/search folder, and then start the

UCMDB server.

The deletion of the folder forces a full reindex for all UCMDB customers and reverts the SOLR

configuration to the out of the box values. This process removes all internal SOLR files and hence

takes longer time than the previous one.

Troubleshooting

UCMDB doesn’t start because of the search subsystem manager. What do I do?

Stop UCMDB, delete the folder <UCMDB installation folder>/search, then restart UCMDB.

If the search still does not start, disable it, as explained in "Enable/Disable the Enhanced Search Engine"

on page 58 and revert to the legacy search engine.
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The search doesn’t return any results.

1. Check that UCMDB Search Engine is enabled.

2. If the search engine is enabled, the server might be indexing the CIs. No CIs can be returned until

the indexing process has completed.

3. If the indexing process has completed, in the Topology Search JMX, invoke the following methods:

o restoreFactoryDefaults: This restores factory configuration for the search.

o reindex: This recreates a search index for CIs in the UCMDB model. Note, this can take up to

several hours for large databases (approx 1M CIs/hour).

You can also invoke the reindexCiType method to re-index all the CIs of a given CI type from the

CMDB model database.

The search doesn't find CI types that I want.

There are several different possible causes for this. Check the following:

l Check that the attribute and CI type are indexable according to the indexing configuration. If they

are not, add the class attributes configuration item as explained "Modify the currently indexed list"

on page 58.

l Check that you have correct synonyms defined for the class in Class synonyms.

l Check that rating and pageItemCount for this CI are non-zero. Check for rating in the Attribute

ranking and for pageItemCount in Presentable CI types.

Cardinality conditions don't work or return incorrect results.

In addition to checking attribute synonyms, check that the attribute type is defined as numeric in

Indexing Configuration and that units configuration matches attribute units in Search_Parser_

Configuration_XML.

The search presents too many unwanted results.

l Check if you are you using queries with natural language. This can limit results of the "best guess" of

what the user intended.
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l If you need to be 100% certain that your query returns results only of one specific CI type, use type:

ci-type filter in the query.

l If the two suggestions above don't help, contact the R&D team with your use case and status report

from JMX.

Problem with configuration - restore factory defaults

To restore the default configuration XML files from the factory content, go to JMX Console >

UCMDB:service=Topology Search Services and invoke the restoreFactoryDefaults() method.

Caution: This method overwrites the current configuration. You should back up the configuration

files before invoking it.

Logs and debugging info

Logs

search.log logs everything related to searches. Default log level is INFO, only statistics are printed. The

log level and number of logs are configured with the search.loglevel variable in

conf/log/cmdb.properties.

Status Report

The topology search JMX status report displays all current configuration tables and statistics for the

search engine component. It is useful to include it when reporting issues to R&D.

Content of Solr Database

By default, the Solr search engine is embedded inside UCMDB server. To query it directly, go to JMX

Console > UCMDB:service=Topology Search Services and invoke the debugSolrQuery() method.

Example queries:

l empty query returns all CIs

l "id:a6693cd46cfd1b4fab0c3551bac9289e" returns a CI with cmdbId

a6693cd46cfd1b4fab0c3551bac9289e. This uses Solr/Lucene syntax.

Using the Enhanced Search Engine

Note: This feature is supported on UCMDB 10.00 and later versions.
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The UCMDB’s powerful enhanced search engine analyzes the input search text to retrieve CI data from

UCMDB. Based on the input search text, the search engine performs various types of searches

simultaneously to provide optimum and comprehensive results to the user. The search engine makes

extensive use of synonyms so you do not need to enter the precise name or data of the items you are

looking for.

To enhance your ability to obtain better search results, examples and explanations of the available

types of searches are provided here.

Note:

l The search engine is provided ready to use out-of-the box. However, it is highly configurable

and the various types of searches described here can be modified by the UCMDB Administrator

to meet your system needs. For more information on configuring the enhanced search engine,

see "Specific Configuration Options" on page 59.

l The enhanced search engine is not case sensitive.

l The free text search in the enhanced search engine can only be performed in English, other

languages are currently not supported. However, CI names, attributes, and values in other

languages can be found by the enhanced search engine.

Simple Search

The simple search is the most basic type of search. The search engine searches for CIs according to CI

data and synonyms for CI data. CI data can include class names and attributes.

Simple Search Examples

l If you enter all Unix or all business application, this triggers a search by class name, since Unix and

business application are class names. The search results include all Unix machines in the system

(when searching for all Unix), or all business applications in the system (when searching for all

business application).

l If you enter all Windows, since windows is a class name synonym for NT, a search by class type is

triggered for all Windows PCs in the system.

For information on how to configure class name synonyms, see "Configure Class Name Conditions"

on page 63.
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l If you enter Windows version 2008, since version is a synonym of the property discovered_os_

name, this triggers a search for all Windows PCs where the property discovered_os_name = 2008.

l If you enter Windows with more than 4GB of memory, since memory is a synonym of the property

memory_size, this triggers a search by property condition for all Windows PCs with the attribute

memory_size > 4GB.

Note: Searches can be performed with any type of pre-defined unit, as explained in "Configure

Search by Property Condition" on page 61. Out-of-the-box definitions are provided for kilobyte,

megabyte, and gigabyte.

For more information on how to configure attribute synonyms, see "Configure Search by Property

Condition" on page 61.

l If you enter all nodes changed last week, all Unix machines created today, or all Windows

changed since Aug 21st 2013, the search engine can interpret this correctly to yield appropriate

results.

For information on how to configure this search, see "Configure Search of CIs Changed in a Specific

Time Period" on page 66. For information on configuring date formats, see "Configure Date Format"

on page 67.

Search According to CMDB Structure

Searches Based on CI Relationships

If you enter Windows 2008, the search engine looks for CIs with the class name or property Windows

that have a related CI with a property value 2008. This could include, for example, a Windows server

connected to SQL server 2008.

For information on how to configure searching based on CI relationships, see "Configure Search by

Topology" on page 60.

Search by Path

l If you enter Windows London, this triggers a search that yields results of all Windows PCs in the

system that are connected directly or indirectly to the London CI.

UCMDB Browser Installation and Configuration Guide

Chapter 3: Search and Functionality

HP Universal CMDB Browser (4.04) Page 73 of 203



For more information on how to configure this type of search, see "Configure Search by Path" on

page 60.

l If you enter all Windows owned by John, the search engine returns all Windows PCs owned by the

user called John.

l If you enter Oracle 16.55.158, the search engine yields search results with all Oracle servers in the

16.55.158.* IP address range.

Search by Cardinality Condition

Certain words or phrases trigger a cardinality search, such as with more than or with less than. If you

enter Windows with more than 5 CPUs, this triggers a search that yields results of all Windows PCs

with at least 5 CIs of type CPU connected to them. The term that follows the cardinality phrase must be

a class name or class synonym. In the example here, CPU is a class synonym.

For information on how to configure the search by cardinality, see "Configure Search by Cardinality

Condition" on page 60.

Note: The example above triggers a search based on CI relationships, since in the UCMDB CPUs are

modeled separately from servers (with direct relationship between them) and this information may

be transparent to the user.

Different Types of Search Results Based on the Same Input

Text

As mentioned above, based on the input search text, the search engine can perform various types of

searches simultaneously. For example, if you enter Windows 2008, the search engine returns the

following results:

l CIs with the class name or property Windows that have a related CI with a property value 2008

(search based on CI relationships, as described above).

l All CIs that have both a property called Windows and a property called 2008.

l All CIs with the class name Windows and a property called 2008.
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Special Support

Phrase Replacement

If you enter Linux machine, this triggers a search of all Unix machines with version = Linux.

For information on how to configure this search, see "Configure String Replacement" on page 63.

Search with Keywords

The search engine supports a set of pre-defined keywords that allow you to perform special searches.

The keywords are type, view, and query.

Search with type Keyword

You can use the type: keyword to filter search results. For example, John type:windows return all

Windows owned by John.

Search with view Keyword

You can search for CIs in a view by using the keyword view: followed by the view name. For example,

view:myView returns all CIs in the myView view result.

Note: The view name is case sensitive (in the UCMDB the user can define two views myView and

MyVIEW). Also, if the view name contains more than one word (separated with spaces) the view

name should be surrounded with quotation marks, for example view:"My view".

Search with query Keyword

You can also search for CIs in query results. This is similar to searching for CIs in view results, but for the

active query defined in UCMDB. For example, query:myQuery returns all CIs in the myQuery result.

Searches Based on Logical Operators

You can use a combination of conditions separated by logical operators. The search engine parses the

search input string from left to right without regards to the prioritization of logical operators, and not
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according to the standard rules of logical operator prioritization. For example, A or B and C is treated

as (A or B) and C, and not as A or (B and C).

Examples

l If you enter Nodes owned by John or Jim, this triggers a search that yields results of all nodes in the

system with an owner John and all nodes in the system with an owner Jim.

l If you enter All Windows with more than 4 CPUs and with at least 4 GB memory, the search

engine yields results of all Windows PCs in the system that have both more than 4 CPUs and at least

4 GB memory.

l If you enter All Windows versions not 2008, the search engine yields results of all Windows PCs in

the system that are not version 2008.

Enriching Search Results

Explanation and Examples

Since the user is not always aware of how IT entities are modeled in UCMDB, he may enter search input

text for one thing while his real intention was something else. The search engine has been designed

with an enriching mechanism that can "guess" the user’s real intention. For example, if the user

searches for the IP address 16.59.188.16, he may be actually interested in the IP’s connected node, and

so the enriching mechanism looks for all nodes connected to the IP address.

It is possible that the user enters London, but what he really wants to know are the nodes at this

location. The enriching mechanism has been designed to look for all nodes connected to a location CI, so

in this example the search engine would return all nodes connected to the London CI.

For information on how to configure the search engine's enriching capability, see "Configure Enriching

Capability" on page 64.

Federated Search

Explanation and Examples

All the types of searches described above are not performed on federated data. However, the search

engine contains some predefined hard-coded topological queries for performing searches on federated

data. For example, if you enter myServer name and the server name is a federated CI, there is a
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federated query that tries to retrieve the CI by its name. This TQL is executed for the CI types node,

business element, and CI collection.

Note:

l The search on federated data can only be performed if it is enabled. By default, it is disabled.

l The search for federated CIs according to their display names (or sub-string of their display

names) is performed if the CI type has been configured for this.

For instructions on enabling/disabling the search on federated data and enabling a search of a

federated CI by the CI display name, see "Enable/Disable Searching for Federated Data" on page

59.

The user can also retrieve data on relationships between federated CIs. For example, the user can

retrieve CIs by their IP address. If you enter 16.1.100.45 and this is the IP address of a federated CI, the

search engine returns the actual node connected to this IP address.

Auto-Completion Search Entry Capability

Auto-completion capability is added to the search field and supports the following language entries:

l CI Type names and synonyms (for example: Windows=NT)

l Attribute names and synonyms (for example: version=DiscoveredOsName)

l Relationship names and synonyms (for example: linked to and located in)

l Cardinality phrases (for example with more than and at least)

Legacy CI Search Engine
The search is performed in the most intuitive way possible using natural language, in the same manner

as modern search engines. The UCMDB Browser currently supports searches for CIs according to the

following attributes:

l ID

l Display Label
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l Location

l IP Address

l Party (that is, owner)

l Any attribute marked with the CMS_SEARCHABLE_ATTRIBUTE qualifier. For details on how to add

this qualifier to an attribute, see "Adding the Search Qualifier to an Attribute" on the next page.

Note: By default, CIs with the MODELING_ENABLED qualifier are included in the search results.

To improve performance, you can exclude these CIs by setting Return CIs with MODELING_

ENABLED qualifier (legacy search engine) in the Infrastructure Settings Manager to False. The

CMS_SEARCHABLE_ATTRIBUTE qualifier on an attribute overrides this setting.

l If searching for a term that matches a CI Type Display Label, all the instances of the matching CI

Type are displayed along with the results of the normal search.

The following are some search examples:

l Searching for John Doe, who is a project manager, yields all Business Elements and Nodes whose

owner is John Doe

l Searching for 172.16, which is the most significant part of an IP address, yields all Nodes with an IP-

address starting with “172.16” (that reside in that subnet)

l Searching for Ohio yields all Nodes residing in data centers located in the state of Ohio, USA

l Searching for Oracle yields all nodes and relevant running software related to the Oracle DB

l If the DiscoveredOsName attribute is marked with the CMS_SEARCHABLE_ATTRIBUTE qualifier,

searching for Windows 2008 Server yields all Nodes with the DiscoveredOsName attribute equal to

Windows 2008 Server.

Search Results: Search results (in the current version – CIs) are the heart of the UCMDB Browser. Users

get results of their search criteria, view relevant information at a glance, and, if required, zoom into the

results for a more detailed view. Search results include only Star CI types, which are the most important

CI types. Star CI types receive special treatment from all (or most) widgets, thus allowing users to

receive more comprehensive and relevant information regarding them.

The following is a list of all Star CI types:
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l Business Elements Related

l CI Collection

l Node

l Running Software (excluding Agent, Inventory Scanner)

l All CI types with the Modeling Enabled or CMS_BROWSER_SEARCH qualifier

Composite Search: A Composite Search allows searching for any CI Type (not just Star CI types). The

search terms must be in the form: X + Y (two search terms, separated by the "+" character). Any of the

search terms can be a possible CI Type display label (for example, "Windows + server_partial_name" is

equivalent to "server_partial_name + Windows").

Performing a Composite Search greatly increases the number of CIs that can be found in the UCMDB

Browser. Searching is performed on the CI Type represented by one of the search terms. The other

search term is considered as input for the normal search algorithm (described above). Federated data is

also searched, if federation is enabled from the configuration file. For details, see "Specify Data Stores

Used for Data Loading (legacy search engine)" on page 81.

The matching algorithm attempts to find an exact match on the first term. If nothing is found, it

attempts to find a partial match on the first term (for example, entering "dows" matches the

"Windows" CI Type, entering "nix" matches "Unix" CI Type). If no results are found, the algorithm

attempts to find an exact match on the second term, and if nothing is found, it attempts to find a

partial match on the second term. If no results are found on the second term, the algorithm performs a

search on both terms together including the '+' character.

The Composite Search is not case sensitive. If there are multiple CI Type matches, only the first one will

be returned. If there are more than two terms (for example, a+b+c), the search is performed on the

entire expression, including the '+' character.

Search by Global ID: The user can perform a search for a CI according to its Global ID. This is useful in

the case of federated CIs, where the Global ID and the CMDB ID differ. For example, if a CI has a Global ID

with a value of daily%0Ant%0A1%0ACMDB_ADAPTER_

ID%3DSTRING%3Df37a5e73a861db7f417ba1ee4192544b%0A%03%03%03rmiron1%0Ant

%0A1%0ACMDB_ADAPTER_ID, you can use the Global ID value as search input in the UCMDB Browser.

CI Refocus: Each CI presented in the UCMDB Browser, either as a search result or as part of a specific

widget, can be refocused by simply selecting it. Refocusing a CI presents its data using the information

widgets.

Adding the Search Qualifier to an Attribute
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The CMS_SEARCHABLE_ATTRIBUTE qualifier can be added to a CI attribute, thus enabling that CI to

appear in search results performed in the UCMDB Browser.

Note: This qualifier should not be added to an attribute that does not support the LIKE_IGNORE_

CASE operator (for example integer attributes). This qualifier should only be used with attributes

that support LIKE_IGNORE_CASE operator, such as string attributes.

To add the CMS_SEARCHABLE_ATTRIBUTE qualifier to an attribute:

1. In UCMDB, go Modeling > CI Type Manager.

2. Select the class in which you want to change an attribute.

3. Select the Export to XML button in the upper right of the CI Types tree.

4. Save the XML file containing the exported class on a local drive.

5. Open the XML file for editing.

6. Find the section corresponding to the attribute to which you want to add the CMS_SEARCHABLE_

ATTRIBUTE qualifier.

An attribute section appears like this:

<Attribute name="attr_name" type="type">
<Attribute-Qualifiers>

<Attribute-Qualifier name="ATTRIBUTE_QUALIFIER1"/>
<Attribute-Qualifier name="ATTRIBUTE_QUALIFIER2"/>

….
</Attribute-Qualifiers>

</Attribute>

Note: If the attribute you want to edit does not have the <Attribute-Qualifiers> section, add it

as specified above.

7. In the <Attribute-Qualifiers> section, add the new <Attribute-Qualifier> tag as follows:

<Attribute-Qualifier name=”CMS_SEARCHABLE_ATTRIBUTE”/>

8. Save the XML file.

9. Go back to the CI Type Manager.
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10. Select the class that you previously exported.

11. Select the Import from XML button in the upper right of the tree.

12. Select the XML file that you previously modified.

13. Wait for the import to complete. You will see a success notification message if the import process

is successful, or a failure message with errors if the process fails.

Specify Data Stores Used for Data Loading (legacy
search engine)
The flag federated_search_enabled is used to enable or disable the use of federation regarding several

operations in the UCMDB Browser. If this flag is set to False (this is the default value), the legacy search

engine, enhanced search engine, Properties widget, Environment widget, and Impact Simulation widget

all use only the local data store for gathering data. If this flag is set to True, all data stores are used

when running a search in the legacy search engine and enhanced search engine, and also when data is

loaded for the Properties, Environment, and Impact Simulation widgets.

This flag is set on the UCMDB server.

Set the federated_search_enabled flag

1. In UCMDB, go to Administration > Infrastructure Settings Manager, and choose UCMDB Browser

settings.

2. In the Name column, choose Show federated search results.

3. In the Value column, choose True or False from the drop-down list.

4. Click Save .

Limitations on Using Federated Data

The use of federated data has the following limitations:

l The Environment widget cannot load data from a completely remote CI (that is, a CI that exists only

in a remote data store and does not exist in the local data store).
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l For completely remote CIs, the Properties widget does not display properties calculated from

related CIs.

Specify CI Types Returned in Search Results (legacy
search engine)
In the legacy search engine, this Boolean configuration allows the user to control which CI types are

returned in search results.

In UCMDB, configuring the CI Types to be returned in Search Results is done through the Show only

results with CI Types with CMS_BROWSER_SEARCH class qualifier setting. This Boolean determines

the CI candidates for search. The default option (false) searches for Star CIs and also CIs with the CMS_

BROWSER_SEARCH qualifier. When this Boolean is true the search is conducted on CIs with the CMS_

BROWSER_SEARCH qualifier only.

Export Search Results
You can perform a search and export the search results to a CSV or Excel file.

To specify the attributes to be exported:

1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

2. Do the following:

o In the Name column, choose Minimal export of search results and choose True if you want to

export only the display label, class name, CI ID, and Global ID attributes for each CI. Choose False

if you want to export all attributes that are displayed in the Properties Widget.

Additional attributes can be excluded if they are marked in the CI Type Manager in UCMDB. For

details, see the description of the Hide in Export Search Results qualifier in the HP Universal

CMDB Modeling Guide.

o In the Name column, choose Remove logical attributes (owner, location) from export of

search results and choose True to remove the owner and location attributes from the exported

search results.
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To export search results to a file:

1. Click Export results in the search results toolbar. The following options are available:

o Current page > XLS or CSV

o All pages > XLS or CSV

2. Click Open, Save, or Cancel.

The created file is named with the date and time that the export was performed.

Specify the Appearance and Order of Widgets
You can specify which widgets appear in the Browser and in what order.

l For UCMDB 10.00 and 10.01 versions: In the Infrastructure Settings Manager in UCMDB, you specify

the list of widgets that you do not want to appear in the Browser with the List of widgets to be

removed from the application setting and the order that the widgets appear with the List of

widget order in the application setting. For details, see "Infrastructure Settings Manager" in the HP

Universal CMDB Administration Guide.

l For UCMDB 10.10 and later versions: In addition to specifying whether widgets (including dynamic

widgets) and their order are visible for all users (as mentioned in the previous section), you can

choose the widgets that you want to appear in the Browser only for a particular role by selecting

them on the Resources tab of the Roles Manager in UCMDB. For details, see "Roles Manager" in the

HP Universal CMDB Administration Guide.

Configure Properties to be Displayed by the Properties
Widget

For UCMDB 10.00 version

You can configure attributes of CI Types to be either displayed by the Properties widget or not displayed

by the Properties widget as follows:
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1. In UCMDB, go to Modeling > CI Type Manager.

2. In the list of CI Types on the left, choose the CI Type with the attribute(s) that you want to

configure.

3. Select the Attributes tab in the editor on the right.

4. In the list of attributes, double-click on the attribute that you want to configure.

The Edit Attribute window appears.

5. In the Edit Attribute window, click the UCMDB Browser Qualifiers tab and do one of the following:

o To hide an attribute:

Select Hide in Properties Widget.

Note: If you select Hide in Properties Widget, make sure that CMS Browser Visible is not

also selected. Otherwise, notifications may appear for attributes that are not visible.

o To display an attribute:

Select CMS Browser Visible.

6. Click OK.

CI Overview Mode

A maximum of three properties are displayed for the selected CI, according to the following priorities:

Note: The order in which properties are presented is alphabetic and cannot be configured.

l For Non-Star CIs: The first three properties according to these priorities:

a. Attributes with the CMS Browser Visible qualifier on concrete attributes or attributes that are

inherited from Star CIs

b. Concrete attributes (not inherited)

l For Star CIs:

o Attributes with the CMS Browser Visible qualifier on concrete attributes or attributes that are

inherited from Star CIs.
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o Special or calculated attributes

l For Node Star CI type:

l Discovered Model

l Discovered OS Name

l Display Label from all connected IP Address (comma-separated)

l Memory Size

l For Running Software CI type:

l Discovered Product Name

l Display Label from connected Node

l Application Category

l For CI Collection type: the same attributes as for the Non-Star CI

l For Business Element Related CI type:

l Business Criticality

l Last Modified Time

o Concrete from the actual CI type or inherited from the Star CI.

The order in which properties are presented in CI Overview mode is alphabetic and cannot be

configured.

Widget Details Mode

Properties are displayed in the three panels as follows:

1. Core Properties

o Star CIs

l Node

l CMDB Object ID/Global ID

l Discovered OS Name
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l Node Operating System Installation Type

l Serial Number

l Discovered OS Version

l Discovered Vendor

l Domain Name

l Memory Size attribute from instance

l CPU Type from connected CPU, if empty – Name from connected CPU

l Calculated number of Core Number from all connected CPU CIs

l Calculated total File System Size from all connected File System CIs

l Running Software

l CMDB Object ID/Global ID

l Discovered Product Name

l Version

l Vendor

l Business Element/CI Collection

l CMDB Object ID/Global ID

l Business Criticality (for Business Element)

l Also:

l All concrete attributes (not derived) that are Visible, excluding static attributes, or

attributes that are inherited from the Star CI.

o Non-Star CIs

l CMDB Object ID/Global ID

l All concrete attributes (not derived) that are Visible, excluding static attributes.
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2. Complementary Properties

o Star CIs

l Node

l Last Modified Time

l Updated By

l Node Boot Time

l Node Is Virtual

l Running Software

l Application Category

l Application Installed Path

l Application Version Description

l Last Modified Time

l Updated By

l Business Element/CI Collection

l Create Time

l Created By

l Last Modified Time

l Updated By

l Also:

l Concatenation of Display Name (comma-separated) of all directly connected Party CIs.

For example," John Doe, UCMDB UI, CMS, HP SW, HP” (divided into two labels, Owners for

Person CIs and Organizations for Organization CIs).

l Concatenation of Display Name (comma-separated) of all directly connected Location
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CIs. For example, “Room 301, 3rd floor, M1, Cupertino, California, World, Milky Way,

Universe”.

o Non-Star CIs

l Last Modified Time

l Updated By

l Concatenation of Display Name (comma-separated) of all directly connected Party CIs. For

example," John Doe, UCMDB UI, CMS, HP SW, HP” (divided into two labels, Owners for Person

CIs and Organizations for Organization CIs).

l Concatenation of Display Name (comma-separated) of all directly connected Location CIs.

For example, “Room 301, 3rd floor, M1, Cupertino, California, World, Milky Way, Universe”.

3. Additional Properties

o All attributes complying with the following rule and that were not displayed in any other panel:

!Static && Have value && Visible && !Deprecated (excluding all attributes derived from

Managed Object)

For UCMDB 10.00 CUP 1 and later versions

You can configure attributes of CI Types to be either displayed or not displayed by the Properties

widget, and determine whether an attribute appears in CI Overview mode and in which properties group

it appears in Widget Details mode, as follows:

1. In UCMDB, go to Modeling > CI Type Manager.

2. In the list of CI Types on the left, choose the CI Type with the attribute(s) that you want to

configure.

3. Select the Attributes tab in the editor on the right.

4. In the list of attributes, double-click on the attribute that you want to configure.

The Edit Attribute window appears.

5. In the Edit Attribute window, click the UCMDB Browser Qualifiers tab and do one of the following:
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o To hide an attribute:

Select Hide in Properties Widget.

Note: If you select Hide in Properties Widget, make sure that CMS Browser Visible is not

also selected. Otherwise, notifications may appear for attributes that are not visible.

o To display an attribute:

Select CMS Browser Visible.

6. If you checked CMS Browser Visible in the previous step, set the following properties:

o View in preview mode: From the drop-down list, chose True if you want the attribute to appear

in the CI overview, or False if you do not want it to appear in CI Overview mode.

o Properties group assignment: From the drop-down list, choose the properties group (Core,

Complementary or Additional) in which you want this attribute to appear in Widget Details

mode.

7. Click OK.

CI Overview Mode

A maximum of three properties are displayed for the selected CI, according to the following priorities:

Note: The order in which properties are presented is alphabetic and cannot be configured.

l For Non-Star CIs: The first three properties according to these priorities:

a. Attributes with the CMS Browser Visible qualifier on concrete attributes or attributes that are

inherited from Star CIs

b. Concrete attributes (not inherited)

l For Star CIs:

o Attributes with the CMS Browser Visible qualifier on concrete attributes or attributes that are

inherited from Star CIs.

o Special or calculated attributes
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l For Node Star CI type:

l Discovered Model

l Discovered OS Name

l Display Label from all connected IP Address (comma-separated)

l Memory Size

l For Running Software CI type:

l Discovered Product Name

l Display Label from connected Node

l Application Category

l For CI Collection type: the same attributes as for the Non-Star CI

l For Business Element Related CI type:

l Business Criticality

l Last Modified Time

o Concrete from the actual CI type or inherited from the Star CI.

The order in which properties are presented in CI Overview mode is alphabetic and cannot be

configured.

Widget Details Mode

Properties are displayed in the three panels as follows:

1. Core Properties

o Star CIs

l Node

l CMDB Object ID/Global ID

l Discovered OS Name

l Node Operating System Installation Type
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l Serial Number

l Discovered OS Version

l Discovered Vendor

l Domain Name

l Memory Size attribute from instance

l CPU Type from connected CPU, if empty – Name from connected CPU

l Calculated number of Core Number from all connected CPU CIs

l Calculated total File System Size from all connected File System CIs

l Running Software

l CMDB Object ID/Global ID

l Discovered Product Name

l Version

l Vendor

l Business Element/CI Collection

l CMDB Object ID/Global ID

l Business Criticality (for Business Element)

l Also:

l All attributes with CMS Browser Visible qualifier set to true and the Properties Group data

item set to Core.

o Non-Star CIs

l CMDB Object ID/Global ID

l All attributes with CMS Browser Visible qualifier set to true and Properties Group data item

set to Core.
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2. Complementary Properties

o Star CIs

l Node

l Last Modified Time

l Updated By

l Node Boot Time

l Node Is Virtual

l Running Software

l Application Category

l Application Installed Path

l Application Version Description

l Last Modified Time

l Updated By

l Business Element/CI Collection

l Create Time

l Created By

l Last Modified Time

l Updated By

l Also:

l Concatenation of Display Name (comma-separated) of all directly connected Party CIs.

For example," John Doe, UCMDB UI, CMS, HP SW, HP” (divided into two labels, Owners for

Person CIs and Organizations for Organization CIs).

l Concatenation of Display Name (comma-separated) of all directly connected Location

CIs. For example, “Room 301, 3rd floor, M1, Cupertino, California, World, Milky Way,
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Universe”.

l All attributes with the CMS Browser Visible qualifier set to true and Properties Group

data item set to Complementary.

o Non-Star CIs

l Last Modified Time

l Updated By

l Concatenation of Display Name (comma-separated) of all directly connected Party CIs. For

example," John Doe, UCMDB UI, CMS, HP SW, HP” (divided into two labels, Owners for Person

CIs and Organizations for Organization CIs).

l Concatenation of Display Name (comma-separated) of all directly connected Location CIs.

For example, “Room 301, 3rd floor, M1, Cupertino, California, World, Milky Way, Universe”.

l All attributes with the CMS Browser Visible qualifier set to true and Properties Group data

item set to Complementary.

3. Additional Properties

o All attributes complying with the following rule and that were not displayed in any other panel:

!Static && Have value && Visible && !Deprecated (excluding all attributes derived from

Managed Object)

o All attributes with CMS Browser Visible qualifier set to true and Properties Group data item set

to Additional.

Configure the Properties Widget to Show/Hide Empty
Attributes
The Properties widget has a setting called Show attributes that have no value, which can be set to

True or False. If this setting is True, any empty attribute (that is, an attribute with no value) for the

selected CI is displayed with the value N/A, both in the CI Overview and the Widget Details modes. If this

setting is set to False, any empty attribute for the selected CI is not displayed. The default value of this

setting is False.

To set the Show attributes that have no value setting:
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1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

2. Set the value of Show attributes that have no value to the value that you want, either True or

False.

Assign Color Categories

Note: This feature is supported on UCMDB 10.10 and later versions.

Color categories in the UCMDB Browser help you with the navigation and searching of CIs. You may

assign any of the available colors to any CI:

Gray (if no category is specified)

Blue

Cyan

Green

Orange

Red

Sky Blue

Violet

Yellow

You can view and change the color categories by:

l Clicking the colored icon in the upper right corner of each CI on the search results page (both in grid

view and thumbnails view) and on the Most Visited page.

l Selecting Color Category from the context menu for a selected CI.

To assign a color category, click the color icon in any of these locations, and select the color category

that you want to apply to the CI. Changes are reflected in all places where categories are indicated.

After assigning colors, you can use the color categories to refine your search (for example, "all red

Windows servers" or "all blue business applications located in Seattle".
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Enable color categories

1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

2. Set the value of Enable categories to True.

3. Click Save .

4. Log out from the UCMDB Browser, and then log in again (this loads the new setting).

Manage color categories

1. Click the Settings button and select Manage System Categories.

2. Change the label for one or more of the available colors.

3. Click OK.

Change CI Attributes
In the Properties widget, you can change the selected CI's attributes in the CI details pane. A CI attribute

can be edited if the following conditions are met:

l The attribute is marked with UCMDB_BROWSER_EDITABLE_ATTRIBUTE qualifier. Even if the attribute

does not appear in the CI details, if it is marked with this qualifier it appears when you click Edit. For

instructions on how to mark an attribute with this qualifier, see "Mark an attribute as CMS Browser

editable" on page 99.

l The attribute is not defined as read-only. Any one of the following qualifiers defines an attribute as

read-only:

o STATIC_ATTRIBUTE

o READ_ONLY_ATTRIBUTE

o ID_ATTRIBUTE

o CALCULATED_ATTRIBUTE

Note: CI attributes cannot be changed for federated CIs.
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In addition to the standard CI types that can be defined for a CI in UCMDB, this widget also allows for

editing location and owner attributes of the selected CI. The list of CI locations that you can choose from

is derived from the list of available Locations CIs in UCMDB, and the list of owners that you can choose

from is derived from the list of available Party CIs in UCMDB. The owner attribute can have multiple

instances. To change the location or owner, see "Change CI location and owner" on page 98. To add an

additional owner to a CI, see "Add an additional owner" on page 98.

The following attribute types have unique editing features in the Properties widget:

l Boolean. If an attribute is defined as boolean, a drop-down box appears that allows you to choose

True or False.

l Date. If an attribute is defined as date number, a date picker appears that allows you to pick the

date according to day, month, and year.

l xml. If an attribute is defined as xml, a text editor appears that allows you to enter free text for this

attribute.

l bytes. If an attribute is defined as bytes, a text editor appears that allows you to enter free text for

this attribute. The difference between this attribute type and the xml attribute type is that the

value of this attribute type is archived before it is saved to the database.

l List of Integers. If an attribute is defined with this type, you can add a list of integers to this

attribute. For instructions on how do this, see "Add a list of Integers or Strings to an attribute" on

the next page.

l List of Strings. If an attribute is defined with this type, you can add a list of strings to this attribute.

For instructions on how do this, see "Add a list of Integers or Strings to an attribute" on the next

page.

To define an attribute in UCMDB with one of the types above, follow the instructions in "Create a CI

attribute with a unique type" on page 99.

Caution: If you attempt to save input for string, xml, or byte attributes that is longer than the limit

defined in the UCMDB CI Type Manager, the following error message appears: "The following error

occurred: Reconciliation DataIn general error. The changes were not saved." If this happens, re-enter

the input so that it is within the defined limit.

The following changes can be made:

l "Change a CI attribute" on the next page

l "Change a CI attribute with Enumeration type" on the next page
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l "Add a list of Integers or Strings to an attribute" below

l "Change CI location and owner" on the next page

l "Add an additional owner" on the next page

l "Mark an attribute as CMS Browser editable" on page 99

l "Create a CI attribute with a unique type" on page 99

Note: This feature is only accessible to users with editing permissions on the selected CI.

Change a CI attribute

1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit.

2. Change the value of the CI attribute.

3. Click Save Changes.

Note: For an attribute that appears in CI Overview mode, if you update it in Widget Details mode

the updated value will appear if you return to CI Overview mode.

Change a CI attribute with Enumeration type

1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit.

2. By the location of the enumeration attribute, click the down arrow.

3. From the drop-down list, select the value that you want to assign to this attribute.

4. Click Save Changes.

Add a list of Integers or Strings to an attribute

If an attribute has been defined with the type list of integers or list of strings (as described in "Create

a CI attribute with a unique type" on page 99), you can add a list of integers or strings to the attribute as

follows:
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1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit.

2. Go to an attribute that is defined as list of integer or list of strings, and click the Edit button.

3. In the input field that appears, enter a string or integer.

4. If you want to add an additional string or integer, click the Add button and enter the

additional string or integer in the input field that appears.

5. Continue adding strings or integers in this manner until you have entered the data you want, and

then click Save Changes.

Change CI location and owner

1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit..

2. By the Location or Owner field, click the Edit button. A drop-down list appears.

3. From the drop-down list, select a Location/Owner.

Tip: If you have a long drop-down list, you can filter the list by typing the initial characters of

the Location/Owner name at the top of the drop-down list. For example, if you type the letters

'Per' at the top of the Owner drop-down list, the list is filtered to show only Owner names that

start with 'Per'.

4. Click OK in the drop-down list.

Note: After selecting a Location/Owner and clicking OK, you can remove your selection by

clicking the 'X' button by the Location/Owner field.

5. Click Save Changes.

Add an additional owner

1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit.
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2. To the right of the owner field, click the Add button. An additional owner appears.

3. In the new owner field, assign a value as described above.

4. Click Save Changes.

Mark an attribute as CMS Browser editable

1. In UCMDB, go to Modeling > CI Type Manager and select the Attributes tab.

2. Choose the desired CI Type.

3. Choose the attribute that you want to make "editable" from the displayed list, and click the Edit

button .

4. In the Edit Attribute dialog box that appears, click the Advanced tab, check CMS Browser Editable,

and click OK.

5. Save your changes to the CI type.

Create a CI attribute with a unique type

1. In UCMDB, go to Modeling > CI Type Manager and select the Attributes tab.

2. Choose the desired CI Type.

3. Click the Add button. The Add Attribute dialog box opens.

4. In the Attribute type section, select Primitive, and from the drop-down list select one of the

following:

o list of integers

o list of strings

o boolean

o date number
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o xml

o bytes

5. Save your changes to the CI type.

Change the Source of Thumbnails (for the
Stakeholder Widget)
The default source for pictures of CI owners (both direct and indirect) presented in the Stakeholder

widget is the gravatar.com website. This source location can be changed according to the following

instructions.

1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

2. In the Name column, choose Stakeholder Image URL.

3. In the Value column, enter the URL for the new source location. The URL should have a parameter

(or parameters) in square brackets (as shown in the examples below), which is an attribute name

from the Party CIT, or from the Organization CIT or Person CIT which are children of the Party CIT.

At runtime, the actual value of this attribute is set in the URL in order to receive the image.

Examples:

o To use an image from the gravatar site, enter:

http://www.gravatar.com/avatar/[email]?s=42&d=mm

where [email] is an attribute of the Person CIT and will be replaced by the actual email address

of the Stakeholder at runtime.

o To use an image from Facebook image, enter:

https://graph.facebook.com/[attr_name]/picture

where [attr_name] is an any attribute that contains the Facebook User ID (this attribute should

be added to Party CIT) and will be replaced by the actual Facebook User ID of the Stakeholder at

runtime.

o To use an image from Google, enter:

https://profiles.google.com/s2/photos/profile/[attr_name]?sz=42
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where [attr_name] is an any attribute that contains the Google User ID (this attribute should be

added to Party CIT) and will be replaced by the actual Google User ID of the Stakeholder at

runtime.

Specify Impact Rules
The Impact Simulation and Dependent Services widgets run impact analysis that uses impact rules, in

the same manner as UCMDB. These impact rules can be grouped into bundles. The default setting is to

run the analysis using all available bundles, however you can choose to run the analysis using only

certain bundles and not others.

To select bundles for impact analysis:

1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

2. In the Name column, choose List of impact rules bundles to be used.

3. In the Value column, enter a comma-separated list of bundle names.

Note:

o Incorrect bundle names are ignored.

o A bundle name that contains a comma cannot be used.

4. Click Save .

5. Log out from the UCMDB Browser, and then log in again (this loads the new bundle settings).

Change the History Widget 'From Date'

Note: The History widget is supported on UCMDB 10.01 and later versions.

The History Widget uses a beginning date and end date to show changes in CI data that occurred during

the period defined by those two dates. The default end date is the current date and time and the

default beginning date is the current end date minus the History Widget From Date setting that is set

in UCMDB. The default value for the History Widget From Date setting is 7, but this value can be

changed by the UCMDB Administrator as explained below.
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To change the History Widget 'From Date':

1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

2. In the Name column, choose History Widget From Date.

3. In the Value column, enter the number of days that you want for the From Date.

4. Click Save .

5. Log out from the UCMDB Browser, and then log in again (this loads the new setting).

Reports

Note: Reports are supported on UCMDB 10.01 and later versions.

The Reports module in the UCMDB Browser provides a method of displaying the data from views in a

report format. The Reports module is divided into two sections:

1. Reports Dashboard

The Reports Dashboard is divided into two sections:

o Basic Reports

Basic reports list the CIs for a main and related CI type that you select. Each thumbnail includes:

l The Report's name

l The Report's icon

l The Report's description

l The Report's labels

Hovering your mouse over a Basic report allows you to access the following:

l Execute Report

l Delete Report
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l Edit Description

l Labels

You can create Basic reports in the UCMDB Browser.

Note: You must be assigned the permission to create views and queries in UCMDB in order

to create basic reports in the UCMDB Browser.

o Topology Reports

This section displays the 20 most visited topology reports. Each thumbnail includes:

l The Report's name

l The Report's icon

l The Report's description

l The Report's labels

Hovering your mouse over a Topology report allows you to access the following:

l Execute Report

l Labels

Every view defined in the Modeling Studio in UCMDB has a corresponding topology report.

UCMDB Browser reports are based on one of the following:

l Pattern views - A pattern view is based on a particular TQL query that defines the structure

of the view. When the view is displayed or refreshed, the Modeling Studio queries the CMDB

for all elements that fit the query, and automatically updates the view with those elements.

l Templates - A template is a view that is based on a reusable pattern view (template) and

has defined parameters which are saved as part of the template. The view displays only

those CIs and relationships that satisfy the query definition and the conditions of the

template. You cannot schedule this type of report or change its parameters in the UCMDB

Browser.
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The report settings are defined in the view definition in Report mode in the Pattern View Editor.

For details, see "Pattern View Editor" in the HP Universal CMDB Modeling Guide. You cannot

create Topology reports in the UCMDB Browser.

2. Reports Right Panel

The right panel allows you access to the following features:

o Search Reports field

Note: In the Reports module, the search field acts as a filter for the reports.

o CATEGORIES- LABELS switch

Use the Labels view

In the Labels view of the Reports module, you can quickly locate a group of reports that have

certain labels. UCMDB administrators can manage the labels and assign labels to reports.

To switch to the Labels view, click the CATEGORIES-LABELS switch at the top-right corner in the

Reports tab. The right pane then lists all the labels.

The Labels view works in the following manner:

l If you do not select any label, the left pane displays all the reports.

l If you select one or multiple labels, the left pane only displays the reports that have one of

the selected labels.

When a label is assigned to a report, the report icon shows the label name at the bottom. When

a report has multiple labels and the icon cannot contain all the label names, a icon

appears. You can click this icon to view all the labels assigned to the report.

Use labels to group reports

Administrators can use labels to group related reports.

Create a label:
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i. In the Reports tab, switch from the Categories view to the Label view.

ii. Click Create New Label.

iii. Enter the label name, and then click Create New Label +.

Rename or delete a label:

i. In the Reports tab, switch from the Categories view to the Label view.

ii. Click Manage Label. The Manage Label dialog box appears.

iii. Perform the following actions to rename or delete a label:

l To rename a label, click Rename, enter the new label name, and then click Save

Changes.

l To delete a label, click Delete.

iv. Click OK.

Assign labels to a report:

i. In the Reports tab, point to the report that you want to label.

ii. Point to Labels in the context menu, and then click one or multiple labels in the label list

that appears.

iii. Move the mouse out of the context menu.

Note: You can assign labels to a topology report only when the topology report appears

under the Topology Reports section.

Remove labels from a report:

i. In the Reports tab, point to the report.

ii. Point to Labels in the context menu, and then clear the checkboxes before the assigned

labels.

iii. Move the mouse out of the context menu.

o Expand button
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o Collapse button

o Refresh Reports button

o View Scheduled Reports button

Create a basic report

1. In the Reports tab, click the node that displays . The Basic Report Wizard opens.

2. Enter a name (and optional description) for the report, and click Next.

Note: The description will appear in the report icon and at the top of the generated report.

You can edit the description after you create the report. To do this, point to the report, and

then click Edit Description from the context menu.

3. Select the main CI type that you want to appear in the report, and then click Next.

To quickly locate a CI type, you can filter the list of CITs by entering a text string, or click one of the

favorite CI types above the list.

4. (Optional) Select an attribute condition for the main CIT (including an operator and value) that you

want to appear in the report. To add additional attributes, click [+] Add attributes. Click Next to

select a related CI type.

Note: When you select the first attribute condition for the main CI Type, if the attribute

selected is Display Label and the operator is Like case insensitive, after you save the report,

these selections will be removed from the attribute conditions list and the value you added

will be displayed in the Name field.

5. (Optional) Select a related CI type, and then click Next.

To quickly locate a CI type, you can filter the list of CITs by entering a text string, or click one of the

favorite CI types above the list.
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You can only include one related CI type in a report. If you click more than one related CI type, the

last item you clicked is the one that will be included in the report. To clear this field completely,

click Deselect.

6. (Optional) Select attributes for the related CI type (including an operator and value) that you want

to appear in the report. To add additional attributes, click [+] Add attributes.

7. When you are finished, click Save.

Create a report from search

1. On the main search page, click Advanced Search.

2. Select the main CI type that you want to appear in the report, and then click Next.

To quickly locate a CI type, you can filter the list of CITs by entering a text string, or click one of the

favorite CI types above the list.

3. (Optional) Select an attribute condition for the main CIT (including an operator and value) that you

want to appear in the report. To add additional attributes, click [+] Add attributes. Click Next to

select a related CI type.

4. (Optional) Select a related CI type, and then click Next.

To quickly locate a CI type, you can filter the list of CITs by entering a text string, or click one of the

favorite CI types above the list.

You can only include one related CI type in a report. If you click more than one related CI type, the

last item you clicked is the one that will be included in the report. To clear this field completely,

click Deselect.

5. (Optional) Select attributes for the related CI type (including an operator and value) that you want

to appear in the report. To add additional attributes, click [+] Add attributes.

6. Click Search.

7. In the left pane, click Select Attributes for Report . The Select Attributes for Report dialog box

appears.

8. (Optional) select the specific attributes that you want to be included in the report.
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9. Click Apply and go to Reports.

10. (Optional) Perform the following steps if you want to save the report for later use:

a. Click Save Report .

b. Enter a report name and optional description, and then click Save.

The report is added to the basic reports.

Open a report

Note: To open a report, you can either select the report, or click the Execute Report option that

appears when you hover the mouse over the report.

1. In the Reports tab, select the basic report to open.

2. Click Execute Report

The following actions are available in an opened report:

l Delete Report

Note: Delete Report action is available only for the basic reports.

l Save Report

l Select Attributes for Report

l Schedule Report

l Exports Results

l URL to Report

The following features help you quickly locate an item in the opened report:
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l Expand All: Click this button to expand all Related CIs.

l Collapse All: Click this button to collapse all Related CIs.

l Search Results: Type the keyword in this field and then press Enter to search within the generated

report.

Note: The search is performed only on the Display Label field.

You can change the order of the columns in a report by dragging them to the desired position.

Generate a report

Note: You can generate only the template-based topology reports.

1. In the Reports tab, select the template-based topology report that you want to generate.

2. Click Generate Report .

The content of the report is generated according to the template that is specified in UCMDB. You

can specify parameters for the included CIs that will be included in the generated report. To return

to the default parameters, click Reset parameters to default .

The following actions are available in a generated report:

l Generate Report

l Reset parameters to default

l Save Report

l Select Attributes for Report

l Schedule Report

l Exports Results

l URL to Report

The following features help you quickly locate an item in the generated report:

UCMDB Browser Installation and Configuration Guide

Chapter 3: Search and Functionality

HP Universal CMDB Browser (4.04) Page 109 of 203



l Expand All: Click this button to expand all Related CIs.

l Collapse All: Click this button to collapse all Related CIs.

l Search Results: Type the keyword in this field and then press Enter to search within the generated

report.

Note: The search is performed only on the Display Label field.

Edit a report

1. In the Reports tab, select the basic report that you want to edit.

2. Do one or more of the following:

o To change the main or related CI type, click the name of the existing CI type.

o To change attributes, click Edit attribute conditions next to the main or related CI type.

3. When you are finished, click Save .

Delete a report

1. In the Reports tab, select the basic report that you want to delete.

2. Click Delete Report . A confirmation message appears.

3. Click OK to delete the report.

Note: To delete a report, you can also hove the mouse over the report and click the Delete

Report option.
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Select content to be displayed in a report

1. In the Reports tab, select the report (basic or topology) that you want to configure.

2. (Optional) Select Attributes for Report to select the specific attributes that you want to be

included in the report.

For basic reports, you select attributes from the Main CI Type or Related CI Type tabs.

For topology reports, you select attributes from tabs that represent the nodes in the selected

view.

o To include all attributes in the report, click .

o To include a specific attribute in the report, select it in the left pane and click .

o To remove a specific attribute from the report, select it in the right pane and click .

o To remove all attributes from the report, click .

3. In the Attribute Order tab, select an attribute and use the up or down arrows to change the display

order in the report.

4. When you are finished, click OK.

Schedule a report

1. In the Reports tab, select the basic report or pattern view-based topology report that you want to

schedule.

2. Click Schedule Report .
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3. Enter the following information:

Field Description

Recipients Enter the email addresses to which the report should be sent. If there is more than
one recipient, separate the entries with semicolons.

Email
subject

Enter the subject line of the email.

Email
content

Enter the text that will appear in the body of the email.

Select
report
formats

Select one or more of the formats (XML, XLS, PDF, or CSV) of the attachments that
will be included when the report is sent. By default, all formats are included.

Repeat Select the frequency at which the report will be generated:

o Once. The report will be sent at once, with no delay.

o Interval. The report will be sent at a specific interval. You must specify the
interval in minutes (0-59 minutes).

o Hourly. The report will be sent once per hour. You must select the minute (0-59
minutes).

o Daily. The report will be sent once per day. You must select the hour (0-23
hours) and minute (0-59 minutes).

o Weekly. The report will be sent once per week. You must select the hour (0-23
hours), minute (0-59 minutes), and day of the week.

o Monthly. The report will be sent once per month. You must select the day (1-31),
hour (0-23), and minutes (0-59 minutes).

Note: If you select 31 as the day for the report to be sent, it will be sent only
in months that contain 31 days (that is, only 7 times per year). To schedule
reports to be sent on the last day of the month, use the Cron scheduling
option.

o Cron. You can use a Cron expression to schedule a job. For more information, see
"Cron Expressions" in the HP Universal CMDB Data Flow Management Guide, or
http://quartz-scheduler.org/documentation/quartz-2.x/tutorials/crontrigger.

Exclude
weekends

Select this checkbox to prevent the report from being sent on weekends.
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Field Description

To specify the days of the week that are weekend days, in UCMDB, go to
Administration > Infrastructure Settings Manager > UCMDB Browser Settings
and set the Days of the weekend setting.

4. When you are finished, click OK.

View all scheduled reports

1. In the Reports tab, do one of the following:

o Click View Scheduled Reports to see all scheduled reports.

o Select a report and click Schedule Report . Then click View Scheduled Reports to see the

reports that are scheduled for the selected report.

2. Select one of the following:

o Mine. Displays all scheduled reports for the currently logged-in user.

o All. Displays all scheduled reports, grouped by user.

Export a report

1. Select the report (basic or topology) that you want to generate.

2. Click Export results .

3. Select the desired export format (XLS, CSV, PDF, or XML). The report is exported in the selected

format.

4. Click Open, Save, or Cancel.
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Link to a report

1. Select the report (basic or topology) to which you want to link.

2. Click URL to Report .

3. Select one of the following:

o Copy URL. Opens the URL to Report dialog box. Select the URL and click Control+C to copy the

link to the clipboard.

To send reports from other HP applications, use the following URL formats:

l For pattern-based reports:

<domain>/ucmdb_browser.jsp#report=<ReportName>;tab=reports

l For template-based reports:

<domain>/ucmdb_

browser.jsp#report=<

ReportName

>&<param1>=<value1>&<param2>=<value2>&<paramn>=<valuen>;tab=reports

Note: The ‘tab=reports’ section may appear either before or after can be before or after

report.

o Email link. Opens an email that contains a link to the report.

Discovery Indicators

Note: This feature is supported on UCMDB 10.21 CUP1 and later versions.

Starting from UCMDB Browser version 4.03, you can see different types of discovery indicators in the

Search, Advanced Search and Reports modules in the UCMDB Browser.

These indicators allow you to see a warning or an error flag on a discovered CI, if any of the discovery

jobs have completed with warnings or errors.
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To use this feature, you need to have the Run Discovery and Integration or View Discovery Status and

Error permission.

By default, the Discovery indicators are disabled. To enable the Discovery indicators, go to UCMDB

Browser > Settings > Manage Discovery Status > select the Display Discovered CIs Status checkbox,

and then click OK .

There are three types of discovery indicators:

1. A warning indicator shows on the CI in the UCMDB Browser when there is at least one discovery

job completed with warnings and there is no discovery job completed with errors.

2. An error indicator shows on the CI in the UCMDB Browser when there is at least one discovery

job completed with errors.

3. A success indicator shows on the CI in the UCMDB Browser when all the discovery jobs

completed successfully.

If a CI is not discovered (updated) by any of the discovery jobs, then no indicator will show on that CI.

Note: In the UCMDB Browser, discovery indicators:

l Apply to discovery jobs only, including regular discovery jobs, management zone jobs, and

Automated Service Modeling (ASM) jobs. Integration jobs are not supported in this release.

l Do not show on a discovered CI when there is no relation between the CI and the job.

Service Modeling

Note: Service Modeling is supported on UCMDB 10.20 and later versions.

Service Modeling enables you to model the infrastructure of a business service. A service can be

regarded as a perspective-based view on a particular CI. When the discovery process runs, relationships

between a CI and its owner and a CI and its stakeholders are found, triggering additional rounds (also

referred to as "hops") of discovery for those related CIs.

Note: The link for a consumer-provider relationship between CIs is indicated with a blue line;

otherwise the link is indicated with a black line. Also, all the incoming and outgoing links for a

selected CI are represented with bolded lines.
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You can model services, as well as run discovery and troubleshoot the discovery process. New service

models are based on CI types that have the SERVICE_MODEL qualifier in UCMDB. After running discovery,

you are able to view the discovered CIs in the context of that business service.

When you create a new service model in the UCMDB Browser, a discovery activity and a perspective-

based view with the same name are created in UCMDB, based on the Service_template perspective. In

addition, when you create a template-based model, the view also contains the specific perspective that

you select when you create the model.

You can also access the Assisted Modeling feature in the UCMDB Browser through the Service Modeling

module. For more information, see "Assisted Modeling" on page 136.

Note:

l To enable a user to access the Service Modeling module in the UCMDB Browser, in the Roles

Manager in UCMDB, click the General Actions tab and add the Service Modeling permission (in

the Data Flow Management Actions group) to the selected role.

l To enable a user to create service models, assign Create permission for at least one CI type

that has the SERVICE_MODEL qualifier assigned to it.

l Users who have only View permission for a CI (and not Edit permission) will view the topology

map in read-only mode.

l To enable access for a user to access a particular view, in the Roles Manager in UCMDB, click the

Browser CI Access Control tab and assign View permission to that view.

l To enable a user to run discovery in the Service Modeling module starting from a URL, in the

Roles Manager in UCMDB, click the General Actions tab and add the Run Discovery and

Integrations permission (in the Data Flow Management Actions group) to the selected role.

For more information about models, see the HP Universal CMDB Modeling Guide.

The Service Modeling module is divided into two sections:

1. Service Modeling Dashboard

The Service Modeling dashboard displays existing service models. The last service model displayed

automatically opens when you open the Service Modeling module.
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The Service Modeling Dashboard displays a thumbnail for each service model, grouped by the state

at which the model was deployed. You can hide the service models from a specific group simply by

clicking the group's name. Each thumbnail includes:

o The name of the service model.

o The CI type on which the service model is based.

o The owner, if one exists for the service. If no owner exists, you can select one on the map by

clicking .

o An icon showing the business criticality, indicating the relative importance of the service to the

business.

2. Service Modeling Left Panel

In the left panel you can do one of the following:

o Create a service model.

o Start assisted modeling. For more information, see "Assisted Modeling" on page 136.

o Search for a service model by name.

o Filter the discovered models by owner.

o Expand or collapse the service models in the dashboard according to their state at which the

model was deployed.

Model a business service starting from a specific entry

point

1. In the Service Modeling tab, click .

2. From the Choose Application Type drop-down list, select URL Entry Point.

3. In the URL field, enter the address that is the starting point for the discovery activity.
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4. Click Check URL Availability to verify that the address is available.

5. To further refine the model that will be created, you can click More Properties (optional) and

define the following:

Field Description

Name Enter a name for the service model.

For template-based models, a predefined name is assigned, consisting of the
name of the CI on which the model is based and the type of the service.

Owner Select an owner from the drop-down list. This list includes all CIs connected to
the business service CI type with an Ownership relationship.

Stakeholders Select a stakeholder from the drop-down list. This list includes all CIs connected
to the business service CI type with a Usage relationship.

Business
Criticality

Select the desired business criticality from the drop-down list. This attribute of
the CI type indicates the relative importance of the service to the business. For
more information, see "CI Type Manager Page" in the HP Universal CMDB
Modeling Guide.

Type Select a CI type from the drop-down list. By default, the BusinessApplication type
is selected. This CI type represents the service on which the Service Model is
based. Only CI types that have the SERVICE_MODEL qualifier assigned in the CI
Type Manager in UCMDB appear in this drop-down list and can be used to model
services.

Description Enter an optional description for the model.

Category Select a category for the model. Possible categories might be Draft, Test,
Development, or Production.

6. When you are finished, click . This runs the service discovery

activity in UCMDB (which is automatically created when you model a service) to discover the actual

CIs that comprise the business service.
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Identify and model applications from existing data

1. In the Service Modeling tab, click .

2. From the Choose Application Type drop-down list, select one of the available templates.

Note: To add a perspective-based view to this list of templates, add it to the UCMDB_Browser_

Service_Modeling bundle as part of the TQL query definition in UCMDB.

3. Select one or more of the displayed CIs. You can filter the list of displayed CIs by typing a string in

the Quick Search field.

The CIs that are displayed in the list are the results of running a perspective-based view in UCMDB,

but only the CIs that were returned by the contact node of the view. For example, if a view contains

a Node (the contact node) connected to an IP address, only Node instances that are connected to IP

addresses will appear in the list, and not all Nodes.

4. When you are finished, click . The Template Modeling pane opens,

which allows you to define properties for each of the models you are creating. You can change the

following properties:

Field Description

Name Enter a name for the service model.

For template-based models, a predefined name is assigned, consisting of the
name of the CI on which the model is based and the type of the service.

Owner Select an owner from the drop-down list. This list includes all CIs connected to
the business service CI type with an Ownership relationship.

Stakeholders Select a stakeholder from the drop-down list. This list includes all CIs connected
to the business service CI type with a Usage relationship.

Business
Criticality

Select the desired business criticality from the drop-down list. This attribute of
the CI type indicates the relative importance of the service to the business. For
more information, see "CI Type Manager Page" in the HP Universal CMDB
Modeling Guide.
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Field Description

Type Select a CI type from the drop-down list. By default, the BusinessApplication type
is selected. This CI type represents the service on which the Service Model is
based. Only CI types that have the SERVICE_MODEL qualifier assigned in the CI
Type Manager in UCMDB appear in this drop-down list and can be used to model
services.

Description Enter an optional description for the model.

Category Select a category for the model. Possible categories might be Draft, Test,
Development, or Production.

Note: Click Apply same to all models to apply each setting to all of the models you are

working on.

5. Click . A new CI of type BusinessApplication is created, and

is connected in UCMDB to the CI on which the model is based.

6. If desired, you can change how information is displayed on the topology map. For more

information, see:

o "Show additional Information on a topology map" on page 122

o "Add layers to an existing model" on page 124

o "Simulate the impact of a service's failure" on page 125

o "Simulate the impact of a CI's failure" on page 126

Edit a service model

1. In the Service Modeling dashboard, open an existing service model.

2. Click . The Service Properties widget opens.

3. Click EDIT MODE.

4. Change one or more of the following properties:
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a. Business Criticality

b. Owner

c. Location

d. Deploy Type

e. Description

f. Stakeholders

g. Name

Note: In the Name field, type in a new name for the service model. Renaming a model

changes the name of:

l The CI that was created when the model was created.

l The view in UCMDB with the same name.

l The associated discovery activity.

5. Click .

Delete a service model

1. In the Service Modeling dashboard, click an existing service model.

2. Click .

Deleting a model deletes:

o The CI that was created when the model was created.

o The view in UCMDB with the same name.

o The associated discovery activity.

3. Click OK to confirm the deletion.
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View a service model in text navigation mode

1. In the Service Model dashboard, click an existing service model.

2. Click .

The right pane opens and lists all the CIs contained in the selected model.

The following features help you quickly locate a CI in the model:

o Search for a CI: Type the keyword in this field to search within the model

o Collapse All: Click this button to collapse all folded CIs and to see only the first level CIs

Show additional Information on a topology map

1. In the Service Modeling dashboard, click an existing service model.

2. Click and then click Show Additional Info.

3. Select one or more of the following checkboxes to see the specific information indicators:

History
Changes

Displays changes on CIs that are in the model during the specified time period.

To display history changes:

a. Select History Changes. The number of history changes according to the
current settings is displayed.

b. Click Change Settings to select the beginning and ending dates for the
changes.

c. Click to update the topology map.

Monitoring Displays the number of KPIs on the CIs in the model.

Note: This option is displayed only when you are using the Monitoring
widget. Setup for the Monitoring widget is described in "Configure the BSM
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Health Indicator (for the Monitoring Widget)" on page 185.

Policy Status Displays the number of policy results on CIs in the model.

Note:

o This option is displayed only when there is a live Configuration Manager
(CM) system deployed in the UCMDB environment.

o Policy indicators are counted for both the indicated CI and the service in
which that CI is located.

Incidents Displays incidents on CIs that are in the model during the specified time period.

To display incidents:

a. Select Incidents. The number of incidents according to the current settings
is displayed.

b. Click Change Settings to select the beginning and ending dates for the
changes.

c. Click to update the topology map.

Request for
Changes

Displays change requests on CIs that are in the model during the specified time
period.

To display change requests:

a. Select Request for Changes. The current number of change requests is
displayed.

b. Click Change Settings to select the time span for change requests.

c. Click to update the topology map.

Problems Displays the number of problems on CIs in the model.

Owner Displays the CI's owner.

Infrastructure
Info

Displays the composite data.

Discovery Displays the discovery progress indicators.
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Note: Your selections are saved for all the service models in your user preferences.

Add layers to an existing model

Four out-of-the-box layers (perspectives) are provided:

l Storage: Represents the generic relation of storage-related data, starting from Running Software

via Node to exported storage pieces.

l Networking: Represents Node-related network topology. Depicts Node to Switch connectivity with all

interfaces, ports and vlans relations.

l Virtualization: An overall virtualization representation of Node virtual dependency with Running

Software in it.

l Clusters: Represent

The following layers are available if ASM Enhanced Package or Content Pack 17 (or a later version) is

deployed:

l Related Node: Select this layer to display the related nodes of all running softwares.

Usually, the Related Node layer shows the Operating System of the computer on which the software

is running.

l Service Connection Point: Select this layer to display the Service Connection Point (SCP) CIs.

A SCP is created during service modeling when the discovery job finds the next hop. The SCP CI

contains the information for the next hop. For example, IP address, port number, and reference

information (such as context root, DB name). The SCP CI triggers the discovery job for the next hop.

l Load Balancers: When you select this layer, the topology map displays load balancers.

You can add layers to the topology map in the following way:

1. In the Service Model dashboard, click an existing service model.

2. Click and then click Add Layers.
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3. Click to execute the selected perspectives and to add new

content to the current map.

4. Do one of the following:

o Click Close and Save Selected Layers to save the selected layers, so that the next time you

open this service model, the perspective and content that you added will be visible in the

topology map.

o Click Close without Saving Selected to discard the selected layers and to close the Add Layers

menu. Selected layers are not saved, but added content remains in the topology map for the

duration of the current session.

Simulate the impact of a service's failure

Dependent Services presents services (CIs of types that have the SERVICE_MODEL qualifier) that will

impact the business service at a specified severity level, if they fail.

1. In the Service Modeling dashboard, click an existing service model.

2. Click and then click Dependent Services.

3. Select a CI in the map.

4. Specify the level of failure that you want to simulate.

5. Click . The CIs that are most likely to impact your service if

they fail will be displayed.

For more information, see "Dependent Services Widget" on page 170.
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Simulate the impact of a CI's failure

1. In the Service Model dashboard, click an existing service model.

2. Click and then click Impact Simulation.

3. Select a CI in the map.

4. Specify the level of failure that you want to simulate.

5. Click . The impact of the failure of the selected CI will be

displayed in the model.

For more information, see "Impact Simulation Widget" on page 158.

Run discovery manually for a service model

By default, service discovery jobs run automatically once each day. Use this procedure to run a discovery

job manually.

1. In the Service Modeling dashboard, click an existing service model.

2. Click .

3. You can do the following before running the discovery process:

o Click Entry point to add or change the URL that is the starting point of the service.

o Click URL Online or URL Offline to check the current status of the entry point URL.

4. Click . Indicators for the discovery progress of each CI are

displayed on the topology map .
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While the discovery process is running, the status Running Discovery is displayed and the number

of discovery issues found is updating. You can click Stop to deactivate the currently running

process, or click to restart the process.

After the discovery process completes, you will either see a message that the discovery has

finished successfully, or that the discovery process finished with errors. Click Discovery Issues to

open the Discovery Issues pane, which lists errors grouped by discovery issues type. The following

discovery issues types may occur during discovery:

o Internal Errors

o Connection Errors

o Credential-Related Errors

o Timeout Errors

o Unexpected/Invalid Behaviors

o Information Retrieval Errors

o Resources-Related Errors

o Parsing Errors

o Encoding Errors

o SQL Related Errors

o HTTP Related Errors

o Specific Application Errors

o Probe Errors

o Software Related Errors

o Others

When you click a discovery issues type a pane opens and lists all the errors within the selected

category.
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To see in the Discovery Issues pane only the relevant discovery issues for a specific CI and for its

trigger CIs, simply click the CI's Discovery indicator.

Note: To see the discovery indicators in the Service Modeling module you need to install CP17.

For probe errors, you can see a pause indicator and meaningful error messages in the following

situations:

o When the discovery job cannot run because the probe is suspended or disconnected, or there is

no setup for the probe.

o When the discovery job cannot run because the probe or the activity is in a blackout period.

o When the discovery job cannot run because the IP is out of the all probe's IP ranges.

Note: These error messages are supported on UCMDB 10.22 and later.

For Software Related Errors, you can see the ignored TCP connections of a running software and

you can add the missing ports in the portNumberToPortName.xml file:

a. In the Discovery Issues pane, click the Software Related Errors category, and then select an

error with the following Problem Source message: "Some outgoing ports are filtered".

b. Click the Application Signature button.

c. Enter an Application Name.

d. Select all the ports you want to be added in the portNumberToPortName.xml file.

e. Click Save Mapping.
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Note:

l You can see the newly added ports in the UCMDB UI > Data Flow Management >

Adapter Management > portNumberToPortName.xml file.

l You can also click the link while viewing the error to send a

message to an administrator for assistance.

f. After you have added the missing ports, click to rerun

discovery.

Note: This feature is supported on UCMDB 10.22 with CP18 and later.

For credential-related errors, you can enter new credentials for the selected protocol, and you can

save multiple protocols. When specifying credentials, you can specify the network scope for those

credentials:

o IPv4 (either as IP range or as Classless Inter-Domain Routing (CIDR)

o IPv6

Note: The newly entered credentials will take affect only after the discovery process has been

restarted.

For all other types of errors, you can click the link while viewing the error to

send a message to an administrator for assistance.

Note: In some cases, if the message is too long, there might be an HTML limitation or an Email

client limitation, and the message will not be displayed entirely in the email.

5. After you enter new credentials, click to rerun discovery.
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Map Toolbar

The following actions are available in the map toolbar (from left to right):

l Change the view to Full Screen

l Open the Quick Navigation Map

l Fit to screen

l Change the map topology view to 1:1 scale

l Zoom out the map topology

l Zoom in the map topology

l Change Layout. You can use one of the following layers: hierarchic: vertical, hierarchic: horizontal,

organic, circular, and directed orthogonal.

View a service's details

Note: Only the widgets that you have permission to view will be displayed.

[LC Req. 29062]

1. In the Service Modeling dashboard, open an existing service model.

2. Hover your mouse over a CI in the model and click the button. Select one of the following:

Overview Displays CI Overview mode for all of the widgets that contains information about
the service model.

Service
Properties

Displays the Service Properties widget, only for the Service CI.

This option is present only if a Service CI is selected.The information displayed
here is similar to the Properties widget. For more information, see "Properties
Widget" on page 149.
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Note: In the Service Properties widget, you can change the name of an
existing service model. For more information, see "Edit a service model" on
page 120.

Properties Displays the Properties widget for the selected CI. For more information, see
"Properties Widget" on page 149.

History Displays the History widget. For more information, see "History Widget" on page
153.

Policy Displays the Policy widget. For more information, see "Policy Widget" on page
159.

Change
Requests

Displays the Change Request widget. For more information, see "Change
Requests Widget" on page 160.

Incidents Displays the Incidents widget. For more information, see "Incidents Widget" on
page 162.

Problems Displays the Problems widget. For more information, see "Problems Widget" on
page 165.

Stakeholder Displays the Stakeholder widget. For more information, see "Stakeholder Widget"
on page 168.

Business
Topology

Displays the Business Topology widget. For more information, see "Business
Topology Widget" on page 175.

Storage
Data

Displays the Storage Data widget. For more information, see "Storage Data
Widget" on page 177.

Environment Displays the Environment widget For more information, see "Environment
Widget" on page 151.

Impact
Simulation

Displays the Impact Simulation widget. For more information, see "Impact
Simulation Widget" on page 158.

Defects Displays the Defects widget. For more information, see "Defects Widget" on page
172.

Dependent
Services

Displays the Dependent Services widget. For more information, see "Dependent
Services Widget" on page 170.

Monitoring Displays the Monitoring widget. For more information, see "Monitoring Widget"
on page 167.

Dynamic (by
name)

Displays dynamic widgets that contain the selected CI. For more information, see
"Dynamic Widgets" on page 178.

Security Displays the Security widget. For more information, see "Security Widget" on
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page 171.

Discovery
Progress

Displays the Discovery Progress widget. For more information, see "Discovery
Progress Widget" on page 181.

Set border rules on a link

By default, consumer-provider relationships between CIs are internal, meaning that they are contained

within a service model. Use the service border rules functionality to define which relationships are

actually external to your service trees.

1. In the Service Model dashboard, click an existing service model.

2. Hover your mouse over a CI in the map and select Border rules on link from the context menu

.

3. Select a link from the displayed list.

4. Click . The following settings

for the border rule are displayed:

Field Description

Name* Enter a name for the border rule. (Mandatory)

References Describes one or more conditions on the References attribute of the selected
consumer-provider link.

You can enter comma-separated values.

Consumer In this section, you define specify a CI type and attribute conditions for End 1 of
the consumer-provider link.

Attributes that have already been defined on the model automatically populate
the corresponding fields here.

Note: Only attributes of type string or enum appear in the list.

Provider In this section, you specify a CI type for End 2 of the consumer-provider link.
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Note: Carefully verify that the attributes you set actually contain values that you specify for

border rules. Otherwise, you will not be able to access the border rule in the UCMDB Browser.

You will be able to access the border rules in UCMDB in Data Flow Management > Adapter

Management > <<No Package>> resource > Configuration Files.

5. When you are finished, click .

When a link is affected by a border rule during a discovery run, the Data Flow Probe updates the

following attributes on the consumer-provider dependency link:

l Is External is updated from False to True.

l Service Border Rules is updated to include the names of the border rules that affect the link.

Note:

l When you add a border rule, the link does not immediately change to External (indicated with a

dotted line for the link). Adding a border rule updates a configuration file on the Data Flow

Probe. After the discovery process runs, the relationship in the topology map will be marked as

External, providing that the relationship matched the conditions on at least one service border

rule.

l When a virtual link is marked as External, and that link contains multiple links, if at least one

contained link is external, this link will show up as External.

Group the CIs in a service model by CITs

1. In the Service Modeling dashboard, click an existing service model.

2. Click at the bottom of the window, and then click the CI Type toggle button.
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The topology map will now display the grouped CIs.

You can expand the grouped CIs, simply by clicking the displayed number.

Arrange the CIs in a service model by layers

1. In the Service Modeling dashboard, click an existing service model.

2. Click at the bottom of the window.

3. Under Change Layout, select Layers.

When you hover the mouse over a layer, the layer's label is displayed and the layer is emphasized.

Note:
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To group the CIs by CITs and also arrange them by layers, under Change Layout, select Layers, and

under Change Grouping, select CI Type.

The topology map will now display the CIs grouped by CITs and arranged by layers.

Access a Service Model Using a Direct Link

As a user, you can access a service model using a direct link

The direct link to a Service Model is functioning exactly like the one for Reports. When a Service is

opened from the dashboard, the view=service_name item is added to the Internet browser URL. When

you switch back to the dashboard, this item is dropped. The link that is created when you select a

service can be used as a direct link. That is to say, when another user uses it (or the same user, in a

different internet browser), it leads the user directly to the selected service, without having to select

the Service Modeling tab in the header and then select the service from the service dashboard.

UCMDB Browser Installation and Configuration Guide

Chapter 3: Search and Functionality

HP Universal CMDB Browser (4.04) Page 135 of 203



Assisted Modeling

Note: Assisted Modeling is supported on UCMDB 10.01 and later versions only with the Enhanced

Search Engine enabled (the value of the cmdb.search.enabled JMX setting is true).

Assisted modeling in the UCMDB Browser provides a more accessible interface for CI modeling than is

available in UCMDB. Assisted modeling is designed for end-users who do not need the full modeling

capabilities that the UCMDB provides for administrators. The UCMDB Browser provides a very intuitive

and straightforward user interface for creating CIs and relationships between CIs.

Assisted modeling is performed according to modeling templates. Best practice modeling templates are

provided out-of-the-box. The best practices templates can be used out-of-the-box ‘as is’, or the UCMDB

administrator can edit them according to your organization's needs. New modeling templates can also

be created by the UCMDB administrator. For instructions on creating templates, see "Create Modeling

Templates" on page 141.

To change the order in which modeling layers are displayed, see "Change the Modeling Layering Order"

on page 142.

Note: To use assisted modeling, users must have data-update permissions assigned in the Roles

Manager in UCMDB, and View access to at least one of the modeling templates.

Get Started with Assisted Modeling

How you access Assisted Modeling depends on which version of UCMDB you are using:

l For UCMDB 10.20 and later versions, you can access Assisted Modeling in two ways, through the

Service Modeling module:

o Click Start Assisted Modeling.

or

o Hover your mouse over a CI in a service model map and select Assisted Modeling from the

context menu .

l For UCMDB 10.01 or 10.11 versions, click the Assisted Modeling tab.
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When the modeling is completed, click .

The modeling topology map is displayed with the selected CI automatically loaded in the model. To see

the related CIs, see "View a List of All CIs that are Related to the Selected CI" on the next page.

Note:

l The templates displayed in the drop-down list are according to the user’s permissions on the

query resource and also according to the selected CI type.

l The selected template can be changed after you have started to make modeling changes.

However, if you change the template all modeling changes made with the previous template are

not saved.

Modeling Actions

You can perform the following modeling actions:

l "Edit the Properties for the Selected CI" on the next page

l "Remove the Selected CI from the Model" on the next page

l "View a List of All CIs that are Related to the Selected CI" on the next page

l "Add an Existing CI to the Model" on page 139

l "Create a New CI and Add It to the Model" on page 139

l "Create and Remove Relationships between the Selected CI and Other CIs in the Model" on page 140

l "Save Changes to the Model" on page 141

l "Create Modeling Templates" on page 141

l "Change the Modeling Layering Order" on page 142

l Navigate the Modeling Topology Map Using a Quick Navigation Map

l Access a Service Model Using a Direct Link
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Edit the Properties for the Selected CI

1. Ensure that a CI is selected in the map.

2. In the right pane, click Edit CI.

Note:

o Similar to the Properties widget in the UCMDB Browser, the CI properties are displayed in

the right pane. In the Assisted Modeling window, mandatory properties are marked with an

‘*’. All of the mandatory fields must have a value to save changes you make to any of the CI

properties.

o For a property to be edited, it must be defined as CMS Browser Editable in UCMDB, in the

same manner as the Properties widget.

o If an attribute of a CI type has the Hide in Modeling qualifier selected, it is not displayed

when editing the CI.

3. Edit the property values.

4. Click Apply at the bottom of the pane.

Remove the Selected CI from the Model

1. Ensure that the CI you want to remove is selected in the map.

2. In the right pane, click Remove from Model.

The CI is removed from the model.

Note:

l If you create a model based on a particular CI, you cannot remove that CI from the model.

l If you create a model based on an empty template, you can remove all CIs from the model.

View a List of All CIs that are Related to the Selected CI

You can view in the model all CIs related to the selected CI (as defined by the selected template) as
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follows:

In the right pane, click Show All Connected CIs. This loads, from UCMDB, all CIs related to the selected

CI, as defined by the modeling template. The related CIs are displayed in the model.

Add an Existing CI to the Model

You can add an existing CI to the model. When you do this, it is automatically connected to the selected

CI in the model. This may not be the CI that started the model.

1. Do one of the following:

o In the right pane, go to the section called Add CIs and click Existing under the CI type that you

want.

o Click Plus in one of the CI type sections in the model. Then, in the right pane, click Add

Existing <CI type>.

The search screen appears. By default, a list of all CIs with the CI type you selected in the previous

step is displayed.

2. Locate the CI you want to add either by finding it in the displayed list or by searching for it in the

search box and click Add, which appears when you hover over the CI.

The CI is now added to the model, directly linked to the selected CI.

3. You can continue to add more CIs in this manner. When finished, click Done at the bottom of the

right pane.

Create a New CI and Add It to the Model

You can create a new CI and add it to the model. When you do this, it is automatically connected to the

selected CI in the model. This may not be the CI that started the model.

Note:

l Only CIs with a CI type that has been assigned the MODELING_ENABLED qualifier in UCMDB (by

the system administrator) can be created in the Assisted Modeling module.

l To edit the Tenant Owner and the Consumer Tenant attributes in the Assisted Modeling module

you need to have the Reassign Tenant and the View Tenant Assignment permissions, and the

attributes must be defined as CMS Browser Visible and CMS Browser Editablein UCMDB.
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1. Do one of the following:

o In the right pane, go to the section called Add CIs and click New under the CI type that you want.

o Click Plus in one of the CI type sections in the model. Then in the right pane, click Create

New <CI type>.

Note:

l Similar to the Properties widget in the UCMDB Browser, the CI properties are displayed

in the right pane. In the Assisted Modeling window, mandatory properties are marked

with an ‘*’. All of the mandatory fields must have a value to save changes you make to

any of the CI properties.

l For a property to be edited, it must be defined as CMS Browser Editable in UCMDB, in

the same manner as the Properties widget.

l If an attribute of a CI type has the Hide in Modeling qualifier selected, it is not

displayed when editing the CI.

2. Edit the property values.

3. Click Apply on the bottom of the pane.

The CI is now added to the model, linked to the CI that was selected.

Create and Remove Relationships between the Selected CI and Other CIs in the

Model

You can create relationships between CIs in the model and the selected CI, or remove existing

relationships between CIs in the model and the selected CI.

1. In the right pane, go to the Edit Connections section and hover over the CI that you want to create

a relationship with or remove the relationship from the selected CI.

Note: You can create relationships only with those CIs that are allowed by the template to

have a relationship with the selected CI and only with those CIs that are displayed.

2. Click Connect or Disconnect.
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Save Changes to the Model

Click Save at the top right of the Assisted Modeling window. When you click Save, all the changes you

have made in the Assisted Modeling window are saved to UCMDB. Until you click Save, none of the

changes you have made are saved.

It is possible that when you click Save, you will receive an error message(s) indicating what needs to be

fixed. Also, if there are errors the invalid CI is marked with a red triangle on the upper left corner.

Create Modeling Templates

1. In UCMDB, go to Modeling Studio and click New .

2. From the drop-down list, select Query. The Query Definition editor opens.

3. Click Query Definition Properties . The Query Definition Properties dialog box opens.

Note: By default, the Type field in the Query Definition Properties dialog box is Integration.

This value should not be changed.

4. Ensure that Integration is selected in the Type field (it should be selected by default).

5. In the Bundles field, click Select Bundles . The Select Bundles dialog box opens.

6. From the Bundles list, select modeling and click OK. If modeling does not appear in the list, enter

modeling in the text field and click Add New Bundle.

7. In the Query Definition Properties dialog box, click OK.

8. Build the TQL query and save it to any location.

Note:

l A user must have permissions on the query resource in order to view the template in the UCMDB

Browser.

l The following limitations exist on modeling templates:
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o Virtual links and compound links are not allowed.

o The TQL query must not have circular dependency.

Change the Modeling Layering Order

If you are viewing the model in Layers mode, you can change the order in which the modeling layers are

displayed

1. Click at the bottom of the Assisted Modeling window.

2. Under Change Layout, select Layers.

3. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

4. In the Name column, select Layer ordering.

5. In the Value field, change the layering order to the order that you want. Ensure that all layering

names are separated by commas.

6. Click Save.

7. If the UCMDB Browser is currently open, log off and then log on again to see the changes in the

layering order. If the UCMDB Browser is not open, you will see the changes in the layering order the

next time you log on.

Navigate the Modeling Topology Map Using a Quick Navigation Map

You can navigate the modeling topology map easily by turning on the quick navigation map.

In the quick navigation map, the elements from the canvas are represented. You can drag and resize

the selection in the map overview.

If the map is too large, a big overview of the map is available, which allows you to use the map overview

navigator to jump directly to a particular part of the map.

A toggle button is available in the map to allow you to turn on/off the minimap. If the map is larger than

20 CIs, the state of the button is saved in your user preferences.
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Notifications

Note:

l Notifications are supported on UCMDB 10.10 and later versions.

l If you log in to the UCMDB Browser with the customer state of Authorized, the Notifications

functionality is disabled automatically, even if it is enabled via settings.

Notifications in the UCMDB Browser enable you to see which property (CI or attribute) has changed, been

added, or been deleted since the last time notifications were generated. Notifications are sent

according to values specified in the UCMDB settings.

After enabling notifications in UCMDB (as described in "Configure notifications" on the next page), select

Notifications from the context menu for a selected CI to specify the widgets for which you want

to see notifications. This icon appears on the search results page and on the Most Visited page.

A list of notifications appears in the Notifications tab in the UCMDB Browser, marked with a (unread)

or (read) indicator, as well as in the locations mentioned above. In the Notifications tab, you can

choose to display all notifications or only unread notifications.

Clicking a notification opens the CI in CI Overview mode. Here, the widgets to which you have subscribed

that contain changes are marked with a  indicator (the changes themselves are visible only in

Widget Details mode). After entering Widget Details mode for any of the marked widgets, the icon in CI

Overview mode changes to . For widgets that contain changes, in Widget Details mode, notifications

that are marked with an  indicator display their values inline. If  is displayed, click the

indicator to see the older values in a pop-up window.

Indicators for changed values appear in the following widgets:

Properties widget An indicator is displayed next to each changed attribute (simple or logical, such
as owner, CPU, memory, and so on). For details, see "Properties Widget" on page
149.

Environment
widget

An indicator is displayed for each newly added CI in the CI list. For details, see
"Environment Widget" on page 151.

History widget An indicator is displayed for the current CI and for CIs related to the current CI

UCMDB Browser Installation and Configuration Guide

Chapter 3: Search and Functionality

HP Universal CMDB Browser (4.04) Page 143 of 203



(up to five levels). For details, see "History Widget" on page 153.

Policy widget An indicator is displayed on each new policy or on a change in the policy status.
For details, see "Policy Widget" on page 159.

Stakeholder
widget

An indicator is displayed for each CI in the list, as well as on the stakeholder's
personal information (email address and phone numbers). For details, see
"Stakeholder Widget" on page 168.

Widgets related to
Service Manager:
Change Request,
Incidents, and
Problems widgets

An indicator is displayed for each ticket, summarizing the changes in the ticket.
Indicators appear for new and updated items (what changed in the affected CIs,
phase, severity value, dates, and so on).

Note: You may receive notifications for these widgets but not be able to
view the corresponding widget details if:

l The particular request from Service Manager is in a state that currently
is not configured as being displayed in the UCMDB Browser. To specify
Service Manager request states to be displayed, in UCMDB, go to
Administration > Infrastructure Settings Manager > UCMDB Browser
Settings and specify the statuses that you want to be displayed.

l The particular CI that was subscribed to notifications for these widgets
from Service Manager is no longer affected by a request.

Dynamic widgets An indicator is displayed next to each changed attribute (for attributes that are
selected in the widget definition).

Note:

l Notifications on dynamic widgets are supported on UCMDB 10.10 CUP 1
and later versions.

l To receive notifications about changed attributes in dynamic widgets,
you must configure the attributes in the dynamic widget configuration.
For details, see "Create a dynamic widget" on page 179.

Note: In all widgets, for data that has been removed or deleted, a indicator appears

next to the widget's title. Click the indicator to view a pop-up window containing all deleted CIs and

attributes.

Configure notifications

l To enable notifications:

UCMDB Browser Installation and Configuration Guide

Chapter 3: Search and Functionality

HP Universal CMDB Browser (4.04) Page 144 of 203



a. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

b. In the Name column, choose Enable notifications.

c. In the Value column, set the value to True.

d. Click Save .

e. Log out from the UCMDB Browser, and then log in again to load the new setting.

f. In the UCMDB Browser, click and specify the widgets for which you want to see

notifications.

l To specify persistency values for notifications:

The length of time that notifications are retained and how often they are generated are defined in

the JMX console:

a. Go to JMX Console > UCMDB:service=Settings Services > setSettingValue.

b. To change each setting, follow these steps:

i. In the name field, enter one of the strings listed below:

l tql.tracker.queue.evaluation.initial.delay.in.min - the initial delay (in minutes) after

startup, before a TQL query is calculated.

l tql.tracker.queue.evaluation.period.in.min - the interval (in minutes) of how often a TQL

query is scheduled to run.

l tql.tracker.queue.max.single.run.time.in.min - the maximum length of time (in minutes)

for the system to work on calculating changes on CIs or TQL queries during a single

execution.

l tql.tracker.min.time.between.tracker.runs.in.min - the minimum length of time

between two runs of a TQL query.

Note: To find the default value for each setting, enter the required string in the name

field of getSettingDefaultValue and click Invoke.
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ii. In the value field, enter the value you want to set.

iii. Click Invoke.

c. Restart the UCMDB server.

Schedule Notifications

You can configure the UCMDB Browser to receive notifications by email.

Note: Receiving notifications by email is supported on UCMDB 10.10 CUP 1 and later versions.

[LC Req. 27039 for 3.2]

You can schedule how often to receive notifications by email by clicking on the Settings button and

selecting Schedule Notificationsfrom the drop-down list.

The emails include the following for each CI with notifications:

l the name, type, and icon

l the widgets that contain the changes from the notifications

l a link back to the UCMDB Browser in the context of the CI

You can choose to receive emails on an ad-hoc basis, or daily at a time that you specify. You must

specify the email address to which the notifications will be sent.

l Ad-hoc emails

Click the Schedule ad-hoc email checkbox to receive notification emails at the interval that has

been specified by your system administrator.

To specify this interval, set the tql.tracker.queue.evaluation.period.in.min setting as described in

"Configure notifications" on page 144.

The same notification will not be sent more than one time.

l Daily emails

Click the Schedule daily email checkbox and select the time of day that you want to receive the
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emails.

All unread notifications will be sent, whether or not they were sent previously.

Note: After you change this setting, you must restart the UCMDB Browser to apply the new value.

Export notifications

[LC Req. 27038 for 3.1]

You can choose to export results for all notifications or only for unread notifications. On the

Notifications tab, click View: Unread or View: All as required.

In addition to the attributes that you specify in the Infrastructure Settings Manager in UCMDB, the name

of the widget in which the changed CI appears is also included in the results.

l To specify the attributes to be exported:

a. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

b. Do the following:

l In the Name column, choose Minimal export of search results and choose True if you want

to export only the display label, class name, CI ID, and Global ID attributes for each CI. Choose

False if you want to export all attributes that are displayed in the Properties Widget.

Additional attributes can be excluded if they are marked in the CI Type Manager in UCMDB.

For details, see the description of the Hide in Export Search Results qualifier in the HP

Universal CMDB Modeling Guide.

l In the Name column, choose Remove logical attributes (owner, location) from export of

search results and choose True to remove the owner and location attributes from the

exported search results.

If you set Minimal export of search results to False, the attributes displayed in the expanded mode

of the Properties widget are exported.

l To export notification results:
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a. Click Export results in the search results toolbar. The following options are available:

l Current page > XLS or CSV

l All pages > XLS or CSV

b. Click Open, Save, or Cancel.

The created file is named with the date and time that the export was performed.

Export Widget Details
You have the ability to export the details for a selected CI in any of the supported widgets (Properties,

Environment, Impact Simulation, History, and Stakeholder widgets).

To enable this functionality, in UCMDB, go to Administration > Infrastructure Settings Manager >

UCMDB Browser Settings and set Enable reports to True. If this feature has not been enabled, the

export icons do not appear in the UCMDB Browser.

Note: Generated reports that are older than one week are automatically deleted.

Export details for a specific widget

In CI Overview mode, click the icon on a supported widget and select one of the following options:

l Export to PDF

l Export to XLS

l Export to CSV

The details that are displayed in the selected widget are generated in a file which you can view

immediately or save.

Note: The report generated from the History widget contains the history (changed attributes and

related CIs) of the selected CI, and of the CIs contained in the selected CI’s model, based on the

specified time range. The same data will be exported from both Selected view and Model view.

UCMDB Browser Installation and Configuration Guide

Chapter 3: Search and Functionality

HP Universal CMDB Browser (4.04) Page 148 of 203



Export details for all supported widgets

In CI Overview mode, click the icon at the top of the screen and select one of the following options:

l Export to PDF

l Export to XLS

The details that are displayed for all supported widgets are generated in a file which you can view

immediately or save.

Properties Widget
The Properties widget is used to present the main, general properties of the selected CI, either by

means of a search result or by refocusing it. The properties presented are customized and differ for

each selected CI type. CI Overview mode presents the most important properties and Widget Details

mode displays additional properties. The information presented in this widget is logically connected to

the selected CI and not according to the UCMDB Data Model.

To specify the properties that are displayed by this widget, see "Configure Properties to be Displayed by

the Properties Widget" on page 83.

To display attributes with empty values (by default, attributes with empty values are not displayed), see

"Configure the Properties Widget to Show/Hide Empty Attributes" on page 93.

You can prevent a CI's location and owner from being displayed in the Properties widget by setting the

Show Location Details and Show Owner Details settings in the Infrastructure Settings Manager in

UCMDB to False. By default, these settings have the value True, and the location and owner are

displayed.

If the UCMDB administrator has configured a property as CMS Browser Editable, an Edit button is

displayed. Click this Edit button to edit the attributes of these properties. When you are finished, click

Save changes or Cancel.

Note:

l For Edit mode to work, the logged-in user must have RUN_DISCOVERY_AND_INTEGRATIONS

permission. For details, see "Roles Manager Page" in the HP Universal CMDB Administration

Guide.
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l To view the Tenant Owner and the Consumer Tenant attributes in the Properties widget , you

need to have the View Tenant Assignment permission, and the attributes must be defined as

CMS Browser Visible in UCMDB. To change the tenant association for a CI, you need to have the

Change Tenant Association permission, and the CI's attribute must be defined as CMS Browser

Editable in UCMDB.

l To edit the Tenant Owner and the Consumer Tenant attributes in the UCMDB Browser you need

to have the Reassign Tenant and the View Tenant Assignment permissions, and the attributes

must be defined as CMS Browser Visible and CMS Browser Editablein UCMDB.

CI Overview Mode

In this mode, for all CI types, a maximum of three properties are displayed for the selected CI. These

properties are configured by the system administrator.

Note: For details about the priorities that are displayed, see "Configure Properties to be Displayed

by the Properties Widget" on page 83.

Widget Details Mode

In this mode, each property is presented on a separate line. The display is divided into three panels, as

follows:

l Core Properties. This panel displays the most important and valuable properties of the selected CI.

For example, for a node the displayed properties could include its OS name, serial number, memory

size, etc.

l Complementary Properties. This panel displays other important properties for the selected CI.

These properties are usually less important than the ones presented in the Core properties panel,

but may still interest most UCMDB Browser users. All properties depicting the CI’s discovery process

are included in this panel.

l Additional Properties. This panel is configured entirely by the UCMDB administrator, and can include

all other properties the Administrator thinks may interest UCMDB Browser’s users. Attributes that

are defined as CMS Browser Visible but do not appear in one of the other two panels are also

displayed in this panel.

The panels are presented in consecutive order and labeled with the panel name. A panel with no

properties is not presented. If a byte type attribute value does not fit entirely in the panel (it is
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displayed truncated), the indicator "..." appears next to the displayed text and a Show All link appears

next to it. Clicking Show All displays the byte type attribute value entirely in a pop-up window.

Note: For instructions on how to assign the panel in which an attribute is displayed, see "Configure

Properties to be Displayed by the Properties Widget" on page 83.

Environment Widget
The Environment widget presents the closest environment of the selected CI (as defined in by the

calculated links that are specified in the CI Type Manager in UCMDB). Details about CIs in the

environment can be displayed in either textual or graphical mode.

Starting with UCMDB 10.00 CUP 1 version, user preferences are saved in the UCMDB server's user

preferences.

CI Overview Mode

A count of CIs contained in the selected CI's environment are displayed, divided by classification. Only

classifications containing more than one CI are displayed. Each classification includes the name of the

classification, its icon, and the number of CIs included in it. Clicking a particular classification displays

the widget details and filters the selected classification (in both Graphical Mode and Textual Mode).

When you click the direct link icon, another web browser window opens, displaying UCMDB's IT Universe

Manager in the Get Related CIs module.

Widget Details Mode

The widget details mode presents the detailed environment data in either textual or graphical mode,

whichever was last used. Textual mode is the default view mode.

Note: If graphical mode does not display, it may be due to the fact that the drive of the machine

where the UCMDB server is installed is full. Free up some space on that drive in order to view

graphical mode.

l o Toolbar

The top row of the Environment widget acts as a toolbar and enables you to:
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l Switch between graphical and textual modes

l Click a button (in graphical mode only) that opens or closes the CIs pane. The default mode

for the CIs pane is opened.

Note: You can also open the CIs pane by selecting a classification in the Topology map.

The CIs pane details the CIs contained in the classification that is selected in the Topology

pane, dividing it into all relevant CI types.

o Textual mode

l Left pane. The left pane displays a list of all classifications containing at least one CI. Each

classification is broken down into a list of the CI types in that classification that have at least

one CI. Selecting any line in this pane displays its details in the right pane.

l Right pane. The right pane displays detailed information about the item that is selected in

the left pane, divided by CI type.

o Graphical mode

Note: When the UCMDB Browser is embedded in an UCMDB server running on a Linux system,

runlevel 5 (enabled X server) is needed for the graphical mode of the Environment Widget to

operate properly. In addition, add unset DISPLAY to the server.sh script. Restart the

UCMDB Server for the server.sh changes to take effect.

In graphical mode, information is displayed in a topology map format.

l For each classification containing at least one CI, the name and number of CIs in that

classification is displayed. Clicking a classification displays all CIs contained in that

classification and matching the current filter. In addition, a thumbnail is displayed for each CI

type that contains more than a single CI.

l Classification icons are displayed in layers according to the relative hierarchy of the CIs as

displayed in the topology map in UCMDB.

l You can navigate in the Environment Widget easily by turning on the quick navigation map.

In the quick navigation map, the elements from the canvas are represented. You can drag

and resize the selection in the map overview.
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If the map is too large, a big overview of the map is available, which allows you to use the map

overview navigator to jump directly to a particular part of the map.

A toggle button is available in the map to allow you to turn on/off the minimap. If the map is

larger than 20 CIs, the state of the button is saved in your user preferences.

Directional lines representing links are displayed with other items in the view if the selected CI

has a direct relationship with at least one other CI (either in the same classification or in a

different classification).

HistoryWidget

Note: The History widget is supported on UCMDB 10.01 and later versions.

The History widget is used to compare details about the selected CIs between different points in time.

The comparison is based on the UCMDB History storage, and can present the following information:

l Changes in attribute values.

l Changes in connectivity between the selected CI and related CIs (due either to addition or deletion of

links between CIs).

l Creation of the CI in UCMDB.

The Selected tab displays historical changes for the selected CI only. The Model tab shows CIs related to

the selected CI that have historical changes. Clicking one of the related CIs displays historical changes

for that related CI.

Note:

l Changes are compared between two points in time. Additional or multiple changes are neither

counted nor presented. For example, the value of an attribute that changes on date X from

value A to value B, and then on date Y from value B to value A, is not displayed as changed.
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l Dates presented in the History widget are displayed in the format defined in the user's default

browser. Only changes after Jan. 1, 1970 are shown. If no changes were made on the selected CI

between the two comparison dates, the message “No data available for History widget” is

displayed.

l For all historical comparison purposes, the snapshot time taken into account is the time that

the CI was changed.

User preferences are saved per user according to the last user's selection:

l The Compare mode (either Selected or Model mode, explained below)

l The latest From and To dates for comparison

CI Overview Mode

This mode displays a graph summarizing the historical changes that occurred in the selected CI (the

default display option) or its model during the previous four weeks. The X axis lists five dates, from four

weeks ago to the current date. The Y axis shows the number of changes in a single day.

Widget Details Mode

The following information is displayed in the widget details mode:

l Presents the Compare mode and the beginning and end dates used for comparison. The default end

date is the current date and time. The default beginning date is the current end date minus the

History Widget From Date setting that is set in UCMDB. The beginning date always starts from

12:00 AM. For example, if the History Widget From Date setting is 5, and the current date is Jan. 30,

2013, then the default beginning date is Jan. 25, 2013 at 12:00 AM. The default value for the History

Widget From Date setting is 7, but this value can be changed by the UCMDB Administrator, as

explained in "Change the History Widget 'From Date'" on page 101.

l If the Compare mode in the last user’s filter is Selected, the History Comparison View for the

selected CI, according to the filter settings, is displayed.

l If the Compare mode in the last user’s filter is Model, the Model view, with all classifications and CI

types according to the filter settings (either the last user selection or default values) is displayed.

The widget details are divided into the following sections:

UCMDB Browser Installation and Configuration Guide

Chapter 3: Search and Functionality

HP Universal CMDB Browser (4.04) Page 154 of 203



l Filter section

When the History widget is expanded, the Filter section is loaded with the latest user selections (as

saved in the user preferences, if any). If there is no latest user selection, the default values are:

o Compare mode – Selected

o Last history comparison dates:

l From date – this date is calculated as follows: current date minus the History Widget From

Date setting that is set in UCMDB, starting from 12:00 AM.

l To date – the current date

Each time a filter field is changed, its data is saved in the user preferences.

Use the following UI elements to configure the information displayed by the History widget:

o The Compare mode tabs toggle between displaying the history comparison only on the selected

CI, or in the wider context of the model (explained above). When you toggle between the two

modes, the following changes occur:

l If the value changes to Selected – the History Comparison view for the selected CI using the

current filter is displayed (regardless of the previous view).

l If the value changes to Model – the Model view, with all classifications and CITs resulting from

the current filter (regardless of the previous view) is displayed.

o The date pickers allow you to select From and To dates (defining the history comparison date

boundaries). Any valid date can be selected. When you select dates, the history comparison is

recalculated according to the new dates, resulted in the displayed view being refreshed (either

history comparison or CI selection).

Note: If the To date is earlier than the From date, an error message is displayed.

l Model View

The Model view displays all CIs contained in the selected CI’s model that match the current filter

(that is, have at least one historical change during the selected time frame), divided by classification

and CI type. This area is only visible when the Compare mode is set to Model, and it is divided into

two panes:
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o Left pane

The left pane summarizes the number of CIs that match the current filter, divided into an

alphabetical list of classifications and CI types.

l The first line (displaying the word All) shows the total number of CIs matching the current

filter. Clicking this line displays, in the right pane, all CIs contained in the selected CI’s model

and matching the current filter.

l For each group with more than a single CI, the name and number of CIs in that group is

displayed. Clicking a group displays, in the right pane, all CIs contained in that group and

matching the current filter.

l Following each group's name, an alphabetical list of all CI types in that group (with more than

a single CI) is displayed. Clicking a CI type displays, in the right pane, all CIs of that CI type and

matching the current filter.

l The icon, name, and number of CIs in that group are displayed for each CI type.

o Right pane

The right pane displays the details of the data in left pane, divided into all relevant CI types. For

each CI type, the following details are displayed.

l The name of the CI type and the number of CIs contained in it.

l The list of CIs contained in the CI type, including the icon, name, and type for each CI.

In addition, hovering over a displayed CI shows a selection button. Clicking this button opens the

History Comparison view for the selected CI.

Ten CIs are displayed for each CI type. If there are more than ten CIs for a CI type, a link appears,

enabling you to view all of the CIs.

Clicking on a CI in this pane opens the History Comparison view for that CI.

If the number of CIs matching the current filter is 0, the first line of the widget displays All 0, and

the right pane is empty.

l History Comparison View

The History Comparison view displays a list of the changes in a specific CI between two selected

points in time. This view appears when:
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o The Compare mode is set to Selected – the selected CI is used for the historical comparison.

o The Compare mode is set to Model and a CI is selected in the Model view – that CI is used for the

historical comparison. In this case, a Back button also appears. Clicking the Back button switches

back to the Model view.

In the upper left corner of the History Comparison view, the following information is displayed for

the CI used for comparison: CI icon, name, and CI type. Clicking on the CI name here takes you to the

CI Overview for the CI under comparison.

The History Comparison view has two sections: Changed Attributes and Changed Related CIs. These

sections are described in detail below.

Changed Attributes section

In the Changed Attributes section two columns appear, displaying the values for the selected CI on

the From and To dates.

The date appearing in the header of the From column is the closest date to the current date from

among:

o the filter's From date

o the date that the CI was created

o the earliest date that has history events for the selected CI

For each changed attribute, its name and the value it had on the From and To dates is displayed.

Clicking on a displayed attribute expands the row on which the information is displayed and shows

the date of the latest change and the user who caused that change. If the value of a byte type

attribute does not fit entirely in the panel (it is displayed truncated), the indicator "..." appears next

to the displayed text and a Show All link appears next to it. Clicking Show All displays the byte type

attribute value entirely in a pop-up window.

If no changes are detected during the selected time period, the message "There are no items to

display" appears.

Changed Related CIs section

The Changed Related CIs section displaysa list of all CIs that were either attached to (linked to) or

detached from the selected CI between the From and To dates.

UCMDB Browser Installation and Configuration Guide

Chapter 3: Search and Functionality

HP Universal CMDB Browser (4.04) Page 157 of 203



Starting from UCMDB Browser version 4.01, this section does not load by default. Instead, a Load

Changed CIs button is available, allowing you to load relationship changes

only on demand by clicking the button.

Starting from UCMDB Browser version 4.04, the button is also available in

the Model view. Clicking this button in Selected view or Model view, displays the relationship changes

in both Selected view and Model view.

The following information is displayed for each CI listed in this section:

o CI icon

o name

o CI type

o linkage state, which is either Related or Not Related

When clicking a CI in this section, it expands and shows the last update date. When expanded, if you

click the CI type, icon, or name; the CI Overview for that CI is displayed. Clicking elsewhere reverts to

the previous view where no update information is presented.

Impact Simulation Widget
The Impact Simulation widget presents the impact analysis of a selected CI (that is, which CIs are

impacted by it, according to a selected impact severity level).

The following table displays the severity levels used in the UCMDB Browser and the comparable severity

levels in the UCMDB server:

UCMDB Browser UCMDB Server

Critical Critical(9)

High Major(8)

Medium Minor(6)

Low Warning(2)

The severity level for a CI is cleared (set to None) when you log in to the UCMDB Browser.
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Note: To view data in the Impact Simulation widget, there must be an impact rule created in UCMDB

and you must have View permission for the Resource Groups > Impact Analysis resource.

This widget uses out-of-the-box impact rules from UCMDB. To configure the impact rules used by this

widget, see "Specify Impact Rules" on page 101

CI Overview Mode

This mode summarizes the number of CIs impacted by the selected CI by means of an Impact Bar,

according to the four severity levels: Critical, Major, Minor, and Normal.

Widget Details Mode

This mode presents detailed information on all the CIs impacted by the selected CI. You can change the

severity, which will rerun the analysis to show a different level of impact.

Policy Widget
The Policy widget is presented only if a live Configuration Manager (CM) system is deployed in the

UCMDB environment. The terminology and icons used in both the CI Overview and Widget Details modes

are identical to what is used in CM. All Key Performance Indicators (KPIs) and related attributes are

taken from CM (that is, no calculation is performed by the Browser).

Note: To use the Policy widget, you must have CM version 9.30 or later installed, and CP10 or later

installed on the UCMDB server.

CI Overview Mode

This mode displays the selected CI's overall policy KPI, taken from CM, as follows:

l Overall policy compliance status: whether it is satisfied or in breach

l Overall policy compliance value (in terms of percentage, graphically presented in a bar)

l KPI description, automatically generated by the CM

For business elements, the CI overview presents the overall business policy KPI (that is, a summary of all

CIs linked to the Business CI, as opposed to the CI itself). A direct link to the CM system, with the context

of the selected CI, is presented in the widget.
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Notifications for changes in the Policy widget are displayed only in the Notifications tab and in the

widget's CI Overview mode.

Widget Details Mode

This mode adds the following details, taken from CM:

l All policies linked to the selected CI. Each policy is separated from the others by an empty space.

l For each linked policy, the policy name, compliance status, and a description are displayed.

Change Requests Widget
The Change Requests widget presents the Change Requests related to the selected CI. CI Overview

mode displays the total number of Change Requests for each Change Request state. Widget Details

mode displays a list of all the Change Requests related to the CI and all their details. The Change

Request widget is presented only when HP Service Manager (SM) configuration element is enabled and

configured in the Infrastructure Settings in UCMDB. All data presented is taken from the UCMDB

federated RequestForChange CI and its relationships.

A Change Request is considered related to a CI if it meets one of the following criteria:

l All Change Requests linked directly to the CI.

l If the selected CI is a Model: All Change Requests linked to all the CIs contained in that model

(meaning, any other contained model or CI).

l If the selected CI is a Person: All Change Requests that are connected to all the CIs owned by that

person.

l In all other cases: All Change Requests that are linked with a composition link to the selected CI (for

example: Running Software to Windows Server).

CI Overview Mode

In this mode, change requests related to the selected CI that have one of the following statuses are

presented:

l Recent. All Change Requests that terminated in the recent time frame (default – 3 days, is

refreshed if the selected time frame is changed in the widget details).
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l In Progress. All Change Requests that are currently in-progress. A Change Request is considered In

Progress if it is open, meaning that its planned start date has passed and its planned end date has

not yet passed. Also, its phase must qualify as In Progress, meaning that it is defined in the In

Progress list in the XML configuration file.

l Overdue. An overdue Change Request is a Change Request that was In Progress but whose planned

end-date has passed.

l Planned. All Change Requests that are planned to start in the recent time frame (default – 3 days, is

refreshed if the selected time frame is changed in the widget details.

l Delayed. A Change Request is Delayed if it was a Planned Change Request but its planned start-date

has passed.

The UCMDB administrator can define which IT SM RFC Phase is mapped to each one of the Change

Request statuses Recent, In Progress, and Planned (the Overdue and Delayed statuses are

automatically calculated by the UCMDB Browser). The UCMDB Browser is configured by default in the

following manner:

UCMDB Status IT SM RFC Phase

Recent Evaluation, Closure

In Progress Implementation

Planned Approval

If a Change Request’s phase does not exist in the configuration list it is ignored, meaning that it is not

included in the Change Request summary or detailed list.

If a Change Request’s planned start date or end date are not defined, the UCMDB Browser uses the

current date for both planned start/end dates (in both the CI Overview and Widget Details modes).

Widget Details Mode

This mode adds the following to the summary displayed in the CI overview:

l Timeline Span toggle: +/-3 days , +/-1 week, +/-1 month. Selecting a timeline span details all Change

Requests related to the selected CI that are contained within the selected timeline (that is, either

their start date or due date are within that timeline). Note that changing the timeline should change

the summary displayed in the CI overview.
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l Show toggle: All/Late. Selecting All details all Change Requests related to the CI in the selected

timeline, selecting Late presents only those Change Requests that are either overdue or delayed (as

explained above).

l All relevant Change Requests, sorted by their status (Recent, In Progress, Overdue, Planned, and

Delayed). The internal sort within each status group is according to Change Request phase and then

planned start date.

The following information is provided per each Change Request:

l ID. This is a clickable field that refocuses on the RequestForChange CI when selected

l Phase

l Planned Start Date. Is emphasized if the Change Request is Delayed.

l Planned End Date. Is emphasized if the Change Request is Overdue.

l Affected CIs. Up to 10 CIs within the context of the selected CI are presented, with a link to show all

results in the event that there are more than 10 affected CIs within the context of the selected CI

linked to the Change Request. Affected CIs can be refocused.

l Affected Service. The first BusinessService CI, within the context of the selected CI, connected to

the Change Request CI through a membership link. If no such CI exists, the Affected Service header

is not displayed. The Affected Service can be refocused.

l Severity

l A direct link to the Service Manager system with the context of the selected change request is

presented per each change request, if this link is configured by the system administrator. For

instructions on how to configure this direct link to Service Manager, see "Configure a Direct Link to

Service Manager for a Selected Problem, Incident, or Change Request" on page 195.

Incidents Widget
The Incidents widget presents the incidents related to the selected CI. CI Overview mode shows the

number of incidents per priority, where the priority groups are Urgent, Major, Minor, and None. Widget

Details mode displays incident details. The Incidents Widget is presented only when the Incidents setting

element is enabled and configured from the Infrastructure Settings Manager in UCMDB. All data

presented is taken from the UCMDB federated Incidents CI and its relationships.

This widget displays incidents related to the selected CI as follows:
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l All incidents linked directly to the CI through a Connection link.

l If the selected CI is a Model. All incidents linked to all the CIs contained in that model (meaning, any

other contained model or CI).

l All incidents linked to CIs that are connected to the currently selected CI through a composition or

membership relationship.

l For BusinessService CIs. All incidents linked directly to the CI through an applicationLink link.

If an incident’s priority does not map to a UCMDB Browser’s Internal Priority, it should not be counted in

CI Overview mode nor presented in Widget Details mode. For instructions on how to configure the

UCMDB Browser's Internal Priorities, see "Configure Browser Internal Priorities (for the Incidents and

Problems Widgets)" on page 43.

CI Overview Mode

This mode presents the number of open incidents from SM that have an Open Date within the Timeline

Span selected in the Widget Details mode (see the description below). The incidents are categorized by

their Internal Priority, where:

l Open incidents are all incidents whose status (an IT SM attribute, federated to UCMDB) is within a

configured range of values defined by two configuration parameters. If an incident status does not

belong to that set of values, it is not considered open.

l Internal Priority is a UCMDB Browser set of values (1-4), where each value has a configurable label

and is mapped to a set of IT SM Priority values (an SM attribute, federated to UCMDB). For instance,

a valid configuration could be of four Internal Priorities (Urgent, Major, Minor, None), where each is

mapped to a specific unique set of IT SM Priority values.

l Both configuration parameters are defined only by the UCMDB administrator.

Widget Details Mode

This mode adds the following information to the summary displayed in CI overview mode:

l Timeline Span toggle. This is a 4-way toggle, with the options Less than a day, Between 1 to 3

days, More than 3 days, and Show All. Selecting a timeline span displays all open incidents related

to the selected CI that are in the timeline span (that is, their Open Date is within that timeline span).

Changing the timeline span also changes the incident groups displayed in CI Overview mode. The

default timeline span in Widget Details mode is Less than a day, unless there are no incidents in
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that span, in which case Between 1 to 3 days is displayed. The timeline span remains in effect for

each user until it is changed.

l All relevant incidents, divided by their Internal Priority. The internal sort within each priority group is

according to the incident’s Open Date. The following items are provided per each incident:

o Incident ID. This is a clickable field that refocuses on the Incident CI when selected.

o Status

o Impact

o Urgency

o Priority

o Open Date

o Title

o Outage Start (this is an optional SM parameter)

o Affected CI. Only a single CI is presented with a link to display all results. The CI presented is

either the node to which the incident is linked (if it is not the current CI) or a Business CI affected

by the incident (if the current CI is directly linked to the Incident CI). If there is a Business Service

connected directly to the incident, it should be displayed as an affected CI. Affected CIs can be

refocused.

Note: The affected CI is displayed only if it is within the context of the selected CI.

o Affected Service. The first BusinessService CI connected to the Incident CI through a

membership link. If no such CI exists, the Affected Service header will not be displayed. Affected

Service can be refocused.

l A direct link to the Service Manager system with the context of the selected incident is presented

per each incident, if this link is configured. For instructions on how to configure this direct link to

Service Manager, see "Configure a Direct Link to Service Manager for a Selected Problem, Incident,

or Change Request" on page 195.

l Each incident is separated from the others by empty space.
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Problems Widget
The Problems widget presents the problems related to the selected CI, either according to their

numbers (in CI Overview mode) or by their details (in Widget Details mode). A problem is considered

related to a CI if it meets one of the following conditions:

l It is linked directly to the CI through a Membership link. Note that IT Service Manager connects a

Problem to its affected Business Service in the same manner (that is, a Membership link connects

the Problem CI with the Business Service CI).

l If the selected CI is a Model, all problems linked to all the contained CIs in that model (meaning, any

other contained model or CI) are considered related to the selected CI.

l In all other cases, all problems linked to the selected CI's composition/membership connected CIs

(probably a Node) are considered related to the selected CI.

Note:

l This widget appears only when it is enabled in UCMDB. For instructions on how enable this

widget, see "Enable the Problems Widget" on page 167.

l If you are connecting to a UCMDB Server that has Content Pack 10 or an older version installed,

you must perform the instructions in the section "Configure the Problems Widget to Work with

Content Pack 10 or Earlier Versions" on page 167 below so that the Problems widget functions

properly.

All presented data is taken from UCMDB Federated Problems CI (and its relationships).

CI Overview Mode

This mode presents the total number of Open problems, categorized by their Internal Priority. Open

problems are all problems with a Status (a Service Manager attribute, federated to UCMDB) that is

within a configured set of values. If a problem’s Status does not belong to that set of values, it is not

considered open.

Internal Priorities are a set of UCMDB Browser values (1-4), where each value has a configurable label

and is mapped to a set of Service Manager Priorities (these are Service Manager attributes that are

federated to UCMDB). For instance, a valid configuration could be four Internal Priorities (Urgent, Major,

Minor, None), where each is mapped to a specific unique set of Service Manager Priority values.
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Configuring the set of values to define when a Problem is open and configuring the four UCMDB Browser

Internal Priorities should be performed only by the UCMDB administrator.

The UCMDB Browser’s mapping between Internal Priorities and Service Manager priorities should be

defined once and be used by all relevant Widgets (that is, the same configuration settings are used for

both the Incidents and Problems Widgets). If a Problem’s priority does not map to a UCMDB Browser

Internal Priority, it is not counted in the CI overview or presented in the widget details.

For instructions on how to configure the UCMDB Browser Internal Priorities, see "Configure Browser

Internal Priorities (for the Incidents and Problems Widgets)" on page 43.

Widget Details Mode

This mode displays all relevant problems according to their Internal Priority. The internal sort within

each priority group is by alphabetic order. The following information is presented for each problem:

l Problem ID: This is a clickable field that refocuses on the Problem CI when selected. The ID is taken

from the reference_number attribute.

l Title: Taken from the name attribute.

l Status: Taken from the problem_status attribute.

l Impact: Taken from the impact_scope attribute.

l Urgency: Taken from the urgency attribute.

l Priority: Taken from the priority attribute.

l Affected CI: Only a single CI is presented with a link to show all results. The CI presented is either the

node to which the problem is linked (if it is not the current CI) or a Business CI affected by the

problem (if the current CI is directly linked to the Problem CI). If there is a Business Service

connected directly to the Problem, it should be displayed as an affected CI. Affected CIs can be

refocused.

l Affected Service: The first BusinessService CI connected to the Problem CI through a membership

link. If no such CI exists, the Affected Service header is not displayed. The Affected Service can be

refocused.

l A direct link to the Service Manager system with the context of the selected problem is presented

per each problem, if this link is configured. For instructions on how to configure this direct link to

Service Manager, see "Configure a Direct Link to Service Manager for a Selected Problem, Incident,

or Change Request" on page 195.

UCMDB Browser Installation and Configuration Guide

Chapter 3: Search and Functionality

HP Universal CMDB Browser (4.04) Page 166 of 203



Enable the Problems Widget

To enable the Problems widget in UCMDB:

1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

2. In the Name column, choose Enable Problems widget.

3. In the Q:\UCMDB_daily_build\UCMDB_Browser\Ver_3.0\UCMDB_Browser_Online_Help\UCMDB_

Browser_Online_Help.htm column, choose True from the drop-down list.

4. Click Save .

Configure the Problems Widget to Work with Content Pack 10 or Earlier Versions

To configure the Problems widget to work with Content Pack 10 or earlier versions:

1. In UCMDB, go to Modeling > CI Type Manager.

2. From the menu bar, choose CI Types > System Type Manager.

3. In the System Type Manager dialog box, select ProblemStatus and click the Edit button.

4. In the Update List Definition dialog box that opens, in the Values section click the Add button

and add a new value called closed.

5. Click OK in the Update List Definition dialog box and then Apply in the System Type Manager dialog

box.

Monitoring Widget
The Monitoring widget displays the statuses of KPIs (received from the BSM) for the selected CI. KPI

statuses can be one of the following: Ok, warning, minor, major, critical, info, no data, and downtime.

CI Overview mode displays the worst KPI status for the selected CI (where downtime is the worst status,

and Ok is the best status). Widget Details mode shows all the details of all KPIs related to the selected

CI.

The UCMDB Browser comes with a BSM adapter that is deployed on the UCMDB server when the Browser

first loads. For this widget to work, the UCMDB administrator must configure this adapter, as described

in "Configure the BSM Health Indicator (for the Monitoring Widget)" on page 185.
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Note:

l System time on the UCMDB server and BSM server should be synchronized, otherwise

monitoring data in the UCMDB Browser will be empty.

l The BSM does not return KPIs for CI collections.

l For the Monitoring Widget to properly display KPI statuses for the selected CI, ensure that all CIs

monitored in the BSM have the attribute Store KPI History For Over Time=true.

Adding Another Data Source for Display in the Monitoring Widget

If you want to add another data source to be displayed in the Monitoring widget, you must add an

additional integration point name to the <data_stores> tag in the ucmdb_browser_config.xml

configuration file, as shown in the following example:

<bsm_configuration>
<data_stores>

<data_store>bsm_adapter</data_store>
<data_store>second_adapter</data_store>

</data_stores>
</bsm_configuration>

Stakeholder Widget
The Stakeholder widget displays data on the owner of the selected CI and also on owner(s) of CIs

directly related to the selected CI. A stakeholder is defined as either the owner of the selected CI or the

owner of a CI directly related to the selected CI.

Note: If the type of the selected CI is Person, this widget is collapsed, disabled, and displays the

following message: “This widget is not relevant for selected CI”.

CI Overview Mode

In this mode, if there is more than one owner for the selected CI this widget displays the total number of

owners (called Direct Stakeholders in the user interface). If there are one or more owners of CIs directly

related to the selected CI, this widget displays the total number of owners of those directly related CIs

(called Other Stakeholders in the user interface). If the selected CI has no direct owner, the message

“There is no direct stakeholder” is displayed in the center of widget.

This widget also displays the following information on the owner of the selected CI:
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l Thumbnail picture (if it exists)

l Name

l Organization or Functional Group (if defined)

l Email address (if defined)

l Telephone number(s) (if defined). If there is more than one phone number for the owner, there is a

button that expands the list of available phone numbers and indicates the type of phone of the

owner.

Note:

l The owner can have one of the following CI types: Organization, Functional Group, or Person. If

there are two or more direct owners of the selected CI, this widget displays the owner in CI

Overview mode according to the following priority levels: Organization (highest priority),

Functional Group, Person (lowest priority).

If, according to the priority levels above, there are two or more direct owners with the same

priority level to be displayed, this widget displays the owner that comes first according to

alphabetical order.

l For the Person CI Type, this widget displays the Person's name according to the following

priority levels: user label (highest priority), name, name of type (lowest priority).

Only if the user label does not exist, will the widget display the Person's name. And only if the

user label and name do not exist, will the widget display the name of type.

Widget Details Mode

This mode displays the same information that is listed in CI Overview mode, but for every stakeholder of

the selected CI, and also displays all CIs owned by the stakeholder, within the context of the selected CI.

Note: The default source of the thumbnail pictures is the gravatar.com website; however, this

source can be changed as described in "Change the Source of Thumbnails (for the Stakeholder

Widget)" on page 100.
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Dependent Services Widget

Note: The Dependent Services widget is supported on UCMDB 10.20 and later versions.

The Dependent Services widget presents all services (that is, all CIs that have the SERVICE_MODEL

qualifier) that will have an impact on a selected CI if they fail, according to a specified impact severity

level.

The following table displays the severity levels used in the UCMDB Browser and the comparable severity

levels in the UCMDB server:

UCMDB Browser UCMDB Server

Critical Critical(9)

High Major(8)

Medium Minor(6)

Low Warning(2)

The severity level for a CI is cleared (set to None) when you log in to the UCMDB Browser.

Note: To view data in the Dependent Services widget, there must be an impact rule created in

UCMDB and you must have View permission for the Resource Groups > Impact Analysis resource.

This widget uses out-of-the-box impact rules from UCMDB. To specify the impact rules used by this

widget, see "Specify Impact Rules" on page 101.

CI Overview Mode

This mode summarizes the number of services that may impact the selected CI, according to the four

severity levels: Critical, Major, Minor, and Normal.

Widget Details Mode

This mode presents detailed information on the services that may impact the selected CI. You can

change the severity, which will rerun the analysis to show a different level of impact.
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Security Widget
The Security widget displays security-related data for the selected CI. This widget appears only if a live

ArcSight Enterprise View (EV) system is deployed with a valid integration between it and the logged-in

UCMDB.

Note:

l For this widget to work, the UCMDB administrator must configure the Enterprise View adapter,

as described in "Configure the Enterprise View Adapter" on page 190.

l For instructions on integrating Enterprise View with UCMDB, see "Configure Integration with

Enterprise View" on page 187.

CI Overview Mode

In this mode, the following security-related data is presented for the selected CI (taken directly from

ArcSight EV and not processed by the UCMDB Browser):

l Overall security score (from 0-100, 0 is the best, 100 is the worst)

l Overall security status icon (uses the same icons as within ArcSight Enterprise Security Manager).

The possible icon values are:

o High

o Medium

o Low risk

o No data

l A direct link to the ArcSight EV system asset summary

Widget Details Mode

In this mode, the following information is added to the summary displayed in CI Overview mode (taken

from the ArcSight EV and not processed by the UCMDB Browser):
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l Risk:

o Score: from 0-100, 0 is the best, 100 is the worst

o Icon: Possible icon values are High, Medium, Low risk, and No data

l Compliance:

o Score: from 0-100, 0 is the best, 100 is the worst

o Icon: possible icon values are High, Medium, Low risk, and No data

o Progress: shows the percentage of overall asset compliance with a policy

l Maturity:

o Score: from 0-5, 0 is the worst, 5 is the best

o Icon: possible icon values are High, Medium, Low risk, and No data

o Progress: shows the percentage of the overall control maturity within a policy

l Vulnerability:

o Score: from 0.00-10.00, 0.00 is the best, 10.00 is the worst

o Icon: possible icon values are High, Medium, Low risk, and No data

l Enterprise Security Manager Threat:

o Score: from 0.00-10.00, 0.00 is the best, 10.00 is the worst

o Icon: possible icon values are High, Medium, Low risk, and No data

Defects Widget
The Defects widget presents the defects opened on all ALM projects that are linked (directly or

indirectly) to the selected business element CI. In CI Overview mode, defects are displayed according to

the defect number; in Widget Details mode, defect details are displayed, as described below.

A business element CI can be linked directly to one or more ALM project(s), using ALM filters (). A

business element CI can also be linked indirectly to ALM projects, through its descendants (it is

connected to another business element CI which is linked directly to one ALM project or more).
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This widget is displayed only if it has been properly configured in UCMDB. For details on this

configuration, see "Integrate with ALM (for the Defects Widget)" on page 190.

This widget and the Defects adapter use the Defects CI type (part of Universal Data Model or UDM) for

federating data from ALM and using it in the widget.

CI Overview Mode

The total number of Open defects in all projects linked to the selected CI are displayed, according to

severity level. The severity levels are Low, Medium, High, Very High, and Urgent.

Widget Details Mode

The following information on defects related to the selected CI is displayed:

Left pane:

The following filters are used to filter the defects displayed in the widget's right pane:

l Refine field. Enter a value here to filter the displayed defects to only those defects that contain

this value in one of the attributes configured for search refinement. For example, if 12 is typed, all

defects that contain “12” in at least one of the configured attributes remain visible, the others are

hidden. This is a cross filter with the other two filters (Severity and First-level, described below).

Configure attributes for the Refine search as follows:

<search_refining_attribute_names>DefectReferenceNumber,DefectSummary
</search_refining_attribute_names>

This is a comma-separated list, and the attributes listed here must belong to the Defect CI type. An

attribute that does not belong to the Defect CI type is ignored.

An "X" button appears to the right of the field, which allows clearing the entered text.

l Severity. This is a toggle between available severity levels. You can filter defects according to

severity level. For example, you can choose to display only defects with Urgent severity level. The

default is All Severities, meaning that it displays defects of all severity levels. The number of defects

for each severity level is displayed.

l First level filtering. Since the resulting number of related defects can be high, it is possible to filter

them according to one of the following:

o If more than a single ALM Project is defined (either directly or indirectly), you can filter defects

according to a specific project. The number of defects per ALM project is displayed. With this type
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of filtering, it is only possible to see defects of a specific ALM project. There is no option to see all

defects of all ALM projects in a single view.

o If a single ALM project is defined, first level filtering is determined by the system administrator.

Right pane:

All relevant defects, filtered by the search string, severity level, and first-level filtering are presented.

Since all displayed defects belong to a single ALM project, the defect details presented are configurable.

Each defect can be presented in a collapsed or expanded mode; collapsed is the default.

In collapsed mode, the following information is displayed:

l Defect ID

l Summary: The summary data is truncated to fit the two line column size.

l Severity (configurable, see above)

l Release: By default, sorting is done using the Severity field on a downward order. It is possible to

sort defects according to any of the above fields, either upward or downward, using the arrows that

appear on each field's label.

Sorting is done by default using the Severity field in descending order. Sorting defects by any field,

either ascending or descending, is done using the arrows displayed on each field's label.

Expanding a Defect

The following information is added to the data presented in the collapsed mode when expanding the

defect:

l Full summary information

l All defect-related properties that the UCMDB administrator configured to be displayed per ALM

project.

All properties are textual, and are presented in two columns.

Defect Description in Widget Details Mode

The defect description setting configures which attribute of the Defect CIT is displayed in Expanded

mode. The default setting is DefectSummary, as shown below:

<description_attribute_name>DefectSummary</description_attribute_name>

The setting here must be an attribute of the Defect CI Type. If it is not, DefectSummary is used by

default.
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Severity Mapping

From the UCMDB Browser settings, it is possible to configure the list of values of the DefectSeverity

attribute that are mapped to severity levels in the UCMDB Browser.

For each Severity, the mapping can be configured from the UCMDB Browser settings as follows:

<severity_urgent_values>5:Urgent</severity_urgent_values>
<severity_very_high_values>4:Very High</severity_very_high_values>
<severity_high_values>3:High</severity_high_values>
<severity_medium_values>2:Medium</severity_medium_values>
<severity_low_values>1:Low</severity_low_values>

If the DefectSeverity of the Defect CI type has the value: “2:Medium”, it is mapped as Medium in the

UCMDB Browser. It is also possible to have a comma-separated list of values here.

Note: The severity displayed in the UCMDB Browser can be modified through UCMDB. Go to

Administration > Infrastructure Settings Manager > UCMDB Browser Settings.

Business TopologyWidget

Note: The Business widget is supported on UCMDB 10.10 and later versions.

The Business widget is based on a dynamic widget and can be configured according to dynamic widget

capabilities. For more information, see "Dynamic Widgets" on page 178. The widget provides additional

modes for displaying the business topology of a CI. It looks for containment and dependency

relationships between a business element and other CIs.

Note: You should only specify the report layout in the dynamic widget definition if the Widget Type

is set to Properties. Otherwise, your specified layout is disregarded.

CI Overview Mode

A count of CIs contained in the current CI's environment are displayed, divided by classification. Only

classifications containing at least one CI are displayed. Each classification includes the name of the

classification, its icon, and the number of CIs included in it. Clicking a particular classification displays

the widget details and filters the selected classification (in both Topology Group CIT mode and Textual

mode).
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Widget Details Mode

Viewing the widget details does the following:

l Replaces the data displayed in CI Overview mode.

l Presents the detailed environment data in Map mode, CIT Group mode, or Textual mode, whichever

was last used. The default mode is the Widget Type value that is selected during creation of the

dynamic widget in UCMDB.

Note: If graphical mode does not display, it may be due to the fact that the drive of the machine

where the UCMDB server is installed is full. Free up some space on that drive in order to view

graphical mode.

o Toolbar

The top row of the Business widget acts as a toolbar and enables you to:

l Switch between the different presentation modes

l Click a button (in graphical mode only) that opens or closes the CIs pane. The default mode

for the CIs pane is opened.

The CIs pane details the CIs contained in the classification that is selected in the CIT Group

pane, dividing it into all relevant CI types.

o Map mode

Note: When the UCMDB Browser is embedded in a UCMDB server running on a Linux system,

runlevel 5 (enabled X server) is needed for the graphical mode of the Dynamic widget to

operate properly. In addition, add unset DISPLAY to the server.sh script. Restart the

UCMDB Server for the server.sh changes to take effect.

l Classification icons are displayed in layers according to relationships in the topology and not

according to the actual hierarchy.

l When you select a CI, a refocus link appears in the corner of the selected node. Clicking

this link causes the UCMDB Browser to refocus on that node.
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Directional lines representing links are displayed with other items in the view if the selected CI

has a direct relationship with at least one other CI (either in the same classification or in a

different classification).

o CIT Group mode

l For each classification containing at least one CI, the name and number of CIs in that

classification is displayed. Clicking a classification displays all CIs contained in that

classification and matching the current filter. In addition, a thumbnail is displayed for each CI

type that contains at least a single CI.

l Classification icons are displayed in layers according to the relative hierarchy of the CIs as

displayed in the topology map in UCMDB.

Directional lines representing links are displayed with other items in the view if the selected CI

has a direct relationship with at least one other CI (either in the same classification or in a

different classification).

o Textual mode

l Left pane. The left pane displays an alphabetical list of all classifications containing at least

one CI. Each classification is broken down into a list of the CI types in that classification that

have at least one CI. Selecting any line in this pane displays its details in the right pane.

l Right pane. The right pane displays detailed information about the item that is selected in

the left pane, divided by CI type.

Storage Data Widget

Note: The Storage widget is supported on UCMDB 10.10 and later versions.

This widget shows the paths between a server and the storage arrays that support the server's file

systems. The path consists of the volumes that reside on the server and the matching volume that

resides on the storage array.

Note: In order to view the Storage widget in the UCMDB Browser, it must be assigned to a role in

UCMDB. The widget will only be listed in the Roles Manager after the UCMDB Browser has been

deployed. For details, see "Roles Manager Page" in the HP Universal CMDB Administration Guide.
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This widget matches the data model that supports integration with Storage Essentials, but can serve

for other integrations as well.

This widget is based on a dynamic widget and can be configured according to dynamic widget

capabilities. For more information, see "Dynamic Widgets" below.

Dynamic Widgets

Note: Dynamic widgets are supported on UCMDB 10.10 and later versions.

Dynamic widgets are widgets that display data about a particular view. You create dynamic widgets in

the Modeling Studio in UCMDB.

Note:

l After you create a dynamic widget in UCMDB, you must log out of the UCMDB Browser and then

log in again to see the newly created widget.

l Only one level of grouping is supported.

l If no grouping option has been specified in the hierarchy tree, all CI attributes appear in a single

screen.

l You must use the > Resource Creation Action > Dynamic Widget action on the Security >

Roles Manager > General Actions tab to control which users may create new dynamic widgets

in the Modeling Studio (for use in the UCMDB Browser).

CI Overview Mode

On the Widget tab of the dynamic widget configuration, you must set an attribute to True in the

Overview column for it to be displayed in CI Overview mode.

The CI Overview mode displays up to six individual properties (six random properties from all nodes

specified in the dynamic widget).

Widget Details Mode

On the Widget tab of the dynamic widget configuration, you must set an attribute to True in the Details

column for it to be displayed in Widget Details mode.
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Properties in Widget Details mode are displayed in different ways, depending on the dynamic widget's

configuration:

l If no grouping classifications have been specified in the hierarchy tree of the dynamic widget's

configuration, all attributes that are defined as True for being shown in Widget Details mode are

displayed in a list.

l If grouping classifications have been specified, in the first level of this mode CIs are displayed by

group (as specified in the hierarchy tree) and show a maximum of two random attributes that are

defined as True for being shown in CI Overview mode. Selecting one of the CIs shows all of the

attributes for that CI that are defined as True for being shown in Widget Details mode, grouped by

the group name for that attribute that was specified in the widget's configuration.

Create a dynamic widget

1. In UCMDB, go to Modeling > Modeling Studio.

Note: To create a dynamic widget, you must have Create Dynamic Widget permission assigned

in the Roles Manager in UCMDB.

2. Click New and from the drop-down list, select Dynamic Widget. In the New Dynamic Widget

dialog, select the base TQL query on which your new dynamic widget is based, or select Create new

query to build a new TQL query.

a. In the View tab, add the query nodes and relationships that define the query.

Specify whether to use a manual (default) or rule-based hierarchy when defining the TQL

query.

Note: If you are starting with a blank widget, you must add at least one query node in

order to save your widget.

b. In the Report tab, select a node in the Hierarchy pane, and choose the attributes for that node

that you want to appear in the widget.

c. In the Widget tab, select a node and set values for that node's attributes:
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UI Element Description

Overview Boolean. Specifies whether this attribute appears in the CI Overview mode.

Details Boolean. Specifies whether this attribute appears in the Widget Details mode.

Refocusable Boolean. Causes the attribute to appear as a hyperlink, which will refocus to
the CI on which it is defined.

Group Name String. Specifies the name of the section under which the attribute will be
grouped in the Widget Details mode.

l Select the Show path checkbox to cause the UCMDB Browser to display the route in the

dynamic widget from a specific node in the view definition to all the node's children.

l Select the Enforce Browser CI access control checkbox to ensure that the dynamic widget

displays data only according to the permissions that were specified in UCMDB (on the

Browser CI Access Control tab in the Roles manager). If the checkbox is not selected, the

dynamic widget will display all data, without permission enforcement.

l Select an initial display mode for the dynamic widget.

l Properties Mode. Displays individual properties for CIs.

Note: If you do not select a Widget Type value, Properties Mode is enabled by

default.

l Topology Map Mode. Displays CIs according to your current topology.

l Topology CIT Group Mode. Displays CIs grouped by CI type according to your current

model.

l Topology Textual Mode. Displays a list of CIs broken down by CI type.

The topology mode that you select is the initial view selection until you change to another

one in the UCMDB Browser.

3. When you are finished, click Save .

For additional details, see "Modeling Studio" in the HP Universal CMDB Modeling Guide.
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Discovery Progress Widget

Note: The Discovery Progress widget is supported on UCMDB 10.22 or later versions.

The Discovery Progress widget presents the progress of running discoveries, and enables you to drill

down to discovered CI instances. The discovery progress information displayed is the last status known

by the UCMDB server for each job Trigger CI within the context selected for discovery.

CI Overview Mode

The Triggered CIs View - Progress/Status Matrix displays a summary of the status of triggered CIs

through the progress of discovery.

UI Element
(A-Z) Description

Progress
bar

Displays the percentage of new trigger CIs that have completed the discovery process
for the set of jobs contained within the focus area that you have selected for discovery
since the last time the activity was modified.

Note: When you activate discovery, the trigger CIs list is prepared. During this
time, discovery progress may not be reflected immediately.

The discovery progress is refreshed when loading the preview, opening the Widget
Details mode, or clicking Refresh from the Widget Details mode.

Show All Clicking the Show All link or the DISCOVERY PROGRESS widget header link opens the
Widget Details Mode.

Understanding the Progress/Status Matrix and the Progress Bar

Progress
Status Total

Pending
Probe

Displays the total
number of trigger
CIs waiting for the
Probe to pick them
up for execution.

Displays the
number of
triggered CIs
successfully
waiting for the
Probe to pick them
up for execution.

-- --
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Progress
Status Total

Reached
Probe

Displays the total
number of
triggered CIs that
reached the Probe,
and may have
started running.

Displays the
number of
triggered CIs that
successfully
reached the Probe,
and may have
started running.

Displays the
number of
triggered CIs that
successfully
reached the Probe
and have started
running, but have
warnings.

--

Completed Displays the total
number of
triggered CIs that
completed running
(successfully or
unsuccessfully).

Displays the
number of
triggered CIs that
successfully
completed
running.

Displays the
number of
triggered CIs that
successfully
completed
running, but have
warnings.

Displays the number
of triggered CIs that
failed to complete
running, did not reach
the Probe, or were
not picked up by the
Probe for execution.

Total Displays the total
number of
triggered CIs.

Displays the total
number of
successful
triggered CIs.

Displays the total
number of
triggered CIs that
were successful,
but had warnings

Displays the total
number of failed
triggered CIs.

Widget Details Mode

The following information related to the triggered CIs is displayed:

Left pane:

The left pane summarizes the number of CIs that match the current filter.

l The first line (displaying the word All) shows the total number of triggered CIs. Clicking this line

displays, in the right pane, all triggered CIs.

l Clicking the second line (displaying the word Completed) shows the total number of triggered CIs

that completed running (successfully or unsuccessfully).

Right pane:

Displays the following details for all triggered CIs.

l Last Discovery Time. Displays the time that the triggered CI was last discovered (touched) by a

probe.
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l Job Name. Displays the list of jobs that have reached the selected stage of discovery and with the

selected status.

l Status. Displays the following status for the triggered CI. The success data is retrieved from the

UCMDB Server side. When there is warning/error with a triggered CI, the data from the UCMDB

Server is overwritten by the data from the probe side.

o Success. Displays the word Success in green.

The success data is retrieved from the UCMDB Server side. When there is a warning/error with a

triggered CI, the data from the UCMDB Server is overwritten by the data from the probe side.

o Warning. Displays the word Warning in orange.

For the triggered CI with a Warning status and a Warning message, a down arrow is displayed at

the beginning of the row. Clicking the down arrow expands a list of detailed warning messages

for the triggered CI. To collapse the warning message list, click the up arrow.

o Error. Displays the word Error in red.

For the triggered CI with an Error status and an Error message, a down arrow is displayed at the

beginning of the row. Clicking the down arrow expands a list of detailed error/warning messages

for the triggered CI. To collapse the error/warning message list, click the up arrow.

Note: In the error/warning message list, the error messages are flagged with , and the

warning messages are flagged with .

If a triggered CI contains both error and warning messages, Error is displayed as its status.

l Probe.

l Trigger CI.
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Load Embeddable Widgets
The embeddable widgets feature allows loading only a single widget instead of the entire UCMDB

Browser. This enables other products to include widgets inside their own applications.

Developers should be aware of two limitations:

l There is no login window. If using LW-SSO, the user enters the URL of the UCMDB Browser and adds

to that URL certain parameters that tell the UCMDB Browser which widget to show, how to show it,

and which CI to show for that widget. The Embedded widget checks the LW-SSO cookie to verify that

the current user is logged on. If there is no valid session, an error message is displayed.

If not using LW-SSO, the user enters the URL of the UCMDB Browser and certain parameters as

mentioned above, and adds to that a username and password. This method is not recommended

since it exposes user credentials.

o There is no search UI, only a single widget. This means that when loading the widget, the user

must know and set the CI ID.

To load an embeddable widget:

For LW-SSO users, you load an embeddable widget by entering the base URL and other information as

follows:
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http://<UCMDB Browser host>:< UCMDB Browser port>/ucmdb-browser/ucmdb_

widget.html#widget=<widget type>;refocus-selection=<CI ID>

This URL can be divided into the following parts:

l Base URL: This is the URL of the UCMDB Browser. For example:

http://<UCMDB Browser host>:< UCMDB Browser port>/ucmdb-browser/

l Widget Entry Point: This is a static value, will always be:

ucmdb_widget.html#

l Widget type: This must be one of the possible widget types: PROPERTIES, ENVIRONMENT, HISTORY,

IMPACT, POLICY, RFC, INCIDENTS, PROBLEMS, BSM, STAKEHOLDER, SECURITY, or DEFECTS.

l CI ID: The ID for the CI whose data will be displayed by the widget. For example, 123456789.

Therefore, to load a widget with the examples given above, using LW-SSO, you would enter a URL of:

http://<UCMDB Browser host>:< UCMDB Browser port>/ucmdb-browser/ucmdb_

widget.html#widget=environment;refocus-selection=123456789

And if not using LW-SSO, using the above example:

http://<UCMDB Browser host>:< UCMDB Browser port>/ucmdb-browser/ucmdb_

widget.html#widget=environment;refocus-selection=123456789;username=guest;

password=765432

Once logged on, the user sees the CI Overview and Widget Details modes of the widget and CI specified

in the URL. Widget Details mode cannot be collapsed.

Configure the BSM Health Indicator (for the Monitoring
Widget)
To use the Monitoring widget, you perform the following configurations:

1. Synchronize the CMS and BSM:

a. In UCMDB, go to Data Flow Management > Integration Studio.

b. Create a new integration point with the following settings:
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l Integration name. BSM synchronization

l Adapter. BSM

l Hostname. BSM hostname

l Port. BSM host port

l Credentials. Choose ‘generic protocol’

l Push Back IDs. Choose ‘enabled’

c. Save the integration point and invoke synchronization.

2. Create the BSM KPI Adapter Integration Point:

a. In UCMDB, go to Data Flow Management > Integration Studio.

b. Create a new integration point with the following settings

l Integration name. BSM Kpi Adapter

l Adapter. BSMKpiAdapter

l Hostname. BSM hostname (use only FQDN)

l Port. BSM host port

l Credentials. Choose ‘generic protocol’

l Customer ID. Enter the Customer ID

c. Select the Kpi and KpiObjective checkboxes and save the integration point.

Note: The BSM KPI Adapter is deployed on the UCMDB server upon initial login to the UCMDB

Browser. This triggers deployment of content and makes it available for configuration on the

UCMDB server.

3. Specify Data Over Time settings:

a. In BSM, go to Admin > Service Health.

b. On the CI Indicators tab, select a view that contains one or more CIs with KPIs.
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c. Select one or more CIs in the upper pane (that have the KPIs you want to view in the Monitoring

widget).

d. In the CI Data pane at the bottom of the screen, select the Save KPI data over time for the

selected CIs checkbox.

Configure Integration with Enterprise View
To enable the Enterprise View/UCMDB Integration, you must first install Enterprise View (EV) and

BusinessObjects. Once these are installed, you must perform the following procedures:

l "Deploy a Universe for Integrating the UCMDB Browser into BusinessObjects" below

l "Deploy a Report Designed for UCMDB Browser Integration into BusinessObjects" on page 189

Deploy a Universe for Integrating the UCMDB Browser into

BusinessObjects

1. Verify that an EnterpriseView Universe exists with the correct description.

a. Open the Central Management Console (go to Programs > Business Objects XI 3.1 >

Business Objects Enterprise > BusinessObjects Enterprise Central Management Console, or

in a web browser, go to the URL: http://<CMS host>:<CMS HTTP port>/ CmcApp).

b. Log in with the user name and password that you defined in BusinessObjects installation.

c. Go to Universes.

d. Open the folder EnterpriseView Universe, and check that EnterpriseView Universe is there

and that version 0.52 appears in the Description field.

2. Back up Existing Universe

a. Right-click on the universe EnterpriseView Universe and go to Organize > Move To.

b. Choose the root folder Universes and click the right arrow to move the folder to the

Destinations column.

c. Click Move.
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d. Exit the Central Management Console and create a new file system folder.

e. Copy the files export.properties and export.bat from the folder ImportExportEVUniverse

located in the UCMDB Browser content folder on HPLN into the folder you created in the

previous step.

f. In the file export.properties in the folder you just created, change the following parameters to

the correct username, password, host name, and port of the host where the BusinessObjects

application is installed:

l userName=<BO_user_name>

l password=<BO_password>

l CMS=<host_name>:<port>

g. Run export.bat from the newly created folder where you copied export.properties.

Note: If you export from the original ImportExportEVUniverse, the universe you export

overwrites the original file that contains the EV Universe for the UCMDB Browser integration.

3. Import the Universe for Integration with UCMDB Browser

a. Open the folder ImportExportEVUniverse and in the file import.properties, change the

following parameters to the correct username, password, host name, and port of the host

where the BusinessObjects application is installed:

l userName=<BO_user_name>

l password=<BO_password>

l CMS=<host_name>:<port>

b. From the same folder (ImportExportEVUniverse), run import.bat.

c. In the CMS console, ensure that EnterpriseView Universe is still situated under the root folder

Universes, and that the description field has changed to version 0.52 a.

d. Move the universe back to the folder EnterpriseView Universe (right-click the imported

universe, select Organize > Move To and select the EnterpriseView Universe folder).

4. Change the Database Connection for the Newly Imported Universe
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a. On the machine where the BusinessObjects application is installed, go to Programs > Business

Objects XI 3.1 > Business Objects Enterprise > Designer.

b. Skip the Quick Design window.

c. Go to File > Import.

d. Select the folder EnterpriseView Universe and choose the universe EnterpriseView_Universe.

e. Go to Tools > Connections.

f. Select EnterpriseView Connection and click Edit.

g. In the Edit dialog box, enter the details of the Oracle EnterpriseView user.

h. Click Next and enter the following for the Configuration Parameters:

l Pool timeout = 10 minutes

l Array fetch size = 1

l Array Bind size = 5

l Login timeout = 600 minutes

i. Click Save.

j. Go to File > Export, select the EnterpriseView Universe folder, and click OK.

Deploy a Report Designed for UCMDB Browser Integration

into BusinessObjects

1. On the machine where the BusinessObjects application is installed, go to Programs > Business

Objects XI 3.1 > Business Objects Enterprise > Web Intelligence Rich Client.

2. Select File > Open, and open the file UCMDB_Browser_Integration.wid, located in the UCMDB

Browser content folder on HPLN.

3. Select File > Export to CMS, and in the folders list, select EnterpriseView Reports.

4. Click OK.
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Configure the Enterprise View Adapter
1. In UCMDB, go to Data Flow Management > Integration Studio.

2. Create a new integration point with the following settings:

o Integration name: EnterpriseViewDataSource (required)

o Adapter: EnterpriseViewAdapter (required)

o Hostname: enter the Business Object’s server hostname (required)

o Port: enter the Business Object’s host port (required). The default port is 6400.

o Credentials ID: Choose Generic Protocol with your credentials

3. In the Data Flow Probe drop-down list, select a probe.

4. Save the integration point.

Note: The EnterpriseViewAdapter adapter is deployed on the UCMDB server upon initial login to the

UCMDB Browser. This triggers deployment of content and makes it available for configuration on

the UCMDB server.

For instructions on integrating Enterprise View with UCMDB, see "Configure Integration with Enterprise

View" on page 187

Integrate with ALM (for the Defects Widget)
The following configuration procedures need to be performed to use the Defects widget in the UCMDB

Browser:

l "Set Up the Defects Adapter" on the next page

l "Create New Attribute and Severity Mapping Properties Files (optional)" on the next page

l "Create the DefectsFilter CI and Relate it to the Business Element" on page 193

l "Enable the Defects Widget in UCMDB" on page 194
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Set Up the Defects Adapter

1. In UCMDB, go to Data Flow Management > Integration Studio.

2. Create a new integration point with the following settings:

o Integration Name. Defects Adapter

o Adapter. ALMAdapter

o Protocol. must be http or https

o HostnameIP. the name or IP address of the machine where ALM is installed

o Port. the port number of the ALM server

o Domain. the domain that is defined in ALM

o Credentials ID. click the browse button and from the list that appears choose credentials for

connecting to ALM, or create new credentials

3. Optional: Click Test Connection to ensure that a connection can be established with the ALM

server.

4. Click OK.

5. Under the Supported and Selected CI Types panel, check the Defect CI type.

6. Click the Save Integration Point button.

Create New Attribute and Severity Mapping Properties Files (optional)

There are two out-of-the-box mapping properties files, one for attributes and one for severities. The

attributes mapping properties files map between names of defect fields in ALM to names of attributes

of the class type Defect in UCMDB. The severities mapping properties file maps between severity levels

in ALM to the five severity levels in UCMDB, as defined in the DefectSeverity typedef in UCMDB. These

files can be accessed by means of the Defects Adapter, by going to Data Flow Management > Adapter

Management > ALMAdapter > Configuration Files. The files are called

sample.attribute.mappings.properties and sample.severity.mappings.properties.

You may want to create your own customized attributes or severity mapping properties files. This could

be necessary if the names of the fields in the out-of-the-box mapping properties files do not match the
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names in your ALM system, or could be useful if you want to add additional fields that do not exist in the

out-of-the-box mapping properties files.

To create a new attribute or severity mapping properties file:

1. If you are creating an attribute mapping properties file:

a. To retrieve the ALM defect attribute field names that you need to create the mapping, go to

the following URL:

http://<ALM server>:8080/qcbin/rest/domains/<domain>

/projects/<project>/customization/entities/defect/fields?login-form-required=y

b. In the ALM login page, enter your user credentials.

c. In the XML file that appears there is a list of the defect’s fields. Note the Name element in

each field, you are going to map the value that appears for the Name element here to the

names of attributes of the class type Defect in UCMDB.

2. In UCMDB, go to Data Flow Management > Adapter Management.

3. Click the New button and from the pop-up menu select New Configuration File.

4. Enter a name that starts with ALMAdapter/…, for example:

ALMAdapter/attribute.mappings.properties.

Note: The custom attribute mappings file should be named attribute.mappings.properties,

and the custom severity mappings file should be named severity.mappings.properties. If

project-specific mappings files are required, they should be named <project-

name>.attribute.mappings.properties and <project-name>.severity.mappings.properties

for attributes or severities, accordingly.

5. Click the Browse button by the Package field, choose ALMAdapter from the list that appears, and

click OK.

6. In the text editor, for attributes mapping each row should contain the name of the ALM field

(attribute) on the left side and name of the equivalent CI attribute on the right side in the following

manner:

<ALM field name>=<CI attribute>
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For severities mapping, each row should contain the ALM severity on the left side and the

equivalent UCMDB severity (as defined in the DefectSeverity typedef in UCMDB) on the right side, in

the following manner:

<ALM severity>=<UCMDB severity>

7. Click OK when you are finished editing the new mapping properties file.

Note:

l The name of the CI attribute must exist in the class type Defect.

l For the severities file, if a severity in ALM has a space, a back slash must precede the space as

follows: Very\ High.

l In the UCMDB Browser, there are only 5 severity levels (Low, Medium, High, Very High, and

Urgent), so all ALM severities must map to one of these 5 levels.

l The type of all custom UCMDB attributes must be String.

Create the DefectsFilter CI and Relate it to the Business Element

The Defects Filter CI that is related to a specific business element represents the ALM filter that is used

to retrieve the relevant defects for that business element.

Note: You can relate more than one DefectsFilter CI to a business element.

To create the DefectsFilter CI and relate it to the business element:

1. Create a filter in ALM (if one has not already been created).

2. Copy the filter's text.

3. In UCMDB, go to Modeling > IT Universe Manager.

4. In the Browse Views tab, click the New CI button.

5. From the CI type tree, select the DefectsFilter CI type.

6. Paste the filter text from the ALM filter into the FilterText attribute value.
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Note: Currently there is a limitation of maximum 885 characters in the FilterText attribute

value.

7. In ProjectGroup attribute, enter the ALM project name.

8. Optional: Give the filter a custom name by setting the Name attribute value.

9. Click Save.

10. Relate the DefectsFilter CI to the business element using a containment relationship from the

Defects filter to the business element.

Enable the Defects Widget in UCMDB

Before connecting to the Browser, enable the Defects widget as follows:

1. Go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

2. Set the value of Enable the Defects Widget to True.

Configure Integration with Service Manager
1. In UCMDB, go to Data Flow Management > Integration Studio.

2. Create a new integration point with the following settings:

o Adapter: select the appropriate adapter for the version of Service Manager that you have

installed.

o Hostname/IP: enter the hostname or IP address of theService Manager server.

o Credentials ID: select the credentials for the Service Manager server.

o Data Flow Probe: select a data flow probe.

3. Select the Is Integration Activated checkbox.

4. Save the integration point.

5. Click the Federation tab of the integration point and verify that the relevant Service Manager
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items are selected.

6. Create a data push job:

o For integration points that use adapters earlier than the ServiceManagerAdapter9.x adapter,

create a data push job that includes the CI types and relation types that you need, and run the

job. For details, see the HP Universal CMDB Data Flow Management Guide.

o For integration points that use the ServiceManagerAdapter9.x adapter, synchronize data using

the out-of-the-box data push job.

Configure a Direct Link to Service Manager for a
Selected Problem, Incident, or Change Request

1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.

2. In the Name column, choose Service Manager application URL for problem CIs.

3. In the Value column, enter the Service Manager URL. Ensure that you enter the correct Service

Manager IP address or hostname and the correct port number. The URL must contain the element

{$PROBLEM_ID} for a Problem, {$INCIDENT_ID} for an incident, or {$RFC_ID} for a change request.

This element is replaced with the actual ID at runtime.

For example:

http://10.0.0.1:8080/webtier-

9.30/index.do?ctx=docEngine&amp;file=rootcause&amp;query=id%3D%22{$PROBLEM_ID}%22

4. Click Save .

Direct Links
A direct link provides the URL to addition information, or to the browser-generated content (for

example, the content of a report or the result of a search).

The direct link icon is available in reports and some widgets.

Tip: If you want to share what is currently displayed with others, you can always copy the URL from

the address bar of the browser and then share the URL with others.
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Direct Links in Reports

In a generated report, when you click the direct link icon , the following two options are available:

Copy URL: Copy the URL of the current generated report to the clipboard.

Email URL: Send the URL of the current generated report by using the default email application.

When you select a report or browse through the Reports module, a link is generated in the address bar

of the browser. You can always copy the URL generated and then share it with others.

Other users can open the same report by using the URL, as long as they have View Permissions for that

particular report.

Direct Links in Widgets

For some of the widgets displayed in the UCMDB Browser, once you select a CI and its data is displayed in

the Browser, it is possible to view additional data in the context of the selected CI and the displayed

widget. A link icon ( ) appears on the far right side of the widgets that provides, among other things,

a direct link to an external application. When you click this icon and select Open Link, you can launch an

external application in the context of the selected CI, as follows:

Link Description

Properties Widget When you click the link icon in the Properties widget and select Open Link,
the UCMDB server for the machine you selected in your initial search opens
(you must log in first), and displays all the CI properties for the CI you
selected in the Browser.

Environment Widget When you click the link icon in the Environment widget and select Open
Link, the UCMDB server for the machine you selected in your initial search
opens (you must log in first), and displays a diagram of all CIs related to
the CI you selected in the Browser.

Impact Simulation
Widget

When you click the link icon in the Impact Simulation widget and select
Open Link, the UCMDB server for the machine you selected in your initial
search opens (you must log in first), and displays the impact analysis for
the CI you selected in the Browser.

Policy Widget When you click the link icon in the Policy widget and select Open Link, the
Configuration Manager installation for the machine you selected in your
initial search opens (you must log in first), and displays a view containing
the defined policies for the CI you selected in the Browser (if a view that is
managed by Configuration Manager exists that contains that CI). If the
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Link Description

selected CI is present in more than one view, Configuration Manager
displays a dialog box where the user can select which view to open.

Change Request
Widget

In the Change Request widget, the link icon appears only in the widget
details, and each Change Request listed has its own link icon. When you
click the link icon for a Change Request and select Open Link, Service
Manager opens (you must log in first), and displays a form containing more
details on that Change Request.

Incidents Widget In the Incidents widget, the link icon appears only in the widget details, and
each Incident listed has its own link icon. When you click the link icon for an
Incident and selecting Open Link, Service Manager opens (you must log in
first), and displays the incident details.

Note: The link icon appears only if the Incidents Widget is configured
for a direct link that contains the tag: {$INCIDENT_ID} in the direct
link URL.

When you click , there is also an option to send a link to the CI in an email.

When entering a URL for a direct link from the UCMDB Browser, you can also use a global ID. The

highlighted section in the example below shows the syntax:

http://<browser-home>/ucmdb-browser?server=Default%20Client#widget=properties;global-

id=ca733b86bd6dc30ecd6e8a4467788cb7

Configure Integration with SiteMinder

Note: Integration with SiteMinder can be performed only when the UCMDB Browser is configured to

one UCMDB Server, since there is no option to select a server from the server list on login.

1. Configure the UCMDB Browser to enable LW-SSO:

a. Follow the instructions in "Configure LW-SSO" on page 23.

b. Add following code to the UCMDB Browser ucmdb_browser_lwsso_config.xml configuration

file, just after the tag </in-ui-lwsso> and before the tag </validation>:

<in-ui-identity-management>
<identity-management>
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<userNameHeaderName>sm_user</userNameHeaderName>
<cookieName>SMSESSION</cookieName>

</identity-management>
</in-ui-identity-management>

2. Configure Reverse Proxy server and CA SiteMinder Client Agent

Note: It is strongly recommended to install and configure the Reverse Proxy web server

before installing the CA SiteMinder Client Agent. For more details, see to the SiteMinder

documentation.

Configure reverse proxy either for the Apache web server or Microsoft IIS, according to the

following instructions:

o Configure Apache Web Server as Reverse Proxy

i. Prerequisites:

l Ensure that CA SiteMinder is installed on your user environment.

l Ensure that the Apache Web Server is installed on the same machine as the CA

SiteMinder Client Agent.

ii. Install Apache 2.2.x on Windows (Apache 2.4.x on Linux).

Download 32-bit binaries with OpenSSL (httpd-2.2.25-win32-x86-openssl-0.9.8y).

iii. Go to C:\Apache24\conf\ and open the Apache Web Server httpd.conf configuration file

with a text editor.

l Uncomment the following two proxy modules:

LoadModule proxy_module modules/mod_proxy.so
LoadModule proxy_http_module modules/mod_proxy_http.so

l Add the following lines:

ProxyRequests off
<Proxy *>
Order deny,allow
Deny from all
Allow from all
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</Proxy>
ProxyPass / http://[UCMDB_SERVER_NAME]:8080/
ProxyPassReverse / http://[UCMDB_SERVER_NAME]:8080/
ProxyPass /ucmdb-ui http://[UCMDB_SERVER_NAME]:8080/ucmdb-ui
ProxyPassReverse /ucmdb-ui http://[UCMDB_SERVER_NAME]:8080/ucmdb-
ui
ProxyPass /status http://[UCMDB_SERVER_NAME]:8080/status
ProxyPassReverse /status http://[UCMDB_SERVER_NAME]:8080/status
ProxyPass /jmx-console http://[UCMDB_SERVER_NAME]:8080/jmx-console
ProxyPassReverse /jmx-console http://[UCMDB_SERVER_NAME]:8080/jmx-
console
ProxyPass /ucmdb-browser http://[UCMDB_SERVER_NAME]/ucmdb-browser
ProxyPassReverse /ucmdb-browser http://[UCMDB_SERVER_NAME]/ucmdb-
browser

If needed, feel free to add more URLs.

iv. Restart Apache 2.2 service.

o Configure Microsoft IIS as Reverse Proxy

i. Prerequisites:

Before downloading and installing ARR, make sure that you have already installed Internet

Information Services (IIS).

ii. Install ARR from the following URL using the Microsoft Web Platform Installer:

http://www.iis.net/downloads/microsoft/application-request-routing

Once installed, the Server Farms item should be present in the Connections tree inside

the IIS Manager.

iii. Right-click Server Farms and select Create Server Farm….

Specify Server Farm name (make sure the Online checkbox is checked) and click Next.

iv. Enter the address of the UCMDB browser together with the port on which the browser can

be accessed, and then click the Add button. (The port can be entered in the Advanced

settings….)

v. After IIS knows which is the server behind, it is necessary to create a simple URL rewriting

rule. When prompted for that, select Yes.
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3. Configure SiteMinder LogoffUri

The UCMDB Browser logout page (logout.jsp) must be defined on CA SiteMinder to ensure correct

logout from the Browser. If you do not do this, you will need to open a new Browser window to re-

enter the UCMDB Browser application.

4. Verify successful integration of the UCMDB Browser with SiteMinder

Access the reverse proxy frontend URL. If all settings are correct, you are prompted to input your

user name and password in the CA SiteMinder authentication dialog. After successful

authentication, you are forwarded to the UCMDB Browser application without having to enter your

UCMDB user name and password.

Configure Integration with Configuration Manager
1. In UCMDB, go to Data Flow Management > Integration Studio.

2. Create a new integration point with the following settings:

o Adapter: select the CM New Policy Adapter.

o Configuration Manager Application URL: enter the hostname or IP address of the

Configuration Manager server.

o Credentials ID: select the credentials for the Configuration Manager server.

o Data Flow Probe: select a data flow probe.

3. Select the Is Integration Activated checkbox.

4. Save the integration point.

5. Click the Federation tab of the integration point and verify that the Policy and PolicyResult

checkboxes are selected.
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Chapter 5: Troubleshooting and Limitations

Problem: Performance for the UCMDB Browser is slow.

l Possible Solution: Add the variable CATALINA_OPTS to the windows environment variables with

values:

-XX:PermSize=128M -XX:MaxPermSize=512M -Xms512M -Xmx4096M

Problem: The UCMDB Browser fails to open or gets stuck on loading when trying to

open it in Internet Explorer 8.

l Possible Solution 1: If your IE8 is 64 bit, clear Internet Explorer’s cache.

l Possible Solution 2: Ensure that compatibility mode is disabled as explained in "Disable Compatibility

View for Internet Explorer 8" on page 43.

Problem: Graphical mode in the UCMDB Browser embedded in Configuration

Manager may not function correctly.

The first time you open the UCMDB Browser module that is embedded in Configuration Manager, the

graphical mode in the Environment widget may not function.

l Solution: First access the UCMDB Browser from within UCMDB, or open a standalone version of the

UCMDB Browser. This deploys a missing resource on your computer, and from then on the graphical

mode in the Environment widget will function correctly in the UCMDB Browser module that is

embedded in Configuration Manager.

Problem: The Tomcat log that contains requests to the UCMDB Browser and their

HTTPS codes becomes too large and is unreadable.

l Solution: Comment out the following lines in the server.xml file, located in <UCMDB_Browser_

installation_directory>\webapps\release\conf:

<Valve className="org.apache.catalina.valves.AccessLogValve" directory="logs"
prefix="localhost_access_log." suffix=".txt"
pattern="%h %l %u %t &quot;%r&quot; %s %b" />
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Problem: Icons are not displayed when the Turn Off Data URI support setting is not

disabled.

l Solution: Disable the Turn Off Data URI support setting on Windows as follows:

a. Click Start, type gpedit.msc in the Start Search box, and then press ENTER.

b. In the navigation pane of the Local Group Policy Editor window, expand Computer Configuration

> Administrative Templates > Windows Components > Internet Explorer > Security Features.

c. In the right pane, double-click Turn Off Data URI support.

d. Select Enabled, click Apply, and then click OK.

e. Go back to the navigation pane of the Local Group Policy Editor window, expand User

Configuration > Administrative Templates > Windows Components > Internet Explorer >

Security Features.

f. Repeat step 3 and step 4.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an

email client is configured on this system, click the link above and an email window opens with the

following information in the subject line:

Feedback on UCMDB Browser Installation and Configuration Guide (Universal CMDB Browser 4.04)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and

send your feedback to cms-doc@hpe.com.

We appreciate your feedback!
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